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Preparing Outlook 98 Exercise Files 
- 

Il  

Important 
The data diskette included vvith this course contains several files that are used 
as the basis for student messages, contacts, and notes. Please note that many 
exercises will require use of e-mail. In such cases, use a colleague's e-mail 
address or your own. Also any messages you send will be stored in your 
Personal Mailbox Sent Items folder. 

.doc Files on data disk 
The Journal.doc and the Specials List.doc files are Word 97 document files 
for use with Section 6, Keeping a Journal and Utilizing Notes. You will be 
able to browse these files with WordPerfect 8. 

.pst File on data disk 

The outlook98.pst file on the data disk (A:\  drive) contins  the initial data you 
need to install on your computer before you can work with the exercises in 
this manual. This data includes sent messages, contacts, and notes that you 
view in Section 1 and use from time to time in other sections. Once you open 
it, you will have a mailbox called OUTLOOK EXERCISES which you will 
work from when performing the exercises in this guide. 

Adding your OUTLOOK EXERCISES Mailbox 

To add the Outlook Exercise Mailbox containing the exercises used in this 
guide you need to copy outlook98.pst to your D:\  drive and opelitirom 
Outlook. 

To copy outlook98.pst to your D:\  drive: 
1. Create a folder on your D: drive called Training 
2. Copy outlook98.pst to DATraining 

To open outlook98.pst: 
1. Load Outlook 
2. From the File menu, choose Open, Personal Folders (.pst) 
3. Select DATraining\outlook98.pst and choose OK. 
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Removing the OUTLOOK EXERCISES Mailbox 

Once you complete the exercises in this guide you may wish to remove the 
OUTLOOK EXERCISES mailbox. 

To remove the OUTLOOK EXERCISE Mailbox 
1. From the Tools menu, choose Services. 
2. Click OUTLOOK EXERCISES. 
3. Click Remove and choose Yes. 
4. Click OK. 

Changing Outlook Default Settings 

Make sure AutoPreview is the Inbox view and the Preview Pane is open. If 
there are such default messages in the Inbox as welcome messages from your 
network administrator or from Microsoft Exchange, permanently delete them. 

Click Tools from the menu and choose Options. In the Outlook Options 
dialog box, make the following changes to the default settings: 

• On the Preferences page, choose E-mail options. In the E-mail options 
dialog box, select the Close original message on reply or forward check 
box. 

• Also in the E-mail options dialog box, choose Advanced E-mail Options, 
and then, in the Advanced E-mail Options dialog box, in the When sending 
a message area, select the Automatic name checking check box. 

• On the Preferences page, choose Calendar Options. In the Calendar 
Options dialog box, in the Calendar work week area, in the Start time 
drop-down list box, enter 9:00 AM. 

• On the Spelling page, make sure the Always check spelling before sending 
check box is deselected. 
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Acquiring the Basics 

• Getting Started 
• Getting Help 
• Printing Documents 
• Ending an Outlook Session 



Section 1: Acquiring the Basics 

Section Skills and Their Importance 
In the following section you will leam to: 

• Get started 
Logging in to connect to your network and get your e-mail is an 
essential part of the startup procedure. To use Outlook efficiently, 
you need to recognize the parts of the Outlook w-indow. You must 
be able to identify, use, and switch between Outlook folders to use 
all the Outlook features effectively. 

▪ Get help 
On-line help is always available. You can display ToolTips or 
invoke the Office Assistant, Microsoft's newest interactive helper. 

▪ Print documents 
You should set up your page so it prints clearly and gives you the 
information you want in the format you want it. You can preview 
your documents, select printing options, and send your document 
to the printer. 

• End an Outlook session 
You must lmow when to minimi7e and when to exit from Outlook. 
If you want to leave Outlook running, you can minimi7e the 
Outlook window to a button on the taskbar. How you choose to 
exit from Outlook depends on what you will be doing later in the 
day. 
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Getting Started 

Getting Started 
Microsoft Outlook 98 is a software program that helps you mariage your 
messages, your time, and your documents. Every day you have a variety of 
appointments and tasks, you send and receive messages, you open and close 
documents, you make notes, you call your colleagues and contacts, and you 
manage your files. Outlook integrates all these features into one program with 
one database. Outlook is most effective when used on a network, that is, when 
it is used with two or more computers that are physically connected. 

With Outlook, you can record simple and complex appointments and resolve 
conflicting appointments. You can keep a list of tasks, somewhat like the to do 
list you might have on your desk, record information about business and 
personal contacts, review who you phoned and when, store notes and 
reminders to yourself, plan events for the entire year, and even track birthdays 
and anniversaries. 

Starting Outlook 

Once you are logged in to the network, you can start Outlook by double-
clicking the Outlook icon on your desktop. 

L METHOD ---I 

To start Outlook: 

1. Log in to the network. 
2. On your desktop,  double-click the Outlook icon. 

EXERCISE 	  

In the following exercise, you will start Outlook. 

1. Log in to the networic 

2. Double-click the Outlook icon 	The Outlook window appears. 

[
-END-

I 
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Section 1: Acquiring the Basics 

Exploring the Outlook Window 

The Outlook window, as illustrated in Figure 1-1, appears at start up. The 
window opens in its nonmaximized view displaying the Inbox. The window 
contains a title bar, menu bar, and status bar common to other Microsoft 
application windows. The toolbar contains context sensitive tools. 

The Outlook Bar is a new screen element that contains shortcuts to the 
folders, where you store your information. You use the shortcuts, which store 
the folder location, just as you would use shortcuts on your desktop. You click 
a shortcut to access the information in your Inbox, your Calendar, your contact 
list, your task list, your Journal, and your notes. For example, when you click 
the Inbox shortcut, a list of the messages you received appears in the 
information viewer, that area of the Outlook window that displays the data for 
whatever folder is active. Group buttons at the top and the bottom of the 
Outlook Bar give you access to additional shortcuts to your remaining mail 
folders and to your file management folders. 
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Figure 1-1: The Components of the Outlook Window 
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Getting Started 

Table 1 - 1 describes the components of the Outlook window. 

1,1  

Component 	 Function 

Outlook Bar 	 Holds folder shortcuts (icons) and 
buttons. Click a shortcut to activate an 
Outlook folder. Click a group button to 
access a different group of folders. 

Standard and Advanced Toolbars 	Hold context-sensitive buttons that 
provide shortcuts for many menu and 
keyboard commands. 

Folder Banner 	 Displays the name of the active 
Outlook, Mail, or Other group folder. 
Click the name area to list all the 
subfolders. 

Column headers 	 Categorize detailed information. Click 
to sort messages or tasks. Available 
in all Mail folders and in the Tasks 
folder. 

Shortcuts 	 Icons on the Outlook Bar that provide 
access to Outlook folders. 

Group buttons 	 Buttons that reveal additional groups 
of Outlook shortcuts. 

Information viewer 	 The pane that displays the active 
Outlook folder. 

Preview Pane 	 Displays the contents of selected 
message. 

Table 1-1: Outlook Window Components 

[E. 
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Section 1: Acquiring the Basics 

Navigating in Outlook 

Microsoft Outlook 98 consists of the Outlook Shortcuts group, which is your 
time management tool; My Shortcuts group, which lets you process your e-
mail; and the Other Shortcuts group, which gives you access to all your 
computer files. 

Each Outlook feature functions as a program on its own, yet, because Outlook 
integrates the data into one database, the features work together to let you pull 
data from one directly into another. 

The Outlook Shortcuts group gives you access to Outlook Today, the Inbox, 
Calendar, Contacts, Tasks, Journal, Notes, and Deleted Items folders. My 
Shortcuts group gives you access to the Drafts, Inbox, Sent Items, Outbox, 
and Deleted Items folders. The Inbox folder in the Outlook Shortcuts group is 
the same Inbox folder that is in My Shortcuts group. You simply access it 
from different groups. The Deleted Items folder is also accessible from both 
folders. The Other Shortcuts group gives you access to My Computer, 
Personal, Favorites and Public Folders folders. 

You use the Outlook Bar shortcuts and the Folder Banner to navigate from 
folder to folder within Outlook. You can also use the Go menu to move from 
folder to folder. 

6 



Getting Started 

Table 1 -2 gives a brief description of each folder. 

	

Shortcut 	Folder 	 Function 

Outlook Today 	Gives you an overview of your day. It lists the 
number of new e-mail messages, 

	

Outlook Tot* 	 appointments and tasks for the day. Available .......„--- 
in Outlook Shortcuts. 

Inbox 	 Holds and displays incoming e-mail. Available 

	

. 	- 	
in Outlook Shortcuts and in My Shortcuts. . 

Jnb : 

Calendar 	Lets you create and manage appointments, 

	

Z 	
schedule meetings, and respond to invitations. _ 

	

ceierear 	 Also gives you access to your tasks. Available 
in Outlook Shortcuts. 

Contacts 	Holds your phone and address list Available 
in Outlook Shortcuts. 

Con
-  

	

--,. 	.. 	
Tasks 	 Lets you list and prioritize what you need to 

	

,..., 	- 	 do. Available in Outlook Shortcuts. ........e..,- 
Tasks 

	

o 	Journal 	Tracks e-mail, phone calls, and files you open. 
Available in Outlook Shortcuts. 

Journal 

...e 	Notes 	 Lets you store and organize information you 

	

, 	 would normally jot down on paper or sticky 

	

Notes 	 notes. Available in Outlook Shortcuts. 

Drafts 	 Holds unfinished messages that are not sent. 

	

, 	 Available in My Shortcuts. 
- Draftt 

	

le 	Deleted Items 	Stores deleted items so you can retrieve 

	

Deleted 	
them, if necessary. Available in Outlook and in 

	

Items 	 My Shortcuts. 

Sent Items 	Holds copies of e-mail you have sent 
Available in My Shortcuts. 

Sentitefi; 

Outbox 	 Holds e-mail you sent that your e-mail system 

	

...-Are 	 has not yet forwarded to the recipient. 

	

OUtb-Eix 	 Available in My Shortcuts. 

My Computer 	Represents the available drives on your 
computer and shows the folders, subfolders, 

« and files available within each drive. Also 

	

elYConeuiitt 	 accesses such features as Control Panel and 
Printers. Available in Other Shortcuts. 

7 



Section 1: Acquiring the Basics 

Personal 	Can be used to contain duplicates of mail 
S:: 

	

	as a backup copy. Personal folders 
are located on your computer's hard disk. 

-Personal Available in Other Shortcuts. 

M Favorites 	The folder in which you can store shortcuts to 

	

e-, 	 your favorite files, folders, and Web pages. 
- --.1%=--, - 

	

Ftekifites 	 Available in Other Shortcuts. 

	

es.: 	
Public Folders 	Contains elements that can be read by 

everyone who can open the folder. Available 

	

Public Fob= 	 in Other Shortcuts. 

Table 1 -2: The Outlook Bar Folders and Their Functions 

The simplest way to navigate from folder to folder is by using the group 
buttons and the shortcuts on the Outlook Bar. 

You can also navigate from folder to folder using the Folder Banner. When 
you click the banner, the complete Outlook folder list appears, showing you 
all folders accessible tbrough Outlook. 

A third way to access another folder is through the Go menu. 

L METHOD 

To navigate in Outlook: 

Outlook Bar method 
1. On the Outlook Bar, click the desired group button. 
2. Click the desired shortcut. 

Folder Banner method 
1. On the Folder Banner, click the name area. 
2. From the folder list, choose the folder you want. 

Menu method 
1. From the Go menu, choose the folder you want. 

8 



4. On the Folder Banner, click the 
words Sent Items 

5. Click the Notes folder 

7. At the top of the Outlook Bar, 
click the Outlook Shortcuts 
group button 

8. Click the Calendar shortcut 

Getting Started 

EXERCISE 

In the following exercise, you will navigate in Outlook. 

1. If necessary, maximize the 
window 

2. At the bottom of the Outlook 
Bar, click the My Shortcuts 
group button 

3. Click the Sent Items shortcut 

6. From the Go menu, choose 
Contacts 

My Shortcuts! group button 
moves to the top of the 
Outlook Bar. The mail 
shortcuts appear. 

The words Sent Items and an 
envelope graphic appear on 
the Folder Banner. A list of 
your sent items appears. 

The Outlook folder list 
appears. 

The word Notes and a graphic 
of a sticky note appear on the 
Folder Banner. Large icons of 
your notes appear in the 
information viewer. 

The word Contacts and a 
rotary card file appear on the 
Folder Banner. The information 
viewer shows the beginning of 
your contact list in alphabetical 
order and displays 
alphanumeric tabs for access 
to additional contacts. 

The Outlook Bar displays the 
Outlook shortcuts. 

The word Calendar and 
today's date appear on the 
Folder Banner. Your Calendar 
for today appears. You have 
no appointments for today. 
You do have three tasks. 

END 7 
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Section 1: Acquiring the Basics 

Getting Help 
As a new user, you need to know where you can get help. When you have a 
question about Outlook, you can  access online help quickly and easily. You 
can display ToolTips, use an Office Assistant, obtain a list of Help topics from 
Help Contents, or search for information about a specific topic using Help 
Index and Help Find. If you need help when you are using a dialog box, you 
can choose the Help button in the dialog box to see its related Help box. 

In Outlook, the simplest Help aid is ToolTips. A ToolTip appears when you 
point the mouse pointer to a button on the toolbar. For example, if you point 
to the Print button, the ToolTip Print appears. If you click the Print button, 
you print the document. 

Using an Office Assistant 

The Office Assistant is an animated character that answers your questions 
about Outlook, occasionally volunteering tips as you work. When you activate 
the Office Assistant, a balloon that asks What would you like to do? appears. 
You can click a suggestion, type a question of your own, or view a tip. 
Figure 1-2 shows the Clippit Office Assistant with a balloon. The Office 
Assistant and the balloon cover part of the Outlook window. 

Figure 1-2: The Clippit Office Assistant with a Balloon 
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Getting Help 

If the Office Assistant is not visible, you can make it appear by clicking the 
Office Assistant button on the toolbar. Figure 1-3 shows the Office Assistant 
button. 

Figure 1-3: The Office Assistant Button 

L METHOD --I 

To use an Office Assistant: 

1. On the toolbar, click the Office Assistant button. 
or 

1. If the Office Assistant is already open, click the Office 
Assistant. 

2. In the balloon, choose Tips, and, after you read the tip, choose 
Close. 
or 

2. In the balloon, in the What would you like to do? area, click a 
suggestion. 
or 

2. In the balloon, in the text box, type a question, and then choose 
Search. 

3. If necessary, repeat step 2. 
4. After you read the text in the Help window, close the window. 

n- EXERCISE 

In the following exercise, you will use an Office Assistant. 

1. On the toolbar, click the Office 	The Office Assistant and the 
Assistant button 	 balloon that asks What would 

you like to do? appear. 

2. In the text box, type calendar 

3. Choose Search 	 Another Help balloon appears. 

11 



The Microsoft Outlook Help 
Topics Calendar page 
appears, identifying areas of 
the Calendar. 

The pointer becomes a hand. 

A help screen that explains 
Date Navigator appears. 

The help screen is closed. 

The help screen explaining the 
item appears. 

The help screen is closed. 

The balloon appears. 

Today's tip appears. 

The balloon appears. 

Another balloon appears. 

The Microsoft Outlook Help 
Topics Change the view page 
appears, explaining standard 
views and how to change 
them. 
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4. In the What would you like to 
do? area, click Calendar 

5. Position the mouse pointer 
over the call out containing the 
words Date Navigator 

6. Click the call out 

7. Read the Help screen, and 
then click anywhere 

8. Click another call out 

9. Read the Help screen, and 
then click anywhere 

10. Continue to examine the Help 
window, and, when you are 
finished, close the window 

11. Click the Office Assistant 

12. Choose Tips 

13. Read the tip, and then choose 
Close 

14. Click the Office Assistant 

15. In the text box, type How do I 
change the view? 

16. Choose Search 

17. In the What would you like to 
do? area, click Change the 
view 

Section 1: Acquiring the Basics 

18. Read the text in the Help 
window, and then close the 
window 

r  END 
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Getting Help 

Choosing an Office Assistant 

Office 97 comes with nine built-in Office Assistants from which to choose. 
When you want to change the appearance of your Office Assistant, you use 
the Gallery page of the Office Assistant dialog box, shown in Figure 1-4, to 
make your choice. 

IT  

Figure 1-4: The Gallery Page of the Office Assistant Dialog Box 

L METHOD --I 
To choose an Office Assistant: 

1. Click the Office Assistant. 
2. In the balloon, choose Options. 
3. In the Office Assistant dialog box, select the Gallery tab. 
4. Scroll through the assistants by clicking the Back and the Next 

buttons. 
5. When you display the assistant you want, choose OK. 

[zi 
[211 

C311. 
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r-- EXERCISE 	  

In the following exercise, you will choose an Office Assistant. 
1. Click the Office Assistant 	The balloon appears. 

2. Choose Options 

	

	 The Office Assistant dialog box 
appears. 

3. Select the Gallery tab 	 The Gallery page appears. 
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6. Choose OK The chosen Office Assistant 
replaces the Clippit Office 
Assistant. 

Section 1: Acquiring the Basics 

4. Click the Next button eight 
times 

The Office Assistants are 
scrolled through the preview 
pane. 

Click the Back button as often 
as necessary to find the Office 
Assistant you want 

r  END ---1 
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The Calendar page of the 
Options dialog box appears. 

A question mark appears 
beside the mouse pointer. 

The help information appears. 

The help information 
disappears. 

Getting Help 

J-1 
J.  

Obtaining Context-Sensitive Help 

You might sometimes need help when using a dialog box. During any step of 
a dialog box process, clicking the question mark to the left of the dialog box 
Close button and then clicking the area of the dialog box about which you 
have a question displays a ScreenTip, context-sensitive information about the 
area. 

L METHOD 

To obtain context-sensitive help: 

1. In any dialog box, click the question mark to the left of the 
Close button. 

2. Click the area where you want help. 
3. Read the information, and then click anywhere. 

r---  EJCERC1SE 

In the following exercise, you will obtain context-sensitive help. 

1. Make sure the Calendar is 
open 

2. From the Tools menu, choose 
Options 

3. Click the question mark to the 
left of the Close button 

4. Click the button E-mail options 

5. Read the information, and then 
dick anywhere 

6. Choose Cancel to dose the 
dialog box 

1211- 	 END 

r;13 
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Section 1: Acquiring the Basics 

Printing Documents 
You can print any Outlook files to carry with you when you are out of the 
office. If you usually carry a paper day planner, you can print the file in the 
size and layout of your planner. Using the Print dialog box, shown in 
Figure 1-5, and the Format page of the Page Setup dialog box, shown in 
Figure 1-6, you can select from a variety of layouts and print any number of 
sequential days for your calendar. You can print your contact list in numerous 
styles and sizes, including a size for your rotary card file. You can print your 
e-mail, your journal, and your tasks, as well. You can choose to preview your 
selection before printing to ensure that your layout, paper format, and date or 
alphabet range is correct. 

Figure 1 -5: The Print Dialog Box 

16 
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Printing Documents 

g 
Li 

Figure 1-6: The Format Page of the Page Setup Dialog Box 

Setting Up the Page 

You might want to print today's schedule to carry to a local appointment, or 
you might prefer to print a full week's or month's schedule to take vtith you 
on a business trip. You might also need to print your Task list or your 
Contacts list. Outlook lets you print your information in whatever layout you 
specify and lets you customize the page. 

L METHOD 

To set up the page for printing: 

1. Open the Folder from which you want to print. 
2. From the File menu, choose Print. 
3. In the Print dialog box, choose Page Setup. 
4. In the Page Setup dialog box, on the Format page, select the 

options you want. 
5. Select the Paper tab. 
6. On the Paper page, in the Paper area, select the options you 

want 
7. If desired, select the Header/Footer tab, and then type the 

desired header and/or footer. 
8. Choose OK. 

17 



Section 1: Acquiring the Basics 

I --- EXERCISE 

In the following exercise, you will set up the page for printing. 

1. Make sure the Calendar is 
open 

2. From the File menu, choose 
Print 

3. Choose Page Setup 

4. On the Format page, in the 
Options area, from the Print 
from drop-down list, make sure 
9:00 AM is selected 

5. If necessary, from the Print to 
drop-down list, select 9:00 PM 

The Print dialog box appears. 

The Page Setup dialog box 
appears. 

6. Select the Paper tab The Paper-page appears. 

7. If necessary, in the Paper 
area, in the Type list, select 
Custom (the last selection in 
the list) 

8. If necessary, in the Page area, 
in the Size list, select Day 
Timer Junior Pocket 

The preview pane in the 
Orientation area shows four 
pages. 

9. Choose OK 	 The Print dialog box 
reappears. 

r  END II  
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Printing Documents 

Selecting Additional Printing Options 

You  cari select additional printing options in the Print dialog box. This is 
where you selec.  t the style and the range of your printout. 

L METHOD --1  
To select additional printing options: 

1. Open the Print dialog box. 
2. In the Print Style area, from the list of previews, select a style. 
3. In the Print Range area, from the drop-down lists, select the 

range. 

1---- EXERCISE 	  

In the following exercise, you will select additional printing options. 

1. Make sure the Print dialog box 
is open 

2. In the Print style area, from the 
Print style list, select Weekly 
Style 

3. In the Print Range area, make 
sure the Start drop-down list 
displays today's date 

4. From the End drop-down list, 
select the date one week from 
yesterday 

r  END i 

tl; 
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Section 1: Acquiring the Basics 

Previewing and Printing a Document 

You should preview your documents before printing them to make sure you 
have set your options exactly the way you want them. When you are satisfied 
with the appearance, you can print your document. 

L METHOD --I 
To preview a document: 

1. In the Print dialog box, choose Preview. 
2. If desired, in the Print Preview window, position the magnifier 

over the area you want to examine in detail, and then click the 
area. 

3. If dissatisfied with the appearance of the document, on the 
toolbar, choose Page Setup to open the Page Setup dialog box 
and to reset options. Then choose OK to return to the Print 
Preview dialog box. 

To print a document from Print Preview: 

1. On the toolbar, choose the Print button. 
2. In the Print dialog box, choose OK. 

To print a document from the Print dialog box: 

1. Choose OK.. 

i--- EXERCISE 

In the following exercise, you will preview and print your Calendar. 

1. In the Print dialog box, choose 
Preview 

2. Position the magnifier over the 
date at the top left , and then 
click the area 

The Print Preview window 
appears displaying your 
Calendar for the current week. 

The date area is magnified. 

3. Click the area again 	 The Calendar zooms out to 
show the full week. 

20 
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9. Choose OK The Calendar for this week 
and next is printed. 

r  END 

Printing Documents 

4. On the toolbar, choose Page 
Setup 

5. If necessary, in the Options 
area, select the Arrange Top to 
bottom option button 

6. In the Options area, select the 
Arrange Left to right option 
button 

7. Choose OK 

8. Choose Print  

The Page Setup dialog box 
appears. 

The Preview area shows the 
days of the week arranged to 
print top to bottom, Monday 
through Wednesday in the left 
column and Thursday through 
Sunday in the right column. 

The Preview area shows the 
days of the week arranged to 
print left to tight, Monday 
through Sunday. 

The Print Preview window 
reappears. 

The Print dialog box appears. 

E:1 

5t1 
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Section 1: Acquiring the Basics 

Ending an Outlook Session 
As with any Windows application, when you are not actively using a program, 
you can choose to minimize it or exit from it. After checking your mail and 
your calendar at the beginning of the day, you might want to minimi7e 
Outlook. This lets you check for messages periodically without signing in and 
out of the program repeatedly. It also lets Outlook send you reminders before 
your appointments. At the end of the work day, you should exit from Outlook 
and log off. 

Saving Your Data 

In many applications, you must take some action to save your data as you 
work and when you finish your work session. In a database application such as 
Outlook, many actions you take are automatically saved. 

When you make entries in the information viewer, you activate the area of the 
pane in which you are worldng. As long as you are working in that area, you 
can freely make changes. When you write an appointment directly on your 
Calendar, write a note, write a task directly on your to do list, or enter an 
activity directly in your journal, Outlook saves your data as soon as you click 
anywhere outside the activated area. 

You can also enter appointments, contacts, tasks, and journal items using 
windows Outlook provides. These windows allow you to enter far more• 
detailed information than you enter directly in the information viewer. The 
windows have a button on the toolbar that lets you save and close the window; 
only in these windows do you indicate whether to save. If you close such a 
window without saving, Outlook provides a message box that asks, Do you 
want to save change? to warn you that you are closing the window without 
saving your data and to give you another opportunity to save what you 
entered. 

When you receive a message, Outlook automatically saves it in your Inbox. 
After you read the message, you can have Outlook continue to save it in your 
Inbox or you can tell Outlook to save it in another folder. When you create an 
e-mail message to send, you can save it in your Drafts folder to send later or 
you can send it immediately, having Outlook automatically save it in your 
Sent Items folder. 

22 



Ending an Outlook Session 

Minimizing and Restoring Outlook 

By winimi7ing Outlook rather than exiting from it, you can quickly retum to 
Outlook to check your messages, appointments, and notes. When you 
minimize Outlook, Outlook continues to run in the background. The 
application is represented on the taskbar by a button that displays the active 
Outlook folder, as shown in Figure 1-7. When you have numerous programs 
running, the entire title is not usually visible. When you have a new message 
in your Inbox, Outlook displays an envelope icon on the taskbar that 
disappears when you read the message. 

Outlook button displaying 	 Envelope icon indicating a 
new message is in the lnbox 

Outlook button displaying 
a new contact card 

the Calendar folder 

[IiisiiiitralFE 	...LI  1mi:4-xi:  	 mi;z:  priür-cii 	isteC B31 3-36 PM  

J.  

Figure 1-7: Taskbar Showing Outlook Buttons 

When you want to restore the Outlook window, you simply click the Outlook 
button on the taskbar. 

23 [2131, 



Section 1: Acquiring the Basics 

Exiting from Outlook and Logging Off 

Two exit options are available from the File menu—Exit and Exit and Log 
Off. As your log in process to WinNT has already authenticated you as a user 
and there was no requirement for you to log in to Outlook, both options will 
close Outlook. 

L METHOD —I 

To exit from Outlook: 

1. From the File menu, choose Exit or Exit and Log Off 
or 

1. Click the Close button. 

EXERCISE 

In the following exercise, you vvill exit from Outlook and log off. 

1. From the file menu, chose Exit 	Outlook is closed. 
and Log Off 

r  END --I 
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To start Outlook and log in: 

1. Log in to the network. 
2. On your desktop, double-click the 

Outlook icon. 
3. If necessary, in the Microsoft 

Mail dialog box, in the Mailbox 
text box, type your user ID. 

4. In the Password text box, type 
your password. 

5. Choose OK. 

To navigate in Outlook: 

Outlook Bar method 
1. On the Outlook Bar, click the 

desired group button. 
2. Click the desired shortcut 

Folder Barmer method 
1. On the Folder Banner, click the 

name area. 
2. From the folder list, choose the 

folder you want. 

Menu method 
1. From the Go menu, choose the 

folder you want 

To obtain context-sensitive help: 

1. In any dialog box, click the 
question mark to the left of the 
Close button. 

2. Click the area where you want 
help. 

3. Read the information, and then 
click anywhere. 

To use an Office Assistant: 

1. On the Standard toolbar, click the 
Office Assistant button. 
or 

1. If the Office Assistant is already 
open, click the Office Assistant. 

2. In the balloon, choose Tips, and, 
after you read the tip, choose 
Close. 
or 

2. In the balloon, in the What would 
you like to do? area, click a 
suggestion. 
or 

2. In the balloon, in the text box, 
type a question, and then choose 
Search. 

3. If necessary, repeat step 2. 
4. After you read the text in the 

Help window, close the window. 

To choose an Office Assistant: 

1. Click the Office Assistant. 
2. In the balloon, choose Options. 
3. In the Office Assistant dialog 

box, select the Gallery tab. 
4. Scroll through the assistants by 

clicicing the Back and the Next 
buttons. 

5. \Vhen you display the assistant 
you want, choose OK. 

To set up the page for printing: 

1. Open the Folder from which you 
want to print 

2. From the File menu, choose Print. 
3. In the Print dialog box, choose 

Page Setup. 
4. In the Page Setup dialog box, on 

the Format page, select the 
options you want. 

5. Select the Paper tab. 
6. On the Paper page, in the Paper 

arca, select the options you want. 
7. If desired, select the 

Header/Footer tab, and then type 
the desired header and/or footer. 

8. Choose OK. 

25 



Section 1: Acquiring the Basics 

To select additional printing options: 

1. Open the Print dialog box. 
2. In the Print Style area, from the 

list of previews, select a style. 
3. In the Print Range area, from the 

drop-down lists, select the range. 

To preview a document: 

1. In the Print dialog box, choose 
Preview. 

2. If desired, in the Print Preview 
window, position the magnifier 
over the area you want to 
examine in detail, and then click 
the area. 

3. If dissatisfied with the 
appearance of the document, on 
the toolbar, choose Page Setup to 
open the Page Setup dialog box 
and to reset options. Then choose 
OK to return to the Print Preview 
dialog box. 

To pr'int a document from Print 
Preview: 

1. On the toolbar, choose the Print 
button. 

2. In the Print dialog box, choose 
OK. 

To print a document from the Print 
dialog box: 

1. Choose OK. 

To exit from Outlook: 

1. From the File menu, choose Exit 
or Exit and Log Off. 
or 

1. Click the Close button. 

26 
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1. Start Outlook. 

2. In My Shortcuts group, open the Deleted Items folder. 

3. Switch to the Outlook Shortcuts group and read the notes in the Notes 
folder. 

4. Ask the Office Assistant to give you information about making a 
recurring appointment. 

5. Choose another Office Assistant. 

6. From the Tools menu, choose Options. On the Preferences page of the 
Options dialog box, in the E-mail settings area, use context-sensitive 
help to learn what the E-mail Options button does. 

7. Open the Contacts folder. Prepare to print your address cards in Card 
Style. If necessary, in the Page Setup dialog box, on the Paper page, 
select letter paper with the page sized for the Day Runner Classic paper 
planner. Preview and then print your cards. 

8. Exit from Outlook. 

9. Restart Outlook. 

10. Close the Office Assistant. 

27 
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Section 2: Communicating with Mail 

Section Skills and Their Importance 
In the following section you will learn to: 

• Use the Inbox 
The Inbox is where you receive e-mail messages. You can read 
your messages, print them, and sort and filter them. You can also 
preview a message and decide whether to open it. 

• Compose a new message 
You must address and type your new message. You can edit what 
you write, format text, and check your spelling. When you are 
satisfied with your message, you can send it. 

II Forward and reply to messages 
Sometimes you will send someone else a copy of a message you 
received. In addition, you will often respond to messages. 

• Manage messages using folders 
As you add data to your folders, you might want to reorganize 
where you store the data and move your data from one folder to 
another. Sometimes you might want to delete data to eliminate 
files from your hard drive. If you fmd you deleted the wrong data, 
you can immediately recover it. 

30 
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Using the Inbox 
When new mail arrives in your Inbox, Outlook notifies you. Whether you are 
worlcing in Outlook or have Outlook minimized and are working in another 
program, Outlook makes a sound and displays an envelope icon on the taskbar 
when new mail arrives. Outlook also briefly changes your mouse pointer to 
the shape of an envelope to notify you of your new message. 

The Inbox, the Outbox, the Sent Items folder, the Drafts folder and the 
Deleted Items folder display the saine two context-sensitive Mail toolbars, the 
Standard toolbar and the Advanced toolbar. The standard toolbar is displayed 
by default. To display the Advanced toolbar, from the View menu, choose 
Toolbars, Advanced. Table 2-1 summarizes the functions of these toolbar 
buttons. 

Button 	Name 	 Function 

Standard Toolbar 

New Mail 	Opens the New Mail Message window so you 
. 	, 	Message 	can compose and send a message. The drop- 

down arrow gives you access to the New 
windows for the other Outlook features. 

Print 	Prints the selected item. To select print 
options, click File menu and choose Print. 

._ 
Move to 	Displays a list of the folders that you can 
Folder 	move an item to. 

Delete 	Removes the selected item and moves it to 
the Deleted Items folder. 

I çil ii‘l.  Y' 	
Reply 	Converts a message you received into a new 

message to which you can add comments. 
Then you can send your comments to the 
sender. 

loit,i, ic, Ai 	Reply to All 	Converts a message you received into a new 
message to which you can add comments. 
Then you can send the message and your 
comments to the sender and to everyone else 
who received the original message. 

- ■;'-er2:. :1 	Forward 
efk 	

Converts a message you received into a new 
message to which you can add comments. 
Then you can send the message to someone 
else. 

Address 	Stores the e-mail addresses of all the names 
Book 	in your postoffice. 
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Section 2: Communicating with Mail 

l aildRék-eivè 	Send and 	Connects to the server to send and receive 
Receive 	messages if working off-line 

Find 	Searches items for the word(s) your specify 

brgàii e 	Organize 	Displays or Hides the Organize pane for the 
currently selected folder so you can rearrange 
its contents. 

Office 	Displays the Office Assistant. 
Assistant 

Advanced Toolbar 

Outlook 	Displays the Outlook Today page. 
Today 

Back 	Opens the previous item. 

Forward 	Opens the next item. 

•  

Up One 	Opens the folder that is one level above the 
, 	 Level 	current folder. 

--- 	Folder List 	Displays or hides the list of all folders. 

Print 	Shows how an item will look when you print it. 
Preview 

Undo 	Reverses the last command or deletes the last 
entry you typed. 

Rules 	Automates processing messages by creating 
. 	VVizard 	rules. 

----. --- 	Current 	Filters your messages by Last Seven Days, 
View 

	

	Sender, Unread Messages, and so forth. The 
drop-down arrow lets you select a filter. 

Group By 	Groups your messages by a selected column 

.. 	

Box 	header. 

Field 	Allows you to add, remove and create fields 
-- — 	Chooser 	for a form or a view. 

AutoPreview 	Sets your message list to display the subject 
line and the first three lines of messages. 

Table 2-1: The Mail Toolbar Buttons 



Using the Inbox 

Messages that others have sent you are stored in your Inbox. If you select the 
Inbox folder in the Outlook bar, a list of your messages appears in the 
information viewer. Each entry in the message list gives you information 
about the message, such as who sent it and its subject. This information is 
listed under the coltunn headers, described in Table 2-2. 

3 
3-  

L:1] 
[Z13 

Previewing and Opening Messages 

Column 	 Function 
header 

Indicates message importance. 

Flags the message for later action. 

Indicates message type. 

Indicates whether there is an attachment. 

M 	 Identifies the sender of the message. 

eCt 1 	Identifies the subject of the message. 

Indicates when the message was received. lifi 	v- ecrl 

Table 2-2: Column Headers 

Messages that you haven't read appear in bold in the message list. The bottom 
part of your information viewer displays the currently selected message in the 
Preview pane. In addition, you can preview messages by setting the message 
list to show you the first few lines of the message. When you open the full 
message, it appears in a message window, illustrated in Figure 2-1. 



Section 2: Communicating with Mail 

0' Welcome to Outiock.1--:14elesage (Rich Ted) 	- 	ZeerkA; _  ID x 

r4,1 Reply 54  Reply to AI! e Forward  

From: 	Ceau, Chreine -CFSP 
To: 	Landry, Helen -SKR; Sizirnon.s, Fie:ène -CF5P; Proyendier', Luc -CFSP; Boucher, Micheline 
Cc: 

5.ublect; Welcome to Outlook 

Microsoft Outlook isis time management and messaging program that lets you 
exchange e-mail within your organization, through the Internet and through other 
services. 

A 
Sent:  Fr i' 12/11/9e 12:54 PM 

, ! 

•nj 

Figure 2-1: The Message Window with a Received Message 

L METHOD —I 

To preview messages: 

1. If necessary, on the Outlook Bar, click the Inbox shortcut. 
2. On the Advanced toolbar, click the AutoPreview button. 

or 
2. From the View menu, choose AutoPreview. 

To display the Preview pane: 

1. From the View menu, choose Preview Pane. 

To open a message: 

1. If necessary, on the Outlook Bar, click the Inbox shortcut. 
or 

1. On the taskbar, double-click the envelope icon. 
2. In the message list, double-click the message. 

34 



3 

3 c 
J;  
I elee 

I 
lœcr 

ISEGD 

[Mil 
[231 

 [;1111  

fu- ft 

eti 

35 

Using the lnbox 

EXERCISE 

In the following exercise, you will preview messages and you will open a 
message. 

	

1. If necessary, on the Advanced 	All messages display their first 

	

toolbar, click the AutoPreview 	three lines. 
button 

2. In the message list, double-
click the Outlook message 

3. Read the message  

The Message window opens. 

r  END 



Section 2: Communicating with Mail 

Selecting and Printing a Message 

You can print the message that is currently displayed. You can also print a 
message without opening it. 

L METHOD —1  

To select a message: 

1. In the message list, click the message. 

To print a message: 

1. Open the message. 
or 

1. In the message list, select the message. 
2. On the Standard toolbar, click the Print button. 

Note: When printing from the message list, you can select multiple 
messages to print by pressing CTIU, and selecting the desired 
messages. Release Criti, when you have selected all the desired 
messages. 

r--- EXERCISE 

In the following exercise, you will print a message. 

1. Make sure the Outlook 
message is open 

2. On the Standard toolbar, click 	The message is printed. 
the Print button 

r  END 1 

36 



Using the lnbox 

Closing a Message 
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When you have finished reading a message, you should close it. The message 
still appears in your message list, but the text that appears is no longer bold. 

L METHOD --I 

To close a message: 

1. In the Message window, click the Close button. 

r-- EXERCISE 

In the following exercise, you will close a message. 

1. In the Outlook message 
window, click the Close button 

The message is closed. The 
text that appears is no longer 
bold in the message list 

r  END 
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Section 2: Communicating with Mail 

Sorting Messages 

You can sort your messages by any item shown in the column headers of the 
message list. To sort your messages, simply click the column header on which 
you want to sort. By default, the first time you click the column header the 
sort occurs in ascending order. The next time you click the column header it 
sorts in descending order. 

L METHOD —I 
To sort messages: 

1. In the message list, click the desired column header. 
2. If desired, click the column header again to change the sort 

order. 

	EXERCISE 	  

In the following exercise, you will sort messages. 

1. On the Outlook bar, click My 	The Mail shortcuts appear. 
Shortcuts button 

2. Click the Sent Items shortcut 	The contents of the Sent items 
folder appear in the information 
viewer. 

3. In the column headers, click 
the To header 

The messages are sorted in 
alphabetical order based on 
the recipient name. 

4. Click the Sent column header 	The messages are sorted by 
date and time order. 

5. Click the Sent œlumn header 
again 

The messages are sorted by 
date order opposite to the 
preceding step. 

r  END 
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Using the Inbox 

Filtering Messages 

You =filter your data in each Outlook folder by selecting a filter from the 
Current View drop-down list. When you filter messages, you display a 
specified subset of messages. 

The Inbox Current View drop-down list gives you numerous criteria to use to 
filter the messages. Table 2-3 sununarizes the Inbox Current View filters. 

Name 	 Function 

Messages 	 Shows the subject line of all messages in the 
folder. 

Messages with AutoPreview 	Shows the subject line and the first three lines 
of all unread messages in the folder. Shows 
the subject line only of other messages. 

By Follow-Up Flag 	 Groups flagged messages first, then groups 
normal (unflagged) messages. 

Last Seven Days 	 Shows only those messages received in the 
last seven days. 

Flagged for Next Seven Days 	Shows only those messages that are flagged 
for action in the next seven days. 

By Conversation Topic 	Groups messages alphabetically by subject. 

By Sender 	 Groups messages alphabetically by sender. 

Unread Messages 	 Shows unread messages only. 

Sent To 	 Shows who else received the same message. 

Message Timeline 	 Graphically shows when each message was 
received. 

Table 2-3:  The In box  Current View Filters 

I- METHOD --I 

To filter messages: 

1. On the Advanced toolbar, click the Current View drop-down list 
arrow. 

2. From the drop-down list, select a filter. 
3. If necessary, in the message box, select an option button, and 

then choose OK. 
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EXERCISE 

In the following exercise, you will filter messages. 

1. Make sure you are in the Sent 
Items folder 

2. On the Advanced toolbar, click 
the Current View drop-down 
list arrow 

3. From the drop-down list, select 
By Conversation Topic 

4. On the Advanced toolbar, click 
the Current View drop-down 
list arrow 

5. From the drop-down list, select 
By Follow-Up Flag 

6. Filter the messages by Sent To 

The drop-down list appears. 

The messages are grouped by 
subject 

The drop-down list appears. 

The messages are all grouped 
as normal; no messages are 
tlagged. 

r  END 
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Composing a New Message 

Composing a New Message 

1;à1EL. 
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1121 To compose a new message, you use the New Message window, shown in 
Figure 2-2. You can open the New Message window from any Mail folder by 
clicking the New Mail Message button on the Standard toolbar. 

3 

3 

ÇPt 	I  AWFOP D 5se Y-1 (51r.11 
TOE- 

J 
subject: . 'Mardi Gras 

You'll have a blast at all the parades and you can come wn me to the restaurant as 
often as you like. 

Did I tell you the whole staff will be in costumes? 

Elena 

Figure 2-2: The New Message TVindow with a New Message to Send 

To create and send a message, you must do three things. First, you must 
address the message. Second, you must type the body of the message, and 
third, you must send the message. 

The buttons on the New Message window toolbar, described in Table 2-4, 
facilitate addressing and sending the message. 
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Section 2: Communicating with Mail 

But-ton 	Name 	 Function 

11- c -m 	Send 	 Sends the message. 

Save 	 Saves the message to disk. 

Print 	 Prints the message. 
—  

Cut 	 Cuts selected items and stores them in 
the Clipboard. 

Copy 	 Copies selected items and stores them 
in the Clipboard. 

Paste 	 Pastes the contents of the Clipboard at 
the insertion point. 

Signature 	 Displays additional automatic 
signatures that you can choose from 
and allows you to create new ones. 

Address Book 	Opens the Address Book, which 
contains addresses for all addressees 
in your postoffice and in your personal 
address book. 

Check Names 	Checks names that you type into the 
To field against names in the Address 
Book. 

Message Flag 	Flags the message for later attention. 

-9 « 	Importance: High 	Displays an exclamation point next to 
the message, indicating that its 
importance is high. 

Importance: Low 	Displays a down arrow next to the 

importance is low. 
liend(iecatt fiecnhgmtheahtt)its 

rig 1 	Insert File 	 mInseesrtsasgaefi, 	

in  the  

message. 

Options 	 Allows you to change the default 
options before sending your 
messages. 

Office Assistant 	Displays the Office Assistant. 

Table 2-4: New Message Window Toolbar Buttons 
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Addressing and Typing a Message 

To address a message, type the recipient's user name in the To text box. A 
user name is a unique naine  assigned to each Outlook user on your network. 
You can address a message to more than one recipient by separating each user 
name with a comma or a semicolon. If you'd like to send a courtesy copy of 
your message, type the recipient's name in the Cc text box. 

You can also type the first few characters of the recipient's user name and 
then, if Outlook can match the characters you typed with a user name, Outlook 
fills in the remainder of the name for you automatically. When an underline 
appears beneath a name in the To text box, this indicates that Outlook has 
verified the name in the postoffice. 

3 If you are not sure how to spell the recipient's name or you do not type well, 
you might prefer to use the To button to address your message. When you 
click the To button, the Select Names dialog box, shown in Figure 2-3, 
appears. Simply select the name of the recipient from the list. 

il 
3 

1-1 
lhow Name: from the: 

Type Name or See* from tr.t 

1 
a 'AGA 
a 'AG P 
a 'AT PITA 

'ATNTA-Inf Mgr 
"BAIRS 

a-BAIRS-infokl gi 
aisix 
a ITS P 

`DALAS 
•DALAS-infeigr 
'E EA 

0 I 
111 
1 11 

Ilii  

1211 
MR Ili 
mr. 

Poebe 	I 	 I Send Oot 

Figure 2-3: The Select Names Dialog Box 
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You should always type a short subject in the Subject text box. Your subject 
becomes the text in the line that the recipient sees in his or her message list 
when not using AutoPreview or the first line when using AutoPreview. 

You can move from field to field by pressing TAB or by positioning the mouse 
pointer in the desired field and clicking the mouse button. After you've 
fmished addressing the message, you can move to the message area and type 
your message. 

L METHOD 

To address and type a message: 

Check names method 
1. In any Mail folder, on the Standard toolbar, click the New Mail 

Message button. 
2. In the New Message window, in the To text box, type the 

recipient's user name. 
3. If sending the message to multiple recipients,  type,  (comma) or 

type ; (semicolon), and then enter the next name. 
4. Repeat step 3 as necessary. 
5. If desired, in the Cc text box, type a user name(s). 
6. In the Subject text box, type a short subject. 
7. In the message area, type the text of your message. 

Note: When you type the first few characters of the recipient's user 
name, Outlook can sometimes identify a match for the characters 
entered, and you need not type the full name. 

Dialog box method 
1. In any Mail folder, on the Standard toolbar, click the New Mail 

Message button. 
2. In the New Message window, choose To. 
3. In the Select Names dialog box, select a name from the list. 
4. Choose To. 
5. Repeat steps 3 and 4 as necessary. 
6. Choose OK. 
7. If desired, choose Cc. 
8. In the Select Names dialog box, select a name from the list. 
9. Choose To. 

10. Repeat steps 8 and 9 as necessary. 
11. Choose OK. 
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12. In the Subject text box, type a short subject. 
13. In the message area, type the text of your message. 

EXERCISE 

1. On the Standard toolbar, click 	The New Message window 

	

the New Mail Message button 	appears. 

2. If necessary, maximize the 
New Message window 

3. In the To text box, type your 
partner's user name 

4. Choose Cc 	 The Select Names dialog box 
appears. 

In the following exercise, you will address a message. 'Then, you will type 
your message. 

5. Select your instructor's name 

6. Choose Cc 

7. Choose OK 

8. In the Subject text box, type 
Mail Activated 

3-Ç The New Message window 
reappears. 

9. In the message area, type the 
following text, including the 
grammatical error. My 
Microsoft Outlook post 
office has been activated. I 
look forward to 
communication with you 
electronically. 

IlLe";" 

Note: Do not correct typing errors you might make. 
r  END 

let I 
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Editing Text 

After you type a message, you might need to make some changes before you 
mail the message. There might be misspelled words or grammatical errors. 
You might decide to add or delete text. In Outlook, you can edit—insert, 
delete, and replace text—in any message you are composing. 

The procedure for inserting and deleting text in Outlook is the same as in most 
Windows word-processing applications. You add text by placing the insertion 
point where you want to insert the text and typing the text. You move the 
insertion point by positioning the I-beam and clicking the mouse or by using 
the arrow keys. There are two ways to delete text. You can position the 
insertion point in the correct location and press DELETE or BACKSPAC'E, or 
you can select the text with the I-beam (drag the mouse to hielight the 
desired text) and press DELETE 

Selecting text and then typing the replacement text lets you replace many 
characters quickly. You can easily replace a single word or a block of text 
ranging from a few words to several paragraphs. 

L METHOD 

To insert text: 

1. Position the insertion point where you want to insert the text. 
2. Type the text. 

To delete text: 

1. Position the insertion point behind the first character you want 
to delete. 

2. Press BACKSPACE 
or 

1. Position the insertion point in front of the first character you 
want to delete. 

2. Press DELETE 
or 

1. Position the I-beam in front of the first character you want to 
delete. 

2. Drag the I-beam over the text to be deleted. 
3. Press BACICSPACE or DELETE 
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To replace a block of text: 

1. Position the 1-beam in front of the first character you want to 
replace. 

2. Drag the 1-beam over the text to be replaced. 
3. Type the replacement text. 

To replace a word: 

1. Double-click the word. 
2. Type the replacement text. 

EXERCISE 	  

In the following exercise, you will edit text. 

1 
IC  

11-1  

1. In the message you just typed, 
in the first sentence, place the 
insertion point between the 
word activated and the period 

2. Press SPACEBAR and then 	The text is inserted, and 
type today 	 existing text is pushed forward. 

3. Place the insertion point after 
the word communication in the 
second sentence 

3 
3 

4. Press BACKSPACE twice 	Two letters are deleted. 

5. Without moving the insertion 	Two letters are inserted. 
point, type ng 

6. In the first sentence, position 
the I-beam in front of the h in 
the word has 

7. Drag to select the words has 
been 

8. Type is 	 The text is replaced. 
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9. In the second sentence, 
double-click the word 
electronically 

The word is selected. 

10. Type via e-mail 	 The word is replaced. 

01. 
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The Formatting toolbar in the New Message window lets you bold, italicize, 
and underline text. You can also change the color of the text, add bullets, and 
change the alignment. In addition, you can change your font with the Font and 
Font Size drop-down lists. Table 2-5 describes the buttons on the formatting 
toolbar. 

J  

Formatting Text 

Button 	Name 	 Function 

Font Color 	Displays selected text in a color. Clicking 
the drop-down arrow displays a color 
palette from which to select the font color. 

n Bold 	 Bolds the selected text. 

J Italic 	 Italicizes the selected text. 

ri Underline 	Underlines  the selected text. 

.. 	Align Left 	Left-aligns selected text 
in the message. 

n 	Center 	 Center-aligns selected tee 
in the message. 

Align Right 	Right-aligns selected text — 
in the message. n 	Justify 	Aligns selected text to left and right 
margins. 

lg- .— 	Bullets 	 Changes the selected text to bulleted text 
.— 

so that it starts with a bullet. 

4N- 	Decrease 	 th 
-r- 	

Decreases 	e indentation of the text. 
Indent 

J 

irj 

LIE 

I4-71- 	
Increase Indent Increases the indentation of the text. 

Table 2-5: Formatting Toolbar Buttons 

Note: Many other mail programs can process only ASCII, or plain text, 
messages. Users of these programs will not see your formatting. 

Ill I 
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L METHOD 

To format text: 

1. Select the text you want to format. 

2. If desired, on the Formatting toolbar, click the desired button. 
3. If desired, from the Font drop-down list, select a font. 

4. If desired, from the Font Size drop-down list, select a font size. 

EXERCISE 

In the following exercise, you will format text. 

1. In the first sentence, select the 	The twirl is highlighted. 
word Outlook 

2. On the Formatting toolbar, 	The word is italicized. 
click the Italic button 

3. In the second sentence, select 	The words are highlighted. 
the words via e-mail 

4. On the Formatting toolbar, 	The color palette is displayed. 
click the Font Color button 

5. Choose Blue 	 The words are colored blue. 

6. Select the word today 	 The word is highlighted. 

7. From the Font drop-down list, 	The font for the word is 
select any font 	 changed. 

8. From the Font size drop-down 	The font size for the word is 
list, select 12 	 changed to 12 points. 

9. On the Formatting toolbar, 	The message is centered. 
click the Center button 

10. On the Formatting toolbar, 
click the Align Right button 

11. On the Formatting toolbar, 
click the Align Left button 

The message is right-aligned. 

The message is left-aligned. 

r  END 
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Working with Signatures 

You can include your name, a standard message, or any other text at the end 
of messages you send by using Outlook's Signature feature. Depending on the 
type of messages you send, you might want to create several signatures. For 
example, first, you might create a formal signature that contains your first and 
last names and your title to use for messages to clients or others with whom 
you are not well acquainted. Next, you might also create an informal signature 
that includes only your first name for contacts you know well. You  cari  create 
a signature from scratch, or you can base the signature on a file that is the 
same file format as your message file format. 

You can create signatures at any time when you are working in Outlook. To 
begin creating signatures, you need to access the Options dialog box. If you 
want to create signatures when you are working in a new message window, 
you can open the Options dialog box by switching to the mail folder from 
which you opened the message window and then choosing Options from the 
Tools menu. From the Options dialog box, you access the Signature Picker 
dialog box, shown in Figure 2-4, and the Create New Signature dialog box, 
shown in Figure 2-5. From the Create New Signature dialog box, you also 
need to access the Edit Signature dialog box, shown in Figure 2-6. Once you 
create your signature(s) and close the Options dialog box, you can switch back 
to the new message window and choose a signature to include with the 
message. 

Elena lTinters 
Elencile Reetaurant 

Figure 2-4: The Signature Picker Dialog Box 
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Create New Signature 

2. Choose how to create your 5ignatee: 

(e. Start with a blank Signature 

.1: 	 t 

'4:17 Advanced 

Ec5t Signature r: IFonaall BD  
r7Signature text 	, 	, 	. 

This text will beincluded' 	in outgoing rriaJ rriessag 

Elena Winters 
Owner, Elena's Restaurant' 

!.jVi
-  

Attach this business card (vCard) to this signature: 

ew vCard  (roui  Contact.. 

Cancel 
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Figure 2-5: The Create New Signature Dialog Box 

Figure 2-6: The Edit Signature Dialog Box 
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CIII 

If you decide you don't want to use a signature after it has been created, you 
can remove the signature from the list of signatures. Deleting a signature from 
the list has no effect on the content of messages in which you have included 
the signature. 

L METHOD --I 
To create signatures 

1. If necessary, from the new message window, switch to the 
mail folder from which you opened the window. 

2. In the mail folder, from the Tools menu, choose Options. 
3. In the Options dialog box, select the Mail Format tab. 
4. On the Mail Format page, in the Signature area, choose 

Signature Picker. 
5. In the Signature Picker dialog box, choose New. 
6. In the Create New Signature dialog box, in the Enter a 

name for your new Signature text box, type a name for the 
signature. 

7. If necessary, in the Choose how to create your Signature 
area, select the desired option button and, if required, select 
a template signature or file. 

8. Choose Next. 
9. In the Edit Signature dialog box, in the Signature text area, 

in the This text will be included in outgoing mail messages 
text box, type the text for the signature. 

10. If desired, in the vCard options area, select or define a 
business card to attach to the signature. 

11. Choose Finish. 
12. If desired, repeat steps 5 through 11 to define additional 

signatures. 
13. In the Signature Picker dialog box, choose OK. 
14. In the Options dialog box, choose OK. 

To include a signature with a message 
1. If necessary, open or switch to a new message window. 
2. As desired, create the message. 
3. Position the insertion point where you veant the signature to 

appear. 
4. On the Standard toolbar, click the Signature button. 
5. From the Signature menu, choose the desired signature. 

Ea 
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To remove signatures 

1. If necessary, from the new message window, switch to the 
mail folder from wlaich you opened the window. 

2. In the mail folder, from the Tools menu, choose Options. 
3. In the Options dialog box, select the Mail Format tab. 
4. On the Mail Format page, in the Signature area, choose 

Signature Picker. 
5. If necessary, in the Signature Picker dialog box, in the 

Signature list, select a signature to delete. 
6. Choose Remove. 
7. In the message box that asks, Are you sure you want to 

permanently remove this Signature? choose Yes. 
8. As desired, repeat steps 5 through 7 to delete additional 

signatures. 
9. In the Signature Picker dialog box, choose OK. 
10. In the Options dialog box, choose OK. 

7— EXERCISE 

In the following exercise, you will work with signatures. 

First, you will create signatures. 

1. From the new message window, 
use the taskbar to switch to the 
Sent Items folder 

2. From the Tools menu, choose 
Options 

3. Select the Mail Format tab 

4. In the Signature area, choose 
Signature Picker 

5. Choose New 

6. In the Enter a name for your new 
Signature text box, type Formal 

The Options dialog box appears. 

The Mail Format page appears. 

The Signature Picker dialog box 
appears. 

The Create New Signature dialog 
box appears. 
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ir The Edit Signature —  [Forma!] 
 dialog box appears. 

8. Choose Next 

Composing a New Message 

7. If necessary, in the Choose how 
to create your Signature area, 
select the Start with a blank 
Signature option button 

9. In the Signature text area, in the 
This text will be included in 
outgoing mail messages text 
box, type your first and last 
names, press Enter, and then 
type your job title 

10. Choose Finish 

11. Following the procedure 
described above, name and 
create a second signature that 
includes only your first name or 
nickname 

12. In the Signature Picker dialog 
box, choose OK 

13. Choose OK 

14. Use the taskbar to switch to the 
new message window 

15. Position the insertion point at the 
end of the message, and then 
press ENTER twice 

16. On the Standard toolbar, click 
the Signature button 

17. Choose Formal 

A two line formal signature is 
created. 

The Edit Signature dialog box 
closes, and the Signature Picker 
dialog box reappears. The new 
signature is listed in the dialog 
box and appears in the Preview 
window. 

Two signatures are listed in the 
Signature Picker dialog box. 

The Options dialog box 
reappears. 

The dialog box closes, and the 
Sent items folder reappears. 

The insertion point moves down 
two lines. 

The Signature menu appears. 

Your  Formai signature is inserted 
into the message. 

Next, you will include a signature with a message. 
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Now, you will remove signatures. 

18. From the new message window, 
use the Windows NT taskbar to 
switch to the Sent Items folder 

19. From the Tools menu, choose 
Options 

20. Select the Mail Format tab 

21. In the Signature area, choose 
Signature Picker 

22. In the Signature list, select 
Formal 

23. Choose Remove 

The Options dialog box appears. 

The Mail Format page appears. 

The Signature Picker dialog box 
appears. 

A message box that asks, Are you 
sure you want to permanently 
remove this Signature? appears. 

24. Choose Yes The message box closes, and the 
signature is  deleted. 

25. Following the procedure 
described above, remove the 
second signature from the list 

ell 
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26. In the Signature Picker dialog 
box, choose OK 

The Options dialog box reappears. 

27. Choose OK The dialog box closes, and the Sent 
items folder reappears. 

28. Use the taskbar to switch to the 
new message window 

The signature still appears in the 
message. 

n  END 

iift  
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Sending a Message 

When you have finished typing the message, click the Send button on the 
toolbar. When you click the Send button, Outlook places your message in the 
Outbox. At regular intervals, the network checks your Outbox and sends the 
messages it  contins.  You can then find your message in the Sent Items folder. 

You can set an option from the Tools menu to run a final spelling check when 
you send your message. If you set this option, then, when you send your 
message, if you still have a misspelled word, the Spelling dialog box, shown 
in Figure 2-7, appears, and it shows you your errors. 

Spdfing 	 raereedefflt Ej E3 

- 	 r  Nat in Dictionary -  conn—orns •  

.31 

Figure 2-7: The Spelling Dialog Box 

L METHOD --I 

To send a message: 

1. In the New Message window, on the Standard toolbar, click the 
Send button. 

2. If necessary, in the Spelling dialog box, examine the word that 
appears in the Not in Dictionary area. 

3. If the word is spelled correctly, choose Ignore or Ignore All to 
accept the word for this message only or choose Add to add the 
word to your custom dictionary. 
or 

3. If the word is spelled incorrectly, in the Suggestions area, select 
the correctly spelled word, if available, or correct the spelling in 
the Change to text field. 
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rzr 
:32 4. Choose Change or Change All to correct the spelling for this 

message. 

5. Repeat steps 2 through 4 as necessary. 

EXERCISE 	  

In the following exercise, you will send a message. 

1. Make sure the message is still 
open 

2. On the toolbar, click the Send 	The Spelling dialog box 
button 	 appears. The Not in Dictionary 

area displays the word 
concirns. The Suggestions 
area suggests the word with 
the correct spelling. 

3. Choose Change The spelling error is corrected. 

4. If your name appears, choose 
Add 

Your name is added to the 
Custom Dictionary. 

5. If necessary, correct spelling 
errors you made while entering 
the message text 

The message is sent. 
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Forwarding and Replying to Messages 

1:3111 Forwarding and Replying to Messages 
Outlook lets you forward and reply to messages that you receive. If you want 
to forward a message to someone who did not receive the original, use the 
Forward button on the toolbar. The Reply to Sender button lets you respond to 
the originator of the message, while the Reply to All button lets you respond 
to all the individuals who received the message. 

Forwarding a Message 

When you open a message and then click the Forward button, a New Message 
window opens containing the message you want to forward, as shown in 
Figure 2-8. The title bar shows an envelope icon followed by the letters FW: 
and then displays the subject of the original message. After you address the 
message, you can add a comment at the top of the message area and then 
send it. 

Figure 2-8: The New Message Window When You Forward a Message 

ttD 
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L METHOD 

To forward a message: 

1. Open the original message. 
or 

1. In the message list, select the message. 
2. On the Standard toolbar, click the Forward button. 
3. Address the message. 
4. If desired, at the top of the message area, type comments. 
5. Send the message. 

EXERCISE 

In the following exercise, you will forward a message. 

1. In the Outlook Bar, click the 
Inbox shortcut 

2. If necessary, check for new 
messages 

3. In the message list, double-
click the message your mail 
partner just sent you 

The message opens. 

4. On the Standard toolbar, click 	The message appears in the 
the Forward button 	 New Message window. 

5. Follow your instructor's 
directions to address the 
message to someone else. 

ii  

6. At the top of the message 
area, type Look! [Your 
partner's name] has 
Outlook! 

7. Send the message 

8. If necessary, close the original 
message 



Forwarding and Replying to Messages 

When you reply to a message, you can reply to the originator only or you can 
reply to the originator and to everyone else who received the message. Click 
the Reply to Sender button to respond to the originator, or click the Reply to 
All button to respond to the originator and to everyone else who received the 
message. Figure 2-9 shows the New Message w -indow when you reply to a 
message. 

When you click a Reply button, a New Message window opens, just as it does 
when you are forwarding a message. In this case, however, the To text box is 
filled in for you with the original sender's address or the sender and all the 
recipients' addresses, and the insertion point is automatically positioned at the 
top of the message area. 

Replying to a Message 

Sent 	Friday, Noverr.ber 13, 1938 11:56 AM 
To: 	Gatpeau Chreine : SXR Lan&y, tie:ele -SX12 
Subject: 	RV. NT Account D Format and Rules 

All. 

Following further discussions/confirmations here's how the format of the KT 
be. ;4 	ke,
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Thank you for your note 

—Oricinal Message- 
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Figure 2-9: The New Message TVindow When You Reply to a Message 
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L METHOD 

To reply to a message: 

1. Open the original message. 
or 

1. In the message list, select the message. 
2. On the Standard toolbar, click the Reply button. 

or 
2. On the Standard toolbar, click the Reply to All button. 
3. At the top of the message area, type your response. 
4. Send the reply. 

EXERCISE 

In the following exercise, you will reply to a message. 

1. In the message list, open the 
message from your mail 
partner 

2. On the Standard toolbar, click 
the Reply button 

3. Type Thanks for your note. 

4. Send the reply 

5. If necessary, close the original 
message 

The message appears in the 
New Message window with the 
original sender's name filled in 
and the insertion point 
posilloned at the top of the 
original message area. 

END 
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Managing Messages Using Folders 

Managing Messages Using Folders 
When your messages arrive, Outlook stores them in the Inbox. As messages 
accumulate, your Inbox can become a confusing jumble. To help you sort 
things out, you can create folders for orderly message storage. 

After you've read a message, you can move it to a folder for storage or, if you 
don't need it anymore, you can delete it. Deleting messages saves you space in 
your mailbox. 

You can manage your messages, and you can also manage data in other 
Outlook folders, using buttons on the Standard and Advanced toolbars. These 
buttons, summarized in Table 2-6, are common to all the Outlook folders. 

Button 	Name 	 Function 

Up One 	Displays the folder one level above the 
Level 	subfolder in which you are working. 

Folder List 	Toggles the folder list. 
I E 

... nu...ea.,. 	 Move to 	Moves a file from one folder to another. 
Folder 

- 	Delete 	Removes the selected file from its folder and 1....x 	
stores it in the Deleted Items folder. 
Permanently deletes the selected file from the 
Deleted Items folder. 

Table 2-6: The Outlook Folder Management Toolbar Buttons 

You open the My Shortcuts group folders from the Outlook Bar. But once you 
create subfolders, you might find it easier to use the folder list The folder list 
displays a folder tree that looks like a folder tree you might see in Explorer 
and in My Computer. The Outlook folder list displays only the Outlook 
folders, as shown in Figure 2-10. When the folder list is collapsed, you see 
only the main folders. When the folder list is expanded, you see the 
subfolders, too. In the folder list, you can create new folders, move data from 
folder to folder, and delete and recover data. 
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-  

- 	Outlook Today - (Mailbox 
._..e Calendar -...0 Contacts 
19 Deleted Items 

--,z5 Drafts 
_..ezi Inbox --(3 Journal --e. Notes —'q; Outbox -* Sent Items —. 	Tasks 	 

Figure 2-10: A Collapsed Folder List 

Creating a Folder 

As you collect more and more data, you might want to make additional folders 
in which to keep your records more neatly. For example, you might want to 
store messages related to one project in one folder and messages related to 
another project in another folder. And once you get on e-mail mailing lists, 
you can certainly use additional file folders in which to sort the mail you 
received and want to keep. To keep organized, you can create a new folder in 
the Create New Folder dialog box, shown in Figure 2-11. 
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Create New Folder  

Folder contains: 

I ma Items 

. 5,e1ect where to place the folder: 
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Figure 2-11: The Create New Folder Dialog Box 
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2. Select the Inbox 	 The message list appears. 

3. From the File menu, choose 
New 

The New submenu appears. 

,à),à 
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Managing Messages Using Folders 

L METHOD 

To create a folder: 

1. On the Advanced toolbar, click the Folder List button. 
2. Select the folder to which you want to add a subfolder. 
3. From the File menu, choose New, and from the New submenu, 

choose Folder. 
4. In the Create New Folder dialog box, in the Name text box, type 

the name for the new subfolder. 
5. Choose OK. 

r---- EXERCISE 	  

In the following exercise, you will create new folders for your Inbox. 

1. On the Advanced toolbar, click 	The folder list appears. 
the Folder List button 

4. Choose Folder 

5. In the Name text box, type 
Restaurant mail 

6. Choose OK 

7. From the File menu, choose 
New 

8. Choose Folder 

9. In the Name text box, type 
Class 

10. Choose OK 

The Create New Folder dialog 
box appears. 

The new folder appears in the 
folder list as a subfolder of the 
lnbox folder. The lnbox is 
selected. 

The New submenu appears. 

The Create New Folder dialog 
box appears. 

The second new subfolder 
appears in the folder list 

r  END 
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Moving a Message to a Folder 

Creating a folder hierarchy is helpful only if you use it to organize your 
messages. You should move a message from the Inbox to a long-term folder 
as soon as you read it and decide to keep it. 

After you create new subfolders, you can move the messages you have stored 
in the Inbox folder to the subfolders you created. You can also move messages 
from one subfolder to another. 

When you display the folder list, you can drag a message from one folder to 
another. You can also use the Move to Folder button on the toolbar to move 
files from one folder to another. The Move to Folder button displays a menu 
listing folders to which you have moved messages and also lets you access the 
Move Items dialog box. The Move Items dialog box, shown in Figure 2-12, 
lets you select any folder into which to move the selected file. 

Idove Item 	- 	 E3 
Move the selected kerns to the folder: 

E- 	Malbox - Landry, Helene -SXR 
Calendar 

He Contacts 
—(9 Deleted Items 

Drafts (1 ) 
Inbox 
Journal 
Notes 

L.Ke outbox 
Sent Items 
Tasks 

Public  Folders 

Figure 2-12: The Move Items Dialog Box 
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Managing Messages Using Folders 

L METHOD 

To move a message to a folder: 

ut 

Drag method 
1. Display the folder list and expand it as necessary. 
2. Drag the message to the appropriate folder. 

Toolbar method 
1. Select the message you want to move. 
2. On the Standard toolbar, click the Move to Folder button. 
3. From the menu, choose the appropriate folder. 

or 
3. From the menu, choose Move to Folder. 
4. In the Move Items dialog box, expand the folder list as 

necessary, and then select the appropriate folder. 
5. Choose OK. 

EXERCISE 

In the following exercise, you will move messages to a folder. 

Inf 

Eau  

Uri 

F 

1. From the message list, drag 
the message from your partner 
to the Class folder 

2. Select the Outlook message 

3. On the Standard toolbar, click 
the Move to Folder button 

4. Choose Move to Folder 

5. Make sure the Class folder is 
selected, and then choose OK 

6. In the folder list select the 
Class folder 

The message is moved and 
disappears from the Inbox 
message list 

A menu appears. 

The Move Items dialog box 
appears. 

The message is moved and 
disappears from the lnbox 
message list 

Your pattner's message and 
the Outlook message appear 
in the message list 

[-END 
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Deleting and Restoring a Message 

A cluttered Inbox makes it difficult to locate specific messages. You should 
delete messages you don't want to keep. You might want to review the 
messages in all folders periodically and delete messages that are no longer 
relevant. If you have a message you no longer want, you can delete it using 
the Delete button on the Standard toolbar. 

Deleted items go to the Deleted Items folder. If you want to recover an item 
from the Deleted Items folder, you can easily select and restore it. But once 
you delete items from the Deleted Items folder, Outlook removes them 
completely from your computer. They do not go to the Recycle Bin and are no 
longer retrievable. 

If you receive a notice that your mailbox is running out of space, you should 
check your Deleted Items folder for items that you can permanently delete. 

L METHOD —1  

To delete an item and hold it: 

1. Select the item you want to delete. 
2. On the Standard toolbar, click the Delete button. 

To restore deleted items: 

I. Open the Deleted Items folder. 
2. Select the item(s) you want to restore. 
3. On the Standard toolbar, click the Move to Folder button. 
4. From the menu, if the folder is listed, choose the folder. 

or 
4. From the menu, if the folder is not listed, choose Move to 

Folder. 
5. If necessary, in the Move Items dialog box, in the Move the 

selected items to the folder: list, select the folder and then 
choose OK. 

JB 

To permanently delete items: 

1. Open the Deleted Items folder. 
2. Select the item(s) you want to delete permanently. 
3. On the Standard toolbar, click the Delete button. 
4. In the Office Assistant balloon or the message box, choose Yes. 

CZEI 
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Managing Messages Using Folders 

7--- EXERCISE 
1 

In the following exercise, you will delete and restore items. 

1. Make sure the Class folder is 
open 

2. Select the Outlook message 

3. On the Standard toolbar, click 
the Delete button 

The message is deleted. 

4. Open the Deleted Items folder The message appears in the 
list 

5. Select the Outlook message 

6. On the Standard toolbar, click 
the Move to Folder button 

The menu appears. 

7. Choose Class The message is moved to the 
Class folder and disappears 
from the Deleted Items list 

8. Open the Class folder 

9. Open the Sent Items folder 

10. Delete the message to Linda 
Elengold 

11. Open the Deleted Items folder 

The message is restored. 

The message list appears. 

The deleted message appears 
in the list 

12. Select the message 

13. On the Standard toolbar, click 
the Delete button 

A message box that asks Are 
you sure that you want to 
permanently delete the 
selected item(s)? appears. 

14. Choose Yes The message is permanently 
deleted. 

15. On the Advanced toolbar, click 	The folder list closes. 
the Folder List button 

r  END --1 
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To preview messages: 

1. If necessary, on the Outlook Bar, 
click the Inbox shortcut. 

2. On the Advanced toolbar, click 
the AutoPreview button. 
or 

2. From the View menu, choose 
AutoPreview. 

To display the Preview Pane: 

1. From the View menu, choose 
Preview Pane. 

To open a message: 

1. If necessary, on the Outlook Bar, 
click the Inbox shortcut. 
Or 

1. On the taskbar, double-click the 
envelope icon. 

2. In the message list, double-click 
the message. 

To select a message: 

1. In the message list, click the 
message. 

To print a message: 

1. Open the message. 
or 

1. In the message list, select the 
message. 

2. On the Standard toolbar, click the 
Print button. 

To close a message: 

1. In the Message window, click the 
Close button. 

To sort messages: 

1. In the message list, click the 
desired column header. 

2. If desired, click the column 
header again to change the sort 
order. 

To filter messages: 

1. On the Advanced toolbar, click 
the Current View drop-down list 
alTOW. 

2. From the drop-down list, select a 
filter. 

3. If necessary, in the message box, 
select an option button, and then 
choose OK. 

To address and type a message: 

Check names method 
1. In any Mail folder, on the 

Standard toolbar, click the New 
Mail Message button. 

2. In the New Message window, in 
the To text box, type the 
recipient's user name. 

3. If sending the message to 
multiple recipients,  type, 
(comma) or type ; (semicolon), 
and then enter the next name. 

4. Repeat step 3 as necessary. 
5. If desired, in the Cc text box, type 

a user name(s). 
6. In the Subject text box, type a 

short subject. 
7. In the message area, type the text 

of your message. 

Dialog box method 
1. In any Mail folder, on the 

Standard toolbar, click the New 
Mail Message button. 

2. In the New Message window, 
choose To. 

3. In the Select Names dialog box, 
select a name from the list 
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4. Choose To. 
5. Repeat steps 3 and 4 as 

necessary. 
6. Choose OK. 
7. If desired, choose Cc. 
8. In the Select Names dialog box, 

select a name from the list • 
9. Choose To. 

10. Repeat steps 8 and 9 as 
necessary. 

11. Choose OK. 
12. In the Subject text box, type a 

short subject. 
13. In the message area, type the text 

of your message. 

To insert text: 

1. Position the insertion point where 
you want to insert the text. 

2. Type the text 

To replace a block of text: 

1. Position the I-beam in front of the 
first character you want to 
replace. 

2. Drag the I-beam over the text to 
be replaced. 

3. Type the replacement text. 

To replace a word: 

1. Double-click the word. 
2. Type the replacement text. 

To delete text: 

1. Position the insertion point 
behind the first character you 
want to delete. 

2. Press BACKSPACE 
or 

1. Position the insertion point in 
front of the first character you 
want to delete. 

2. Press DELETE 
or 

1. Position the I-beam in front of the 
first character you want to delete. 

2. Drag the I-beam over the text to 
be deleted. 

3. Press BACKSPACE or DELETE 

To format text: 

1. Select the text you want to 
format. 

2. If desired, on the Formatting 
toolbar, click the desired button. 

3. If desired, from the Font drop-
down list, select a font. 

4. If desired, from the Font Size 
drop-down list, select a font size. 

To create signatures 

1. If necessary, from the new 
message window, switch to the 
mail folder from which you 
opened the window. 

2. In the mail folder, from the Tools 
menu, choose Options. 

3. In the Options dialog box, select 
the Mail Format tab. 

4. On the Mail Format page, in the 
Signature area, choose Signature 
Picker. 

5. In the Signature Picker dialog 
box, choose New. 

6. In the Create New Signature 
dialog box, in the Enter a name 
for your new Signature text box, 
type a name for the signature. 

7. If necessary, in the Choose how 
to create your Signature area, 
select the desired option button 
and, if required, select a template 
signature or file. 

8. Choose Next. 
9. In the Edit Signature dialog box, 

in the Signature text area, in the 
This text will be included in 
outgoing mail messages text box, 
type the text for the signature. 

10.If desired, in the vCard options 
area, select or define a business 
card to attach to the signature. 

11.Choose Finish. 
12. If  desired, repeat steps 5 through 

11 to define additional signatures. 
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Section 2: Communicating with Mail 

13.1n the Signature Picker dialog 
box, choose OK. 

14.In the Options dialog box, choose 
OK. 

To include a signature with a message 

1. If necessary, open or switch to a 
new message window. 

2. As desired, create the message. 
3. Position the insertion point where 

you want the signature to appear. 
4. On the Standard toolbar, click the 

Signature button. 
5. From the Signature menu, choose 

the desired signature. 

To remove signatures 

1. If necessary, from the new 
message window, switch to the 
mail folder from which you 
opened the window. 

2. In the mail folder, from the Tools 
menu, choose Options. 

3. In the Options dialog box, select 
the Mail Format tab. 

4. On the Mail Format page, in the 
Signature area, choose Signature 
Picker. 

5. If necessary, in the Signature 
Picker dialog box, in the 
Signature list, select a signature 
to delete. 

6. Choose Remove. 
7. In the message box that asks, Are 

you sure you want to permanently 
remove this Signature? choose 
Yes. 

8. As desired, repeat steps 5 through 
7 to delete additional signatures. 

9. In the Signature Picker dialog 
box, choose OK. 

10.In the Options dialog box, choose 
OK 

To send a message: 

1. In the New Message vvindow, on 
the Standard toolbar, click the 
Send button. 

2. If necessary, in the Spelling 
dialog box, examine the word that 
appears in the Not in Dictionary 
area. 

3. If the word is spelled correctly, 
choose Ignore or Ignore All to 
accept the word for this message 
only or choose Add to add the 
word to your custom dictionary. 
or 

3. If the word is spelled incorrectly, 
in the Suggestions area, select the 
correctly spelled word, if 
available, or correct the spelling 
in the Change to text field. 

4. Choose Change or Change All to 
correct the spelling for this 
message. 

5. Repeat steps 2 through 4 as 
necessary. 

To forward a message: 

1. Open the original message. 
Or 

I .  In the message list, select the 
message. 

2. On the Standard toolbar, click the 
Forward button. 

3. Address the message. 
4. If desired, at the top of the 

message area, type coimnents. 
5. Send the message. 

To reply to a message: 

1. Open the original message. 
or 

1. In the message list, select the 
message. 

2. On the Standard toolbar, click the 
Reply button. 
or 

2. On the Standard toolbar, click the 
Reply to All button. 
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3. At the top of the message area, 
type your response. 

4. Send the reply. 

To create a folder: 

1. On the Advanced toolbar, click 
the Folder List button. 

2. Select the folder to which you 
want to add a subfolder. 

3. From the File menu, choose New, 
and from the New submenu, 
choose Folder. 

4. In the Create New Folder dialog 
box, in the Name text box, type 
the name for the new subfolder. 

5. Choose OK. 

To move a message to a folder: 

Drag method 
1. Display the folder list and expand 

it as necessary. 
2. Drag the message to the 

appropriate folder. 

Toolbar method 
1. Select the message you want to 

move. 
2. On the Standard toolbar, click the 

Move to Folder button. 
3. From the menu, choose the 

appropriate folder. 
Or 

3. From the menu, choose Move to 
Folder. 

4. In the Move Items dialog box, 
expand the folder list as 
necessary, and then select the 
appropriate folder. 

5. Choose OK.  

To restore deleted items: 

1. Open the Deleted Items folder. 
2. Select the item(s) you want to 

restore. 
3. On the Standard toolbar, click 

Move to Folder button. 
4. From the menu, if the folder is 

listed, choose the folder. 
or 

4. From the menu, if the folder is 
not listed, choose Move to 
Folder. 

5. If necessary, in the Move Items 
dialog box, in the Move the 
selected items to the folder: list, 
select the folder and then choose 
OK. 

To permanently delete items: 

1. Open the Deleted Items folder. 
2. Select the item(s) you want to 

delete permanently. 
3. On the Standard toolbar, click the 

Delete button. 
4. In the Office Assistant balloon or 

the message box, choose Yes. 

To delete an item and hold it: 

1. Select the item you want to 
delete. 

2. On the Standard toolbar, click the 
Delete button. 

1) 
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Self: Check  Exercise 

1. Address a new message to your partner with the subject Food Drive. 

2. In the message area, type the following text (include the misspellings). 
Use the AutoComplete tip. 

Dear Sir or Madam: 

Next week we're holding our anual food drive for the Orleans 
Parish Food Bank. We need non-perishible food items. Please bring 
your foodto my restaurant. 

3. In the second sentence, insert the words canned food and other before 
the word non-perishable. 

4. In the third sentence (Please bring...), add a space between donations 
and to. Then replace the wordfood with donations. 

5. Change the formatting of the Orleans Parish Food Bank to 14 point 
italic. Align the message to the right. Then realign the message to the 
left. 

CIE 
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6. Delete your AutoSignature, and then create a new AutoSignature using 
your full name. 

7. Correct the spelling and send the message. 

8. Preview and read a new message. Print the message. Move the message 
to the Restaurant mail folder. 

9. Open the Olajuwan Farewell message. 

10. Forward the message to your partner, typing the following comment at 
the top of the message area: Would you like to bring something? 

11. In the Inbox, move the Olajuwan message to the Restaurant mail 
folder. 

12. Open the Vendor Meeting message. 

13. Reply to the sender with the following comment added at the top of the 
message area: I would like to attend. 

1:131i 
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Self-Check Exercise 

14. In the Sent Items folder, create a Business Mail subfolder and a 
Personal Mail subfolder. 

15. File the Joan Berkson and the Anne Marble sent items in the Business 
Mail subfolder. File the Susan Crawford sent item in the Personal Mail 
subfolder. 

16. Delete the Susan Crawford Sent Item from the Sent Items Personal 
Mail subfolder and then restore it to the same folder. 

17. Permanently delete the Vendor Meeting message. 

18. Close the folder list. 
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Section 3: Organizing Contacts 

Section Skills and Their Importance 
In the following section you will learn to: 

• Create a contact list • 
Outlook stores your contact fist—names, business and home 
addresses, phone and fax numbers, e-mail addresses, web sites, and 
more—and gives you direct access to those contacts. You can also 
enter and update relevant information, including additional notes 
and reminders. 

II Manage contacts 
You  can  view and sort your contact list in several ways, hiding and 
showing only the fields you want. You can even use the contact list 
to help you remember the name of a person who works for the 
company that you want to call. You can update, organi7e, and 
retrieve your contact list, grouping and sorting it as you prefer. 

1 
fj 

A 

(C315.3mG  

((piinC-«*jaili6die‘  
(Preat  

pe 
(L12/11 



17=1111M= 
I 	EX yaw !So jock Adore ..:),A3 

192 El 

• 	D:.; 	•=à. 	 ..;°`-'1`5°_,  .17?  _ 
Ci  . 	 *Wrens Cards 

rthelook ShatcLet 

t  
re7.1 

d 

Jj 

- PC 4  

1 	- 

_ t 

x 

Zifit ) 
1) 79 

1 

r=ri 

relle 

r 

Ur] 

rie 

) 
D) 

) 
) 

9 

9 

Creating a Contact List 

Creating a Contact List 
When you open the Contacts folder, Outlook displays the contact list, 
illustrated in Figure 3-1, in the information viewer. The contact list contains 
names, phone numbers, and other important information about your business 
and personal associates. With a contact list, you can store, update, organize, 
and retrieve your colleagues' contact information. If you forget a contact's 
name, you can look that person up another way, such as by workplace or by 
any other field listed in the contact information. 
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Figure 3-1: The Contact List Displayed as Address Cards 

If you have more contacts stored in your folder than you can display at one 
time in the information viewer, you can click one of the alphanumeric tabs at 
the right of the screen to display the contact you want. 

As in other Outlook folders, there are context-sensitive buttons on the toolbars 
that are available only in the Contacts folder. Table 3-1 describes the fimctions 
of these toolbar buttons. 



Section 3: Organizing Contacts 

Button 	Name 	 Function 

Standard Toolbar buttons 
1 	New Contact 	Opens the New Contact window so that you 

can add a new contact address card. The 
drop-down arrow gives you access to the 
New windows for the other Outlook features. 

AutoDialer 	If connected, places a call to your contact. 
The drop-down arrow displays the selected 
contact's phone numbers and gives you 
dialing options. 

Opens a New Message window addressed to MI 	Message to 	the selected contact 
New 

Contact 

Advanced Toolbar buttons 
„...., 	

New Meeting 	Opens a New Meeting window addressed to 
with Contact 	the selected contact. 

New Task for 	Opens a New Task window assigned to the 
Contact 	selected contact 

Explore Web 	Opens the selected contact's web page. 
Page 	

.  

Current View 	Filters your messages by Detailed Address 
Cards, Company, Location, and so forth. The 
drop-down arrow lets you select a filter. 

Table 3-1: The Contacts Toolbar Buttons 
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Creating a Contact List 

Adding Contacts Manually 

At the very least, your contact list should include names and phone numbers, 
but the more inclusive you make your list, the more helpful it can be to you. 
To add contacts, type your data into the New Contact window, illustrated in 
Figure 3-2, selecting tabs as appropriate to enter additional details. 

Figure 3-2: The New Contact Window 

When you enter all the information in the New Contact window and save it, 
Outlook stores each contact in the contact list as an address card. Address 
cards in the contact list simulate business cards in your rotary or card file. 

The Contact window has toolbar buttons of its own. Table 3-2 summarizes the 
fimction of the toolbar buttons peculiar to the Contact window. 
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Button 	Name 	 Function 

ii] sea and  ocea 	Save and 	Saves the information in the window and 
 	Close 	 closes the window. 

Save and New 	Saves the information in the window and 
closes the window. Also opens a New 
Contact window. 

Insert File 	Inserts a file in the large text box at the 
bottom of the window. 

Flag for Follow 	Adds special text to the message to 
Up 	 indicate that a follow-up action is required. 

Display Map of 	Starts Internet Explorer and displays the 
_ 	Address 	Address Finder web page. 

New Message 	Opens a message addressed to the 
. 	to Contact 	contact 

AutoDialer 	Starts Internet Explorer and displays the 
1, 

Address Finder web page 

Previous Item 	Displays the previous Contact window. 
The drop-down arrow accesses the first 
item in the folder. 

	_. 
Next Item 	Displays the next contact window. The 

_ 	 drop-down arrow accesses the last item in 
the folder. , 

Table 3-2: The Contact Window Toolbar Buttons 

L METHOD --I 
To add contacts manually: 

1. Open the Contacts folder. 

2. On the Standard toolbar, click the New Contact button. 

3. In the New Contact window, for all pages, fill in the text boxes, 
select the check boxes, and so forth, as appropriate. 

4. On the toolbar, click the Save and Close button. 
or 

4. On the toolbar, click the Save and New button to add another 
contact. 
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1— EXERCISE 	  

In the following exercise, you will add contacts to your contact list 
manually. 

1. From the Outlook Bar, open 	The contact list appears in 
the Contacts folder 	 Address Cards view. 

2. On the Standard toolbar, dick 	The New Contact window 
the New Contact button 	appears. 

3. Click on the Full Name... 
button 

4. In the First: field, type Jeff use 
the TAB key to move to the 
Last: field and type Thompson 
then click on OK 

5. In the Job title field type 
Marketing Rep and in the 
Company: field type ACME 
Wholesale 

6. Click on the Address... button 

Lq  

Fg 

FlE 

7. In the Street field type 222 
Whooping Crane Hwy, in the 
City field type New Orleans, in 
the State/Province field type 
LA in the ZIP/Postal code field 
type 70110 then click on OK 

8. Make sure the This is the 
mailing address check box is 
selected 

9. In the Business field, type 
) 	 504-555-1612 

10. In the E-mail field, type 
) 	 jthompso@acmewhol.com  
) 	 11. On the toolbar, click the Save 	The contact list reappears. 
) 	 and Close button 

12. At the right of the screen, click 	The Jeff Thompson address 
) 	 the t alphanumeric button 	card appears in the contact list. 

) 
) 
) 
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13. Using the information shown in 
Table 3-3 as a guide, enter the 
first contact into your contact 
list 

14. With your mail partner, select 
one of the remaining contacts 
for you to enter into your 
contact list and the other for 
your partner to enter, and then 
add the entry 

	

Full 	Job Title Company Business 	City 	State 	Zip 	Business 

	

Name 	 Address 	 code 	Phone 
number 

Beth 	Marketing 	Krk & 	1500 	Metairie 	LA 	70005- 504-555- 
Wright 	Rep 	Associates Veterans 	 2704 	0296 

Memorial 	- 
Blvd. 

Ray 	Consultant 	Krk & 	334 	Columbia 	MD 	21044- 410-555- 
Martinez 	 Associates 	Hardwin Ct. 	 0928 	7784 

Judy 	Friend 	JK 	9901 Ark 	Columbia 	MD 	21045- 410-555- 
Karras 	 Computer 	Circle 	 0012 	1572 

Services 

Table 3-3: Contact List Information 



Creating a Contact List 

Selecting and Editing an Address Card 

Your contacts might change jobs, get new phone numbers, or give you 
additional information that you want to store in your contact list. You can edit 
information in your contact list directly on the address card or in the Contact 
window. 

L METHOD ---1  

To select an address card: 

1. Click the desired card. 

To edit an address card: 

1. Select the address card. 
2. On the address card, type the changes. 

or 
2. Double-click the address card. 
3. In the Contact window, type the changes. 
4. On the toolbar, click the Save and Close button. 

[—EXERCISE 

In the following exercise, you will edit address cards in your contact list. 

1. Make sure the Jeff Thompson 
address card is selected 

2. Click between the H and the w 
in Hvvy in the business address 

3. Press BACKSPACE and then 
type Pk 

4. Select the Beth Wright address 
card, and then double-click it 

The address card is selected. 

The insertion point appears 
between the H and the w in 
Hwy. 

The business address is now 
222 Whooping Crane Pkwy. 

The Beth Wright Contact 
window appears. 
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5. In the large text box at the 
bottom of the window, type 
Beth markets herbs and 
spices. 

6. On the toolbar, click the Save 	The Contact window closes 
and Close button 	 and the changes are saved. 

FEND] 
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Transmitting and Adding Contacts with E-mail 

If colleagues have someone listed in their contact lists who you would like to 
include in your list too, your colleagues can e-mail the address card directly to 
you, just as you can e-mail similar cards to your colleagues. Then you can 
open the e-mail message and transfer the address card directly to your 
Contacts folder. Neither of you has to retype the information. 

L METHOD --I 

To transmit contacts via e-mail: 

1. Select the contact. 
2. From the Actions menu, choose Forward. 
3. In the New Message window, address and send the message. 

To add contacts from e-mail: 

1. Open the message with the address card. 
2. Click the address card icon. 
3. In the Message window, from the Edit menu, choose Copy. 
4. Open the Contacts folder. 
S. In the Contacts folder, from the Edit menu, choose Paste. 

1--- EXERCISE 

In the following exercise, you will transmit and add contacts to your 
contact list with e-mail. 

1. Make sure your contact list is 
open 

2. Select the contact you created 
(and your mail partner did not 
create) 

3. From the Actions menu, 
choose Forward 

The New Message window 
appears with the address card 
as an icon in the message 
area. 

4. Address the new message to 
your partner, and then send it 
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The address card is selected. 

The address card is copied to 
the Clipboard. 

Section 3: Organizing Contacts 

5. Check for new mail, and then 
open your partners message 

6. On your partners message, 
click the address card icon 

7. In the Message window, from 
the Edit menu, choose Copy 

8. Resize and reposition the 
Message window so you can 
see the Outlook bar 

9. Open the Contacts folder 

10. In the Contacts folder, from the The address card is added to 
Edit menu, choose Paste 	your contact list 

11. On the taskbar, click the 
Message button to restore the 
Message window 

12. Close the Message window 

r  END 
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Managing Contacts 

Managing Contacts 
Besides organizing your contact list alphabetically by contact name, Outlook 
lets you view it by company naine, location, and category. For example, if you 
cannot remember the name of a contact but do remember that person's 
workplace, you can view your contact list by company to find the contact. 
You can choose which fields you display and which you hide. 

Showing and Hiding Fields 

In the Contacts folder, you can view your contacts by address cards, phone 
list, category, company, or location. In addition, with the Show Fields dialog 
box, shown in Figure 3-3, you can change the fields  that appear on the address 
cards. 
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L METHOD ----I 
To show and hide fields: 

1. From the View menu, choose Current View, Customize Current 
View. 

2. On the View Summary dialog box, click the Fields button. 
3. In the Show Fields dialog box, in the Available fields list box, 

select the field(s) you want to add to the view pane, and then 
choose Add. 
or 

3. In the Show fields dialog box, in the Show these fields in this 
order: list box, select the field(s) you want to remove from the 
view pane, and then choose Remove. 

4. If desired, choose New Field, and then create a new field. 
5. If desired, in the Show these fields in this order: list, select a 

field and choose Move up or Move down. 
6. Repeat step 4 as necessary to list the fields in the order you 

want them. 
7. Choose OK. 

r---- EXERCISE 

In the following exercise, you will show and hide fields. 

1. From the View menu, choose 	The View Summary dialog box 
Current View, Curtomize 	appears. 
Current View. 

2. Click the Fields button. 

	

	 The Show Fields dialog box 
appears 

3. In the Available fields list box, 
select Business Home Page 

4. Choose Add 

5. In the Show these fields in this 
order: list box, select Business 
Fax 

Business Home Page appears 
at the bottom in the Show these 
fields in this order: list box 
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Managing Contacts 

6. Choose Move Up repeatedly 
until Business Fax is below 
Company Main Phone in the 
list 

7. Choose OK  The address cards show the 
Business Fax number on each 
card for which such a number 
is available. 

T END  7 
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Changing the Current View 

Besides viewing address cards with one mailing address and a business and 
home phone number, you can change the Current View to display detailed 
address cards or a phone list that displays a contact with phone numbers but 
not addresses. You can group your contact list by company to fmd contacts 
whose name you forget. 

When you change the Current View, you are applying a built-in filter. 
Table 3-4 summarizes the Contacts Current View filters. 

Name 	 Function 

Address Cards 	 Shows simple address cards for all contacts in 
the folder. 

Detailed Address Cards 	Shows detailed address cards for all contacts 
in the folder. 

Phone List 	 Lists all contacts. You can sort the contacts by 
first or last name, company, and so forth. 

By Category 	 Groups contacts by category. 

By Company 	 Groups contacts by company. 

By Location 	 Lists all contacts. You can sort the contacts by 
state and country as well as by first or last 
name, company, and so forth. 

By Follow Up Flag 	 Groups contacts by flag. Also shows the due 
date for follow-up action for the flag. 

Table 3-4: The Contacts Current View Filters 

L METHOD 

To change the Current View: 

Menu method 
1. From the View menu, choose Current View. 	 t.

. 

2. From the Current View submenu, choose the desired view. 

Advanced Toolbar method 
1. Click the Current View drop-down list arrow. 
2. From the drop-down list, select the view. 
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LAIMMeauriat±C,... 
3. If necessary, in the Save View Settings message box, select the 

Update the view "..." with the current View settings option 
button. 

4. Choose OK. 

1- EXERCISE 

In the following exercise, you will change 
contact list. 

the Current View of your 

1. Click the Current View drop-
down list arrow 

The drop-down list appears. 

2. Select Detailed Address Cards The Save View Settings 
message box might appear. 

3. If necessary, select the Update 
the view 'Address Cards' with 
the current view settings option 
button 

4. Choose OK The address cards show more 
details. 

5. Change the Current View to By 
Company 

The contacts are grouped by 
company. 

6. If necessary, expand the list to 
show employees of Kric & 
Associates 

Two names appear. 

END 7  
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To add contacts manually: 

1. Open the Contacts folder. 
2. On the Standard toolbar, click the 

New Contact button. 
3. In the New Contact window, for 

all pages, fill in the text boxes, 
select the check boxes, and so 
forth, as appropriate. 

4. On the toolbar, click the Save and 
Close button. 
or 

4. On the toolbar, click the Save and 
New button to add another 
contact. 

To select an address card: 

1. Click the desired card. 

To edit an address card: 

1. Select the address card. 
2. On the address card, type the 

changes. 
or 

2. Double-click the address card. 
3. In the Contact window, type the 

changes. 
4. On the toolbar, click the Save and 

Close button. 

To transmit contacts via e-mail: 

1. Select the contact. 
2. From the Actions menu, choose 

Forward. 
3. In the New Message window, 

address and send the message. 

To add contacts from e-mail: 

1. Open the message with the 
address card. 

2. Click the address card icon. 
3. In the Message window, from the 

Edit menu, choose Copy. 
4. Open the Contacts folder.  

5. In the Contacts folder, from the 
Edit menu, choose Paste. 

To show and hide fields: 

1. From the View menu, choose 
Current View, Customize Current 
View. 

2. In the View Summary dialog box, 
click the Fields button. 

3. In the Show Fields dialog box, in 
the Available fields list box, 
select the field(s) you want to add 
to the view pane, and then choose 
Add. 
or 

3. In the Show fields dialog box, in 
the Show these fields in this 
order: list box, select the field(s) 
you want to remove from the 
view pane, and then choose 
Remove. 

4. If desired, choose New Field, and 
then create a new field. 

5. If desired, in the Show these 
fields in this order: list, select a 
field and choose Move up or 
Move down. 

6. Repeat step 4 as necessary to list 
the fields in the order you want 
them. 

7. Choose OK. 

To change the Current View: 

Menu method 
1. From the View menu, choose 
Current View. 
2. From the Current View submenu, 

choose the desired view. 

Advanced Toolbar method 
1. Click the Current View drop-

down list arrow. 
2. From the drop-down list, select 

the view. 
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3. If necessary, in the Save View 
Settings message box, select the 
Update the view "... " with the 
current View settings option 
button. 

4. Choose OK. 

9 
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Self-Check Exercise 

1. Add one of the following contacts to your contact list and arrange with 
your e-mail partner for your partner to add the other contact: 

Dr. Kelly Tucker, Nature's Best Bets, 1101 Chartres St, New Orleans, 
LA, 70116-2504, 504-555-9023. 

Charles Simon, Presto Pasta, 550 Esplanade Ave, New Orleans, LA 
70116, 504-555-1094. 

2. Send the contact you added in step 1 above to your e-mail partner. 

3. Add the contact your e-mail partner sent you to your contact list. 

4. Edit the business address of the Raymond Martinez contact to read 
Hardwick Ct. 

5. Remove the field Business Home Page from the fields you display on 
your address cards. In the Show Fields dialog box, in the Show these 
fields in this order: list box, move Business Fax down three places. 

6. Change your contact list Current View to Address Cards. 

ii  
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Scheduling with Calendar 

• Navigating in Calendar 
• Making and Moving 

Appointments 
• Managùig Appointments 
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Section 4: Scheduling with Calendar 

Section Skills and Their Importance 
In the following section you will learn to: 

• Navigate in Calendar 
To use your appointment book effectively, you can view a day, a 
week, or a month at a time. You can move from date to date, check 
advance appointments, and look up past events. 

• Make and move appointments 
You can use the Calendar to record and track appointments. Using 
Outlook's Calendar features, you can create appointments, change 
them, and move them. 

• Manage appointments 
You can designate regular appointments as recurring, set 
reminders, create tentative appointments, and cancel and delete 
appointments. When an event, such as a conference, occurs that 
lasts a full day or several days, you can mark it on the Calendar 
apart from your appointments, then schedule as usual. 



Navigating in Calendar 

Navigating in Calendar 
In the Calendar folder, you can schedule appointments and review your tasks. 
An appointrnent is a scheduled activity that does not involve anyone else. A 
task is an activity you must perforai and track to completion. 

To manage your time effectively, you must be able to move easily from one 
date to another within your Outlook Calendar and to display each date in the 
desired view. The Calendar toolbar offers quick access to various Calendar 
views. The Date Navigator, which looks like a monthly calendar, helps you 
speedily move from one week or month to another. You can even show two 
time zones, which helps you when traveling or when working with someone at 
an office in another time zone. The TaskPad holds your to do list. Figure 4-1 
shows the Calendar screen elements. 
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Date Navigator 
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Figure 4-1: The Calendar Screen Elements 
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Viewing a Day, a Work Week, a Week, or a Month 

In the Calendar, you can display your appointments by Day, Work Week, 
Week, or Month view. You can also choose to filter the Current View using 
the Advanced toolbar. Table 4-1 summarizes the built-in Current view filters. 

Name 	 Function 

Day/Week/Month 	 Shows the Calendar as an appointment book. 
Displays the date(s) selected on the Date 
Navigator. 

Day/VVeek/Month View With 	Same as the DayNVeek/Month view, except 
AutoPreview 	 the first lines of the text appear in each item. 

Active Appointments 	 Lists all active appointments. You can sort 
appointments by Subject, Start Date, End 
Date, and so forth. 

Events 	 Lists all active holidays and events. 

Annual Events 	 Lists active annual events only. 

Recurring Appointments 	Lists recurring appointments only. 

By Category 	 Groups active appointments by category. 

Table 4-1: The Calendar Current View Filters 

On the standard toolbar, the context-sensitive Calendar buttons provide you 
with a quick means to change views and to retum to today's date. Some of 
these toolbar buttons are visible only when you maximize Outlook. Table 4-2 
summarizes the Calendar standard toolbar buttons and their functions. 

211! 
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Navigating in Calendar 

Button 	Name 	 Function 

Standard Toolbar buttons 

Irtà—; ;,', 	New 	 Opens the New Appointment window so that 
Appointrnent you can create an appointment. The drop-

down arrow gives you access to the New 
windows for the other Outlook features. 

[GO tO-Tode ] 	Go to Today 	Displays today's date in Day, Week, or 
Month view. 

	

, Ejay  s 	Day 	 Displays one day on the Calendar. 

in  work'we'ek i' 	Work Week 	Displays one work week on the Calendar. 

	

linAe k: 	Week 	Displays one week on the Calendar. 

fek 	i3-tiii 	Month 	Displays one month on the Calendar. 

Advanced Toolbar buttons 

g Plan a 	 Invites attendees to a meeting, and displays 
Meeting 	invitees' schedules 

DaYM=leekitionth 	Current View 	Filters your appointments by Active 
Appointments, Events, Recurring 
Appointments, and so forth. The drop-down 
arrow lets you select a filter. 

9 
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Table 4-2: The Calendar Toolbar Buttons 

L METHOD 

To view a day, a work weelc, a week, or a month: 

1. On the toolbar, click the button for the view you want. 
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1--- EXERCISE 	  

In the following exercise, you will view a day, a work week, a week, and a 
month. 

1. Open the Calendar folder The Calendar for today, the 
Date Navigator, and the 
TaskPad appear in 
Day/Week/Month view. 

2. On the Standard toolbar, click 
the Work Week button 

3. On the Standard toolbar, click 
the Week button 

4. On the Standard toolbar, click 
the Month button 

5. On the scroll bar, click the top 
scroll arrow once 

6. On the scroll bar, drag the 
scroll box up about 14 inch 
slowly 

7. On the Standard toolbar, click 
the Go to Today button 

8. On the Standard toolbar, click 
the Day button 

The Calendar changes to Work 
Week view. 

The Calendar changes to 
Week view. 

The Calendar changes to 
Month view. The Date 
Navigator and the TaskPad are 
hidden. 

The Month view starts and 
ends one week earlier. 

As you drag, a box that gives 
you the starting date for the 
five-week period that would 
appear when you release the 
pointer appears, with the date 
changing as you continue to 
drag. 

The Calendar continues to 
appear in its current view, but it 
changes the time period 
displayed to include the current 
day. 

The Calendar changes to Day 
view, showing today's date. 
The Date Navigator and the 
TaskPad reappear. 

r END --1 
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Or 
0) Using the Date Navigator 

I) 

5 
5 
5 
5 
5 

The Date Navigator, shown in Figure 4-2, is not only a monthly calendar but 
gives you quick access to any date you want. You might have one or two 
months displayed in your Date Navigator, depending on your screen 
resolution. By adjusting the pane size, you can expand the Date Navigator to 
display more months. You adjust the pane size using the double-headed arrow 
mouse pointer, shown in Figure 4-3. 

When the Calendar opens, the Date Navigator hiellights today's date 
(January 2, 1997, as shown). It always displays today's date with a box around 
it so you can find it easily. And it displays dates on which you have scheduled 
appointments in bold. 

One Month Back 	One Month Forward 
arrow 	Month Label armw 

A 	lanuary 1999 	bi  
5 MTWTF 5  

2728 29 30 31 1 2 
3 4 5 67E3-9- 

10 11 12 13 14 15 16 
1716 19 20 21 22 23 
24 25 26 27 28 29 30 
31 

Today's date 
Date with an 
appointment 

Figure 4-2: The Date Navigator 
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Figure 4-3: The Double-Headed Arrow Mouse Pointer 

L METHOD —I 

To view appointments for a day during the current month: 

1. On the Date Navigator, click the desired date. 
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2. On the Date Navigator, click 
the One Month Forward arrow 

3. On the Date Navigator, click 
the 25th of the displayed 
month 

4. On the Date Navigator, click 
the One Month Forward arrow 
two times 

5. Click and hold the month label 

6. Drag the mouse pointer to the 
current month 

104 

Next month's Date Navigator 
appears. The Calendar for the 
date you selected appears. 

The Calendar for the 25th of 
the displayed month appears. 

The Date Navigator for three 
months from now appears. The 
Calendar for the 25th of the 
month three months from 
today appears. 

The pop-up month list appears. 

This month's Date Navigator 
appears. The Calendar for the 
25th of this month appears. 

fi 
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To adjust pane size to show a different number of months in the Date 
Navigator: 

1. Position the mouse pointer over the border between the panes 
you want to adjust. 

2. When the mouse pointer becomes the double-headed arrow 
mouse pointer, drag the border to the desired position. 

To view appointments in another month: 

1. Click the One Month Back arrow once for each previous month 
or the One Month Forward arrow once for each future month. 
or 

1. Click and hold the month label, and then, on the pop-up month 
list, drag the mouse pointer to the desired month. 

2. Click the desired date. 

EXERCISE 

In the following exercise, you will use the Date Navigator to view dates in 
your Calendar. 

1. On the Date Navigator, click 
tomorrow's date 

The Calendar for tomorrow 
appears. 
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15. Click the Go to Today toolbar 	The Calendar for today 
button appears. 
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Navigating in Calendar 

7. On the Standard toolbar, click 
the Go to Today button 

8. Position the mouse pointer 
over the border that separates 
the Calendar from the Date 
Navigator 

9. Drag the border to the left 

10. On the Date Navigator, click 
any date next month 

11. Position the mouse pointer 
over the border that separates 
the Date Navigator from the 
TaskPad 

The Calendar for today 
appears. 

The mouse pointer becomes 
the double-headed arrow 
mouse pointer. 

The border does not appear to 
move; however, a vertical line 
that indicates that you can 
view one more month in the 
Date Navigator appears while 
you are dragging. Once you 
release the mouse button, a 
calendar for an additional 
month appears in the Date 
Navigator. 

The Calendar for the date you 
selected appears. 

The mouse pointer becomes 
the double-headed arrow 
mouse pointer. 

12. Drag the border down 

14. Drag the horizontal border that 
separates the Date Navigator 
from the TaskPad up 

13. Drag the vertical border back 
to the right 

The border does not appear to 
move; however, a horizontal 
line that indicates that you can 
view additional months 
appears while you are 
dragging. Once you release 
the mouse button, more 
calendars appear in the Date 
Navigator. 

One column of calendars 
disappears in the Date 
Navigator. 

The Date Navigator is restored 
to its default appearance. 

r  END 
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Vievving a Range of Dates, Several Weeks, and 
Dis contiguous Days 

You can also use the Date Navigator to view selected days, such as a five-day 
work week, the next three Tuesdays, three weeks, or whatever days you like. 
If the days are contiguous, you can drag across them to display them. If they 
are discontiguous, you select the days by holding CTRL and clicking the 
desired dates, just as you would select multiple files in Microsoft Explorer. 

L METHOD 

To view a range of dates: 

I. On the Date Navigator, drag across the dates. 

To view several weeks: 

1. Position the mouse pointer near the left edge of the Date 
Navigator. 

2. When the pointer changes from pointing left to pointing right, 
drag the pointer along the left edge of the Date Navigator for the 
desired weeks. 

To view discontiguous days: 

1. Press and hold CTRL 

2. On the Date Navigator, click each date you want to view. 
3. Release CTRL 

r--- EXERCISE 

In the following exercise, you will view a range of dates, three weeks, and 
discontiguous days. 

1. On the Date Navigator, drag 
from today's date through the 
next two days 

2. Position the mouse pointer 
near the left edge of the Date 
Navigator 

Today, tomorrow, and the next 
day appear on your Calendar. 

The pointer changes to an 
arrow pointing right. 
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) 

) 

The second and third full 
weeks of this month appear on 
your Calendar. 

3. Drag the pointer along the left 
edge of the Date Navigator for 
the second and third full weeks 
of this month 

4. On the Date Navigator, click 	Today's date is selected and 
today's date 	 appears on your Calendar. 

5. Press and hold CTRL 

6. On the Date Navigator, click 
the date one week from today 

Today's date and the date one 
week from today appear on 
your Calendar. 

7. Release Cmt. 

8. On the Date Navigator, click 	Only today's date appears on 
today's date 	 your Calendar. 

r  END 7  
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Showing Two Time Zones 

When you work regularly with an office in another time zone, you might find 
it helpful to display that office's time zone as well as your own when 
displaying the Calendar. This can help you plan phone calls for the right time 
of day. You set the time zone display in the Time Zone dialog box, shown in 
Figure 4-4. 

Figure 4-4: The Time Zone Dialog Box 

L METHOD —I 
To show two time zones: 

I. In the Calendar, from the Tools menu, choose Options. 
2. In the Options dialog box, on the Preferences page, choose 

Calendar Options... 
3. In the Calendar Options dialog box, choose Time Zone. 
4. In the Time Zone dialog box, in the Current time zone area, in 

the Label text box, type a short name for the current time zone. 
5. Select the Show an additional time zone check box. 
6. In the additional time zone area, in the Label text box, type a 

short name for the second time zone. 
7. In the Time drop-dovvn list, select a time zone. 
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8. If that time zone uses daylight savings time during the spring 
and summer, select the Adjust  for  daylight saving time check 
box. 

9. Choose OK. 
10.In the Calendar Options dialog box, choose OK. 
11.In the Options dialog box, choose OK. 

Note: To change your current time zone to the second time zone, in 
the Time Zone dialog box, choose Swap Time Zones. This, 
however, affects all times displayed in all your Windows-based 
programs, not just the time displayed in Outlook. 

!— EXERCISE 	  

In the following exercise, you will show two time zones. 

1. From the Tools menu, choose 	The Options dialog box 
Options 	 appears. 

2. In the Options dialog box, 
choose the Preferences tab 
and choose the Calendar 
Options button 

3. In the Calendar Options dialog 	The Time Zone dialog box 
box, choose Time Zone 	appears. 

4. In the Current time zone area, 
in the Label text box, type a 
short name for your time zone 

5. Select the Show an additional 	The additional time zone area 
time zone check box 	 appears. 

6. If necessary, select the tee in 
the Label text box, and then 
type a short name for the time 
zone directly to the east of 
your current time zone 

7. In the Time drop-down list, 
select the time zone directly to 
the east of your current time 
zone (the next earlier time in 
the drop-down list) 
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8. If necessary, select the Adjust 
for daylight saving time check 
box 

9. Choose OK 

10. Choose OK 

The Options dialog box 
reappears. 

The Calendar displays your 
time zone adjacent to the 
Calendar and the second time 
zone to the left of your time 
zone. 

r  END --1 
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Making and Moving Appointments 

Making and Moving Appointments 
Outlook gives you the flexibility you need to manage your appointments. You 
usually make appointments in the Day view of the Calendar, although you can 
also set an appointment in the Work Week, Week and the Month views. You 
can edit and move appointments as required in all views. Working in the 
information viewer, you can edit an appointment by inserting and deleting 
text, just as you do in a Mail message. 

Sometimes you must move an appointment to another day. You can easily 
modify the date of an appointment in the Day, Work Week and Week views. 
To move an appointment within the same calendar week, you can drag and 
drop it within Day, Work Week and Week views. To move an appointment 
farther away in time, you can drag it to the Date Navigator. 

Creating Appointments 

') 

The most basic method of making an appointment is simple—click a time slot 
or drag a time period in your Calendar to select it, and then type a description 
of the appointment. As you type the text of an appointment, the text appears 
on the screen. If the displayed time slot is not wide enough, the text wraps 
automatically to the next line when it gets to the right edge of the appointment 
area. 

When you finish describing an appointment, Outlook saves the entry as soon 
as you click somewhere outside the appointment time slot. Even if you choose 
to exit the program, you do not need to click a Save button or choose Save 
from a menu to save your appointment. 

You can make a more detailed appointment using the New Appointment 
window, shown in Figure 4-5. In this window, you can enter additional 
comments about the appointment, such as the materials you should bring with 
you to the appointment, directions to the location, and so forth. 

By default, Outlook sends you a reminder about your appointments before 
each appointment. If you want to cancel the reminder or change the hiterval 
before the appointment for the reminder to appear, you can do so in the New 
Appointment window. A bell icon appears in the time slot to indicate that you 
set a reminder for the appointment. 

) 
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Figure 4-5: The New Appointment Window 

You access the New Appointment window by clicking the New Appointment 
button located on the Calendar toolbar. 

L METHOD 

To select a time slot or time period: 
-e.yr 

1. In the Calendar (Day, Work Week, Week, or Month view), 
display the desired date. 

2. Click the time slot. 
or 

2. Drag through as many time slots as necessary. 

ri  

To create a basic appointment: 	 t — pill 

1. Select a time slot or time period. 	
(
parril, ( 2. Type a description. 	 –.711.717: 

To create a detailed appointment: 

1. If desired, select a time slot or time period. 
2. Double-click the selected time slot or time period. 

or 
2. On the Standard toolbar, click the New Appointment button. 
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1. At your instructor's direction, 
click a thirty-minute time slot 
approximately one hour from 
the current time 

The time slot is selected. 

) 
) 
) 
) 
) 
) 

4. Drag through the 3:00 P.M. 
time slot 

A 1Y2-hour time period is 
selected. The previous 
appointment is saved. 

5. Type Design new floor plan A Design new floor plan 
appointment appears in your 
selected time slot 

) 
) 

9 

ri 
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3. In the New Appointment window, type a subject for the 
appointment. 

4. In the Location combo box, type the location or select it from 
the drop-down list. 

5. If necessary, modify the Start time and End time displayed. 
6. If desired, in the large text box at the bottom of the page, type 

comments about the appointment. 
7. On the toolbar, click the Save and Close button. 

Note: Instead of selecting an appointment date on the Date 
Navigator or typing munbers for the date or time, you can use 
Microsoft's AutoDate feature. Simply type a description of the 
date—for example, next Tuesday, two months from today, from 
tomorrow until the end of the month—or time—an hour ago, noon, 
five o'clock pm—in the Start time and End time combo boxes. 
You can also type the names of holidays that fall on the same date 
every year—Valentine's Day, Veterans Day, Halloween. Outlook 
translates your descriptions into dates. 

EXERCISE 

) 	 In the following exercise, you will create appointments. 
) 

) 

) 
) 

2. Type Call to check for new 
deliveries 

3. Position the mouse pointer 
over the 2:00 P.M. time slot 

A Call to check for new 
deliveries appointment 
appears in your selected time 
slot 
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The entry in the left Sta rt  time 
combo box changes to show 
the actual date when you 
clicked or tabbed to the next 
data entry field. 

The entry in the n'ght Start time 
combo box changes to show 
the time in numerals when you 
clicked or tabbed to the next 
data entry field. 

r 
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6. On the Standard toolbar, click 
the New Appointment button 

7. On the Appointment page, in 
the Subject text box, type 
Reconcile accounts 

8. In the Location combo box, 
type office 

9. In the left Start time combo 
box, select the date and then 
type first Monday of next 
month 

10. In the right Start time combo 
box, select the time and type 
nine a.m. 

11. In the right End time combo 
box, select the time and type 
noon 

12. In the Reminder area, make 
sure the Reminder check box 
is selected 

13. In the Reminder drop-down list 
box, make sure 15 minutes is 
selected 

The New Appointment window 
appears. The previous 
appointment is saved. 

14. In the large text box at the 
bottom of the window, type 
Get someone to cover 
phones. 

The entry in the right End time 
combo box changes to show 
the time in numerals vvhen you 
clicked or tabbed to the next 
data entry field. 
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15. On the toolbar, click the Save 
and Close button 

The Calendar for today 
reappears. 

16. Display the Calendar for the 
first Monday of next month 

The Calendar appears 
displaying the new 
appointment on the first 
Monday of next month. 

r  END 
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Section 4: Scheduling with Calendar 

Selecting an Appointment and Modifying the Date 
in Day View 

When you modify appointment details, you need to select the appointment 
before you can edit it. Figure 4-6 shows the Calendar with an appointment 
selected. 

Top appointment handle 

eal Calendar - Microsoft Outlook ...;ezie Wig E3 
Fie [dt. Yew Qo ools 	ideb 

C,o to Todeq"McAe: Wor_k Week  U eek Ea 'Month ; ei Find ",iIb Organq.,e jJ 
(› • rj e . D2e7/7-' 

l‘lursday,Isn 21 

Move 
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Zi‘ Staff Meeteg 
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r2ID order  new tae 

Zif : U Create a Presentation for Trade Program - 
i 2 ID :Phone CC In Cttavia re Y3As 

D ; Create a Presentaton for  Trade Program 

21r:3Pretzarng141,neeriai  Vat 

1222  

•11,  

'1 Item 

Bottom appointment handle 

Figure 4-6: The Calendar with an Appoint-ment Selected 

When you must move an appointment to a different week, the simplest way is 
to use the Date Navigator in Day view. You position the mouse pointer over 
the move handle, which is the blue line to the left of the appointment. The 
pointer becomes a four-headed arrow, shown in Figure 4-7, which you use to 
drag the appointment to the Date Navigator. You select the appointment when 
you begin to drag it. If you want to reschedule the appointment for the 
following month, you can adjust the Date Navigator's width to show two 
months. 
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Figure 4-7: The Mouse Pointer When Positioned over the Move Handle 

L METHOD —1  

To select an appointment: 

1. Click the appointment. 

To change the date of an appointment in Day view: 

1. Position the mouse pointer over the move handle. 
2. When the pointer becomes a four-headed arrow, click and drag 

the appointment to the desired date on the Date Navigator. 
or 

2. When the pointer becomes a four-headed arrow, click the move 
handle. 

3. From the Edit menu, choose Cut. 
4. On the Date Navigator, click the new date or time. 

Or 

4. Display the desired day. 
5. From the Edit menu, choose Paste. 

EXERCISE 

In the following exercise, you will move the date of an appointment from 
one week to another and from one month to another in Day view. 

1. Display today's appointments 
in Day view 

2. Adjust the Date Navigator to 
show two months 

3. Position the mouse pointer 	The mouse pointer becomes a 
over the move handle of the 	four-headed arrow. 
Design new floor plan 
appointment 

4. Drag the appointment to Friday The appointment now takes place 
of next week on the Date 	on Friday of next week and Friday 
Navigator 	 of next week appears in the 

Calendar. 
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5. Position the mouse pointer 
over the move handle 

6. Drag the appointment to the 
first Wednesday of next month 
on the Date Navigator 

7. Position the mouse pointer 
over the move handle 

8. Click the move handle 

9. From the Edit menu, choose 
Cut 

10. On the Standard toolbar, click 
the Go to Today button 

11. From the Edit menu, choose 
Paste 

12. Adjust the Date Navigator to 
show just one month 

The mouse pointer becomes a 
four-headed arrow. 

The appointment now takes place 
on the first Wednesday of next 
month and the first Wednesday of 
next month appears in the 
Calendar. 

The mouse pointer becomes a 
four-headed arrow. 

The appointment is placed on the 
Clipboard. 

Today's date appears in the 
Calendar. 

The appointment is scheduled for 
today at its original time. 

END 
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Making and Moving Appointments 

Modifying the Date in Week View 

You can also move an appointment in Week view. You can drag it to a new 
date displayed on the calendar or on the Date Navigator. Figure 4-8 shows the 
Calendar in Week view. 

Figure 4-8: The Calendar in Week View 

L METHOD --I 
To modify the date of an appointment in Week view: 

1. Position the mouse pointer over the time area of the 
appointment. 

2. When the pointer becomes a four-headed arrow, drag the 
appointment to the new date on the Calendar or on the Date 
Navigator. 
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1 EXERCISE 

In the following exercise, you will modify the date of your appointment in 
Week view. 

1. On the Standard toolbar, click 
the Week button 

2. Position the mouse pointer 
over the time area of the 
Design new floor plan 
appointment 

3. Drag the appointment to Friday 
on the Calendar 

4. Position the mouse pointer 
over the time area of the 
appointment 

5. Drag the appointment to 
Wednesday on the Date 
Navigator 

6. If today is not Wednesday, 
position the mouse pointer 
over the time area of the 
appointment 

7. Drag the appointment to 
today's date on the Calendar 

8. On the toolbar, click the Day 
button 

The Week view appears. 

The mouse pointer becomes a 
four-headed arrow. 

The appointment now takes place 
on Friday from 2:00 P.M. to 
3:30 P.M. 

The mouse pointer becomes a 
four-headed arrow. 

The appointment now takes place 
on Wednesday. 

The mouse pointer becomes a 
four-headed arrow. 

The appointment now takes place 
today. 

Today's Calendar appears in Day 
view. 

r  END --1 
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Changing the Time of an Appointment 

Outlook lets you easily modify the beginning and ending times of an 
appointment. If you must move an appointment to another time slot in the 
same day, you can drag it there with the move handle. You can change just the 
startup time of an appointment by dragging the top appointment handle with 
the double-headed arrow or change just the ending time of an appointment by 
dragging the bottom appointment handle with the double-headed arrow. The 
appointment laandles are the blue borders at the top and the bottom of a 
selected appointment that allow you to change the appointment beginning and 
ending times. 

METHOD 

To move an appointment to another time slot on the same day: 

1. Position the mouse pointer over the move handle. 
2. When the pointer becomes a four-headed arrow, drag the 

appointment to the new time slot. 

To change the startup time or the ending time of an appointment: 

1. Position the mouse pointer over an appointment handle. 
2. When the pointer becomes a double-headed arrow, drag the 

appointment handle to the new time. 

r-- EXERCISE 

In the following exercise, you will change the time of your appointment. 

1. Position the mouse pointer 
over the move handle of the 
Design new floor plan 
appointment 

2. Drag the appointment one hour 
later 

The mouse pointer becomes a 
four-headed arrow. 

3. Select the appointment again 

4. Position the mouse pointer 
over the top appointment 
handle 

The  mouse pointer becomes a 
double-headed arrow. 

5. Drag the top handle to 
1:30 P.M. 

The appointment now begins at 
1:30 P.M. 
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6. Position the mouse pointer 
over the bottom appointment 
handle 

7. Drag the bottom handle to 
3:00 P.M. 

The mouse pointer becomes a 
double-headed arrow. 

The appointment now ends at 
3:00 P.M. 

r  END-'  
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Managing Appointments 

Managing Appointments 
Outlook provides a variety of more complex time-management capabilities, 
including creating recurring appointments and tentative appointments. 
Recurring appointments are those appointments in your schedule that occur 
regularly, such as a biweekly review of orders or preparing a monthly report. 
Tentative appointments are those appointments for which you need to reserve 
a time slot even though they might not take place. 

You can also mark events, days on which you observe or celebrate something 
while conducting business as usual. For example, you would mark your 
birthday as an event. You can also mark a conference as an event, and then 
schedule the individual sessions you plan to attend as appointments. 

In addition, should you need to cancel an appointment, Outlook lets you delete 
it so you can schedule another appointment in your newly freed time period. 

Creating Recurring Appointments 

When you schedule a recurring appointment, Outlook automatically places all 
future occurrences of the appointment in your Calendar for the period you 
specify. The Appointment Recurrence dialog box, illustrated in Figure 4-9, 
lets you define recurring appointments. 

Figure 4-9: The Appointment Recurrence Dialog Box 
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When you have scheduled a recurring appointment, your Calendar shows the 
Recurrence icon, a circle made from two arrows, which appears at the left of 
the appointment, as shown in Figure 4-10. 

Figure 4-10: A Recurring Appointment Displaying The Recurrence Icon 

L METHOD 

To create a recurring appointment: 

1. Select a time slot or time period. 
2. From the Actions menu, choose New Recurring Appointment. 
3. In the Appointment Recurrence dialog box, in the Recurrence 

pattern area, in the left column, select a time period option 
button. 

4. In the Recurrence pattern area, in the right column, select the 
appropriate option button or check boxes and, if necessary, fill 
in the required information. 

5. In the Range of recurrence area, select the appropriate end date 
option button and fill in required information. 

6. Choose OK. 
7. Complete the New Appointment window, and then, on the 

toolbar, click the Save and Close button. 

EXERCISE 

In the following exercise, you will create a recurring appointment. 

1. On the Calendar, select 
11:00 A.M. to 2:00 P.M.  on the 
third Monday of next month 

2. From the Actions menu, 	The Appointment Recurrence 
choose New Recurring 	 dialog box appears over the 
Appointment 	 New Appointment window. 
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5 

3. In the Recurrence pattern 
area, in the left column, select 
the Monthly option button 

4. In the Recurrence pattern 
area, in the right column, 
select the second option button 

5. In the Range of recurrence 
area, make sure the No end 
date option button is selected 

6. Choose OK 

5 
9 
9 

9 

The New Appointment window 
appears. 
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7. In the Subject text box, type 
Mayor's monthly business 
lunch 

8. In the Location text box, type 
restaurant 

9. In the large text box at the 
bottom of the window, type 
The mayor always orders 
stuffed grape leaves. 

10. On the toolbar, click the Save 
and Close button 

The appointrnent appears on 
the Calendar displaying the 
subject and the location. The 
appointment displays the 
Recurrence icon. 

r  END 
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Editing Recurring Appointments 

You can edit recurring appointments by reopening the Appointment 
Recurrence dialog box. Before this dialog box appears, however, the Open 
Recurring Item message box, shown in Figure 411, appears. In this message 
box, you specify whether the change is for this occurrence only or for the 
entire series. 

Figure 4-11: The Open Recurring Item Message Box 

L METHOD —I 

To edit a recurring appointment: 
1. Double-click the appointment. 

or 
1. Select the appointment, and then, from the File menu, choose 

Open/Selected Items. 
2. In the Open Recurring Item message box, select the desired 

option button, and then choose OK. 
3. In the Recurring Appointment window, make the changes. 
4. If desired, from the Appointment menu, choose Recurrence. 
5. In the Appointment Recurrence dialog box, make the changes. 
6. Choose OK. 
7. In the Recurring Appointment window, on the toolbar, click the 

Save and Close button. 
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I  --- EXERCISE 

In the following exercise, you will edit a recurring appointment. 

1. If necessary, select the 
Mayor's business lunch 
appointment 

2. From the File menu, choose 	The Open Recurring Item 
Open/Selected Items 	 message box appears. 

3. Select the Open the series 
option button 

4. Choose OK 	 The Recurring Appointment 
window appears. 

5. In the Subject text box, select 
the word monthly and type 
biweekly 

6. From the Appointment menu, 	The Appointment Recurrence 
choose Recurrence 	 dialog box appears. 

7. In the Recurrence pattern 
area, in the left column, select 
the Weekly option button 

8. In the Recurrence pattern 
area, in the right column, 
select the number in the Recur 
every...weeks text box, and 
then type 2 

The Recurring Appointment 
window shows the 
appointment recurring every 
two weeks beginning with the 
selected date. 9 

10. On the toolbar, click the Save 	The edited appointment 
9 	 and Close button 	 appears on the Calendar. 
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Creating Tentative Appointments 
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Sometimes you might want to reserve a time slot even if you are not sure an 
appointment is definite For example, if you want to attend a training class but 
your supervisor has not approved the expense yet, you can mark the time slot 
as a tentative appointment. Tentative appointments display a light blue move 
handle to the left of the appointment. 

L METHOD --I 

To create a tentative appointment: 

1. Create an appointment but do not close the New Appointment 
window. 

2. From the Show time as drop-down list, select Tentative. 
3. On the toolbar, click the Save and Close button. 

EXERCISE 

In the following exercise, you will create a tentative appointment. 

1. On the Date Navigator, select 	The Calendar displays next 
next Tuesday 	 Tuesday. 

2. On the Calendar, select the 
time period from 9:00 A.M. to 
1:30 P.M. 

3. On the toolbar, click the New 
Appointment button 

4. In the Subject text box, type 
Excel 97 training class 

5. From the Show time as drop-
down list, select Tentative 

6. On the toolbar, click the Save 
and Close button 

The New Appointment window 
appears. 

The appointment appears on 
the Calendar. The move 
handle is light blue. 

r  END 
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Managing Appointrnents 

Inserting Events 

You can remember special business and personal days by inserting them using 
the New Event window, shown in Figure 4-12. Outlook displays events at the 
head of your Calendar, as illustrated in Figure 4-13. Here is a simple place to 
list pay days, birthdays, anniversaries, and other significant events that do not 
require appointments during your work day. If the event lasts several clays, 
Outlook displays it every day for its duration. 

Figure 4-12: The New Event TVindow 
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Section 4: Scheduling with Calendar 

Figure 4-13: The Calendar with an Event Displayed 

L METHOD --I 
To insert events: 

1. From the Actions menu, choose New All Day Event. 
2. In the New Event window, complete the text boxes, select the 

options buttons and check boxes, and so forth, as if you were 
creating a new appointment. 

3. Make sure the All day event check box is selected. 
4. Make sure Free is selected in the Show time as: drop-down list 

box. 
5. On the toolbar, click the Save and Close button. 
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Managing Appointments 

r-- EXERCISE 

In the following exercise, you will insert an event. 

1. From the Actions menu, 	The New Event window 
choose New All Day Event 	appears. 

2. In the Subject text box, type 
New Year's Day 

3. From the Sta rt  time drop-down 
calendar, type January 1, 2000 

4. Make sure the All day event 
check box is selected 

5. Make sure Free is selected in 
the Show time as: drop-down 
list box 

6. On the toolbar, click the Save 	The Calendar reappears. 
and Close button 

7. Go to the date you selected for The event appears above the 
New Year's Day 	 Calendar on the selected date. 

- END  -i  
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Section 4: Scheduling with Calendar 

Deleting Appointments 

You should delete appointments as soon as you cancel them. Prompt deletions 
keep your Calendar up-to-date and give you and your colleagues an accurate 
picture for setting meetings. You can use the toolbar button to delete 
appointments. 

L METHOD —I 
To delete an appointment: 

1. Select the appointment. 
2. From the Edit menu, choose Delete. 

or 
2. On the toolbar, click the Delete button. 

r-- EXERCISE 

In the following exercise, you will delete an appointment. 

1. Display today's date 

2. In the Calendar, select the Call 
to check for new deliveries 
appointment 

3. On the Standard toolbar, click 	The appointment is deleted. 
the Delete button 

r  END 
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Managing Appointments 

Restoring Deleted Appointments 

If you delete an appointment in error and realize your mistake immediately 
after the deletion, you can restore it quickly. If you take any other action 
before restoring the appointment, however, you must recreate the deleted 
appointment from scratch. 

L METHOD 

To restore a deleted appointment immediately after deleting it: 
1. From the Edit menu, choose Undo Delete. 

or 
1. On the Advanced toolbar, click the Undo Delete button. 

EXERCISE 

In the following exercise, you will restore a deleted appointment. 

1. On the Advanced toolbar, dick The Call to check for new 
the Undo Delete button 	deliveries appointment is 

restored. 

r  END 

3 
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Summary 

To view a day, a work week, a week, 
or a month: 

1. On the Standard toolbar, click the 
button for the view you want. 

To view appointments for a day 
during the current month: 

1. On the Date Navigator, click the 
desired date. 

To adjust pane size to show a 
different number of months in the 
Date Navigator: 

1. Position the mouse pointer over 
the border between the panes you 
want to adjust. 

2. When the mouse pointer becomes 
the double-headed arrow mouse 
pointer, drag the border to the 
desired position. 

To view appointments in another 
month: 

1. Click the One Month Back arrow 
once for each previous month or 
the One Month Forward arrow 
once for each future month. 
or 

1. Click and hold the month label, 
and then, on the pop-up month 
list, drag the mouse pointer to the 
desired month. 

2. Click the desired date. 

To view a range of dates: 

1. On the Date Navigator, drag 
across the dates. 

To view several weeks: 

1. Position the mouse pointer near 
the left edge of the Date 
Navigator. 

2. When the pointer changes from 
pointing left to pointing right, 
drag the pointer along the left 
edge of the Date Navigator for 
the desired weelcs. 

To view discontiguons days: 

1. Press and hold CIRL 
2. On the Date Navigator, click each 

date you want to view. 
3. Release CritiL 

To show two time zones: 

1. In the Calendar, from the Tools 
menu, choose Options. 

2. In the Options dialog box, on the 
Preferences page, choose 
Calendar Options. 

3. In the Calendar Options dialog 
box choose Time Zone. 

4. In the Time Zone dialog box, in 
the Current time zone area, in the 
Label text box, type a short name 
for the current time zone. 

5. Select the Show an additional 
time zone check box. 

6. In the additional time zone area, 
in the Label text box, type a short 
name for the second time zone. 

7. In the Time  drop-dos  n list, select 
a time zone. 

8. If that time zone uses daylight 
savings time during the spring 
and surnmer, select the Adjust  for 

 daylight saving time check box. 
9. Choose OK. 
10.In the Calendar Options dialog 

box choose OK. 
il .In the Options dialog box, choose 

OK. 
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Summary 

To select a time slot or time period: 

1. In the Calendar (Day, Work 
Weelc, Weelc, or Month view), 
display the desired date. 

2. Click the time slot. 
or 

2. Drag through as many time slots 
as necessary. 

To create a basic appointment: 

1. Select a time slot or time period. 
2. Type a description. 

To select an appointment: 

1. Click the appointment 

To create a detailed appointment: 

1. If desired, select a time slot or 
time period. 

2. Double-click the selected time 
slot or time period. 
or 

2. On the Standard toolbar, click the 
New Appointment button. 

3. In the New Appointment window, 
on the Appointment page, in the 
Subject text box, type the subject 

4. In the Location combo box, type 
the location or select it from the 
drop-down list 

5. If necessary, modify the Start 
time and End time display-ed. 

6. If desired, in the large text box at 
the bottom of the page, type 
comments about the appointment. 

7. On the toolbar, click the Save and 
Close button. 

To change the date of an appointment 
in Day view: 

I.  Position the mouse pointer over 
the move handle. 

2. When the pointer becomes a four-
headed arrow, click and drag the 
appointment to the desired date 
on the Date Navigator. 
or  

2. When the pointer becomes a four-
headed arrow, click the move 
handle. 

3. From the Edit menu, choose Cut. 
4. On the Date Navigator, click the 

new date or time. 
or 

4. Display the desired day. 
5. From the Edit menu, choose 

Paste. 

To modify the date of an appointment 
in Week view: 

1. Position the mouse pointer over 
the time area of the appointment. 

2. When the pointer becomes a four-
headed arrow, drag the 
appointment to the new date on 
the Calendar or on the Date 
Navigator. 

To move an appointment to another 
time slot on the same day: 

1. Position the mouse pointer over 
the move handle. 

2. When the pointer becomes a four-
headed arrow, drag the 
appointment to the new time slot. 

To change the startup time or the 
ending time of an appointment: 

1. Position the mouse pointer over 
an appointment handle. 

2. When the pointer becomes a 
double-headed arrow, drag the 
appointment handle to the new 
time. 

To create a recurring appointment: 

1. Select a time slot or time period. 
2. From the Actions menu, choose 

New Recurring Appointment. 
3. In the Appointment Recurrence 

dialog box, in the Recurrence 
pattern arca, in the left column, 
select a time period option 
button. 
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Section 4: Scheduling with Calendar 

4. In the Recurrence pattern area, in 
the right column, select the 
appropriate option button or 
check boxes and, if necessary, fill 
in the required information. 

5. In the Range of recurrence area, 
select the appropriate end date 
option button and fill in required 
information. 

6. Choose OK. 
7. Complete the New Appointment 

window, and then, on the toolbar, 
click the Save and Close button. 

To edit a recurring appointment: 

1. Double-click the appointment. 
or 

1. Select the appointment, and then, 
from the File menu, choose 
Open / Selected Items. 

2. In the Open Recurring Item 
message box, select the desired 
option button, and then choose 
OK. 

3. In the Recurring Appointment 
window, make the changes. 

4. If desired, from the Appointment 
menu, choose Recurrence. 

5. In the Appointment Recurrence 
dialog box, naake the changes. 

6. Choose OK. 
7. In the Recurring Appointment 

window, on the toolbar, click the 
Save and Close button. 

To create a tentative appointment: 

1. Create an appointment but do not 
close the New Appointment 
window. 

2. From the Show time as: drop-
down list, select Tentative. 

3. On the toolbar, click the Save and 
Close button. 

To insert events: 

1. From the Actions menu, choose 
New All Day Event. 

2. In the New Event window, 
complete the text boxes, select 
the options buttons and check 
boxes, and so forth, as if you 
were creating a new appointment. 

3. Make sure the All day event 
check box is selected. 

4. Make sure Free is selected in the 
Show time as: drop down list 
box. 

5. On the toolbar, click the Save 
and Close button. 

To delete an appointment: 

1. Select the appointment. 
2. From the Edit menu, choose 

Delete. 
or 

2. On the Standard toolbar, click the 
Delete button. 

To restore a deleted appointment 
immediately after deleting it: 

1. From the Edit menu, choose 
Undo Delete. 
or 

1. On the Advanced toolbar, click 
the Undo Delete button. 
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Self-Check Exercise 4 
1. On the Friday before the third Monday of next month, make a one-hour 

appointment located in your office beginning at 9:00 A.M. to review 
preparations for the mayor's biweekly luncheon. Make a note that says: 
Order all ingredients for stuffed grape leaves. 

2. Move the appointment to the Thursday before the third Monday, and 
then move it forward thirty minutes to start at 9:30 A.M. 

3. Shorten the appointment to end at 10:00 A.M. 

4. Display Friday of the previous week. Make a one-half hour appointment 
that recurs weekly at 4:30 P.M. to review your staples inventory. 

5. Change the inventory appointment to biweekly. 

6. On the second Tuesday of every month, create a recurring appointment 
from 6:00 P.M. to 9:00 P.M. to teach a culinary course at the New Orleans 
Culinary Institute. 

7. Set a reminder for the culinary course for two hours before the course 
begins. 

8. On the fourth Friday following the current date, create a tentative 
appointment from 5:30 P.M. to 6:00 P.M. for a haircut at Snippits. 

9. Delete the haircut appointment and restore it irnmediately. 

10. View your appointments for this week, and then view your appointments 
for the entire month. Then return to Day view. 

11. Show only your time zone. 

12. Insert your birthday as an event in your calendar. 

13. Restore your Calendar to today's date in Day view. 

137 



Section 4: Scheduling with Calendar 

£31  

feji -J (c3i  a  

fe"-It 

JdT 
le 1 
„CC 
ell 

ej 

(cp_sri 
qjj  

( 3e1(ç:7-13/1  
(‘...73  „el  
(c- 
(c

i
=rinuf  

,- 	1mi 

138 



o  
•  

cf) 

Organizing Tasks 

• Working with Tasks 
• Managing Tasks 

M 

Z 

,!• 

9111MMIS 

rift'27  

1 

iz.r1  
rerl 
ra .0 

CL 

tar' 
rer' 

ter._ 
,cst 
plut 

ifluc; 



Section 5: Organizing Tasks 

Section Skills and Their Importance 
In the following section you will leam to: 

• Work with tasks 
Outlook can help you manage most professional and personal 
tasks. You create new tasks, edit them, make them recurring, and, 
if necessary, delete them. You can view them in detail in the Tasks 
folder or in brief on the TaskPad in the Calendar folder. 

II Manage tasks 
With Outlook, you can set priorities for tasks, track them, and 
mark them completed. You can even automatically regenerate a 
task after you complete it. You can also group and sort your tasks 
by their priority, due date, or any other property by which you 
choose to group or sort. 
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Figure 5-1: Tasks in Simple List View 

The TaskPad in your Calendar shows active tasks that you should complete 
within the next seven days. You can add to the task list in the Tasks folder or 
on the TaskPad. 
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Working with Tasks 

Working with Tasks 
Tasks are activities or duties you must perform and track through completion. 
Tasks can be work-related, such as completing and sending in time sheets, or 
personal, such as purchasing tickets to an event. 

The Tasks folder, shown in Figure 5-1, lets you define your taslcs. You can 
display all tasks in a simple list or a detailed list, show only active tasks, show 
tasks for the next seven days, show overdue tasks, or view your tasks by other 
criteria. 

IIIESEMETHEZI 
,:11 	V'tees Ç;o Took ACaorts tie:p 

cçe ca  
0  t 

Sets— 



I Detark 1 
. 	. 

Sik:ett: iPrepare retructer mtes 

Zte date: 	iNione 	Ltj 	Status: Mor-F-Stertett 

Ste  e 	J ie 	 iricresal 	% Correiete: 

reerlinder 7.2.1 	Owner: ltencty, tieiere -5)CR 

4".• 

PriYee r, t - 	— 
f 

Section 5: Organizing Tasks 

Creating a Task 

You can create a simple task in your list by clicking the Click here to add a 
new Task text box on the task list in the Tasks folder or on the TaskPad in the 
Calendar. You then enter your information and click anywhere else on the task 
list or press ENTER to save your data. To add more detailed information, 
however, you must use the New Task window, shown in Figure 5-2. In the 
Task window, you can show the start and due dates, the status, and the priority 
of the task. You can also set a reminder for the task. 
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Figure 5-2: The New Task Window 

You access the New Task window by clicldng the New Task button on the 
toolbar. Table 5-1 summarizes the context-sensitive Tasks toolbar buttons. 

v 
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Working with Tasks 

Standard Toolbar 

Button 	Name 	 Function 
-----..-.-- 	New Task 	Opens the New Task window so you can 0 71 	 create a new task. The drop-down arrow 

gives you access to the New windows for the 
other Outlook features. 

Advanced Toolbar 

-sera==1"List 	 Current View 	Filters your tasks by Active Tasks, Next 1................:. 
Seven Days, Completed Tasks, and so forth. 
The drop-down arrow lets you select a filter. 

I—M-- 	Group By 
Box 	

Groups your messages by a selected column 
header. 

ft 	AutoPreview 	Sets your task list to display the subject line 
and the contents of the large text box at the 
bottom of the Task window. 

Table 5-1: The Tasks Toolbar Buttons 

L METHOD --I 
To create a task: 

Task list method 
1. Click the Click here to add a new Task text box. 
2. In the text box, type the subject. 
3. If necessary, click the Due Date text box. 
4. Enter a due date. 

or 
4. Click the Due Date drop-down arrow, and then select a date 

from the Date Navigator. 
5. Click anywhere else on the task list. 

or 
5. Press ENTER 

New Task window method 
1. On the toolbar, click the New Task button. 

or 
1. From the Actions menu, choose New Task. 
2. In the Task window, on the Task page, in the Subject text box, 

type the subject. 
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Section 5: Organizing Tasks 

3. In the Start date combo box, type the start date or click the Start 
date drop-down arrow and choose a start date from the Date 
Navigator, and then in the Due date combo box, type the due 
date or click the Due date drop-down arrow and choose a due 
date from the Date Navigator. 

4. If desired, set a reminder. 
5. If desired, in the large text box at the bottom of the window, add 

notes. 
6. On the toolbar, click the Save and Close button. 

In the following exercise, you will create tasks. 

1. Open the Tasks folder 	 The task list appears in Simple 
List view. 

1----- EXERCISE 

Today's date appears in the 
Start combo box. 

144 

2. Click the Click here to add a 
new Task text box 

3. Type collect recipes for 
culinary course 

4. Click the Due Date text box 

5. Type first Tuesday of next 
month 

6. Press ENTER 

7. On the toolbar, click the New 
Task button 

The insertion point is in the 
subject text box. The word 
None appears in the Due Date 
text box. 

The Due Date text box 
becomes a combo box. 

The text appears in the Date 
Due box. 

The new task is added to the 
task list The due date appears 
as a date. 

The New Task window 
appears. 

8. On the Task page, in the 
Subject text box, type Make 
signs for Food Festival 
stand 

9. In the Sta rt  Date drop down list 
box click the down arrow and 
choose the Today button 
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Working with Tasks 

10. In the Due Date drop down list 
box, click the down arrow, and 
choose the first Monday in next 
March 

11. On the toolbar, click the Save 	The task appears on the task 
and Close button 	 list 

12. Add the tasks in Table 5-2 to 
your task list 

r °  7 

Task 	 Start Date 	Due Date 

Buy copy pape 	 today 	 next Tuesday 

Send fliers re: next 	next Monday 	Friday after next 
month's specials to all 	 Monday 
customers who left 
business cards 

Call suppliers about 	today 	 month from today 
discounts for bulk orders 

The date of the first Monday in 
next March appears in the Due 
combo box. 

Table 5-2: Additional Tasks for Task List 



Task window method 
1. Double-click the task. 

or 
1. Select the task, and then, from the File menu, choose 

Open / Selected Items. 
2. In the Task window, make the change. 
3. On the toolbar, click the Save and Close button. 

EXERCISE 

In the following exercise, you will edit tasks. 

2. Select the due date and type 
tomorrow 
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Selecting and Editing a Task 

Tasks are often not completed as initially conceived. You might fmd it 
necessary to change the end date of a task or to edit the task description. You 
edit tasks in the Task window. You can also make simple edits directly on the 
task list. 

L METHOD 

To select a task: 

1. Click the task. 

To edit a task: 

Task list or TaskPad method 
1. Select the task. 
2. Make the change. 
3. Click anywhere else on the task list. 

or 
3. Press ENTER 
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1. On the task list, click the 
collect recipes for culinary 
course Due Date text box 

The task is selected. The 
columns to the left of the due 
date become blue. The (imp-
down arrow appears. 



The task list reappears. The 
task displays the new due 
date. 

The task is selected. 

Working with Tasks 

3. Click anywhere else on the 
task list 

4. Click the get info on food 
festival Subject task box 

5. Double-click the task  

Tomorrow's date appears in 
the Due Date text box. The edit 
is saved. 

The task is selected. The 
columns to the left and the 
right of the subject become 
blue. 

The get info on food festival 
- Task window appears. 

6. In the Due combo box, select 
the text and then type today 

7. Choose Save and Close 

8. Click the order new tablecloths 
task 

9. From the File menu, choose 
Open / Selected items 

10. In the notes area, change the 
number of square tablecloths 
to 12 

The order new tablecloths - 
Task window appears. 

11. On the toolbar, click the Save 	The task list reappears. 
and Close button 

F END --I 
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Section 5: Organizing Tasks 

Making a Task Recurring 

Some tasks you do routinely—for example, you pick up your paycheck every 
other Friday. You can define these routine tasks as recurring tasks so that they 
are always on your task list. You see the task listed only once, but whenever 
you complete the task, the next occurrence then appears on the task list. 

You schedule recurring tasks in the Task window using the Task Recurrence 
dialog box, shown in Figure 5-3. If a task already appears on your task list and 
you want to make it recurring, you can select the task, open its Task window, 
and then click the Recurrence button on the toolbar. 

Figure 5-3: The Task Recurrence Dialog Box 

Once you have designated a task as recurring, the Icon field displays the 
Recurring Task icon, a clipboard with the recurring task symbol, two arrows 
in a circle on a gray box, as shown in Figure 5-4. This symbol is similar to the 
recurring appointment symbol. 

Figure 5-4: The Recurring Task Icon 
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Working with Tasks 

L METHOD --I 

To make a task recurring: 

1. Select a task and open the Task window. 
or 

1. Create a task but do not close the Task window. 
2. On the toolbar, click the Recurrence button. 
3. In the Task Recurrence dialog box, in the Recurrence pattern 

area, in the left column, select a time period option button. 
4. In the Recurrence pattern area, in the right column, select the 

appropriate option button or check boxes and, if necessary, fill 
in the required information in the appropriate text boxes. 

5. In the Range of recurrence area, select the appropriate end date 
option button and fill in the required information. 

6. Choose OK. 
7. In the Task window, on the toolbar, click the Save and Close 

button. 

r--- EXERCISE 

In the following exercise, you will malce a task recurring. 

1. Select the send tilers  te: next 
month's specials.. ,  task and 
open the Task window 

2. On the toolbar, click the 	The Task Recurrence dialog 
Recurrence button 	 box appears. 

3. In the Recurrence pattern 
area, in the left column, select 
the Monthly option button. 

4. In the Recurrence pattern 
area, in the right column, 
select the second option button 

5. In the Range of recurrence 
area, select the End after 
option button, and then select 
the text in the text box and 
type 6 
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Section 5: Organizing Tasks 

6. Choose OK 

7. On the toolbar, click the Save 
and Close button 

The Task window reappears. 
An information area that tells 
you when the task is due, 
when the task starts, and how 
long it is effective appears just 
below the tabs. 

The task is recurring. The task 
list reappears. The icon cell 
displays the Recurring Task 
icon. 

r  END i 
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Working with Tasks 

Deleting and Restoring a Task 

When you are no longer responsible for a task on your task list and you have 
not done any work on it, you should delete the item from your list. If you 
delete a task in error, you can immediately restore it. 

Note: Since Outlook is a record of your activities, you should not delete 
partially completed and completed tasks. This can be especially important 
when auditors come by or when it is time for your annual performance 
appraisal. 

I— METHOD --] 
To delete a task: 

1. Select the task. 
2. On the toolbar, click the Delete button. 

To restore a deleted task immediately after deleting it: 

1. From the Edit menu, choose Undo Delete. 
or 

1. On the advanced toolbar, click the Undo Delete button. 

r--- EXERCISE 

In the following exercise, you will delete and restore a task. 

1. Select the buy copy paper task 

2. On the toolbar, click the Delete  The  task disappears from the 
button 	 task list 

3. On the advanced toolbar, click 	The task reappears on the task 
the Undo Delete button 	list 

r  END i 
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Section 5: Organizing Tasks 

Managing Tasks 
If you have many tasks, you might want to view your task list differently. As 
in the Mail folder, you can sort your tasks by clicking the column headers. In 
addition, you can filter your task list to show a subset of your tasks by clicking 
the Current View drop-down arrow. 

The Tasks Current View drop-down list on the Advanced toolbar gives you 
numerous criteria to use to filter the messages. Table 5-3 summarizes the 
Tasks Current View filters. 

Name 	 Function 

Simple List 	 Shows the subject line, task type, status, and 
due date of all tasks. 

Detailed List 	 Shows the Simple List with such additional 
details as priority, whether there are 
attachments, and categories. 

Active Tasks 	 Shows only those tasks that are incomplete. 

Next Seven Days 	 Shows only those tasks due in the next seven 
days. 

Overdue Tasks 	 Shows only those tasks that are overdue. 

By Category 	 Groups tasks by category. 

Assignment 	 Groups tasks by who assigned them to you. 

By Person Responsible 	Groups tasks by who is responsible for their 
completion. 

Completed Tasks 	 Shows only completed tasks. 

Task Timeline 	 Graphically shows when each task was 
assigned, its duration, and its completion date. 

Table 5-3: The Tasks Current View Filters 

When you assign priorities to your tasks, you can decide which task to work 
on based on its importance and its due date. You should also track the status 
of a task and check it off when you complete it. 
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Managing Tasks 

Setting .the Priority for a Task 

While it is important that you complete all tasks punctually, some tasks are 
more important than others, and you should work on them first. Outlook lets 
you set the priority on tasks so you can quickly evaluate how to best use your 
time. You can use the Task window to set your task priority or, if you already 
have a task on your list, you can display the list in a detailed view and add a 
priority symbol to the task by clicking the Priority column header, shown in 
Figure 5-5. The symbol for low priority is a blue arrow pointing down and for 
high priority is a red exclamation point. Normal priority has no symbol. 

14. 
!le  

Figure 5-5: The Priority Column Header 

Note: The Priority column header is not visible when you filter your Current 
View as Simple List or as Task Timeline. 

L METHOD 

To set the priority for a task: 

Task window method 
1. Select a task and open the Task window. 

or 
1. Create a task but do not close the Task window. 
2. In the Task window, click the Priority drop-down list box, and 

then select a priority. 
3. On the toolbar, click the Save and Close button. 

Detailed list method 
1. In any task list view that shows the Priority column, click the 

Priority column cell for the task. 
2. From the drop-down list, select a priority. 
3. Click anywhere on the task list 

or 
3. PreSS ENTER 
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Section 5: Organizing Tasks 

FJCERCISE 

In the following exercise, you will set the priority for several tasks. 

1. Open the buy copy paper Task 
window 

2. Click the Priority drop-down list 
box, and then select High 

3. On the toolbar, click the Save 
and Close button 

The task list reappears. 

4. On the toolbar, click the 
Current View drop-down list 
arrow, and then select Active 
Tasks 

5. Click the priority column cell for 
the get info on food festival 
task 

6. Select High 

7. Click anywhere on the task list  

A red exclamation point 
appears in the Priority column 
cell of the buy copy paper 
task. 

A drop-down list appears. 

A red exclamation point 
appears in the Pnbrity column. 

The priority is saved. 
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Managing Tasks 

Tracking a Task's Status and Marking a Task 
Completed 

Each time you work on a task, you should track its status on the Status page of 
the Task window, shown in Figure 5-6. You can enter such details as how 
many hours the task lasted, who to bill, who you contacted, and so forth on 
this page. You can show that a task is in progress and approximate how close 
to completion you are on the Task page. 

Figure 5-6: The Details Page of the Task Window 

When you finish a task, you should mark it as completed so that it no longer 
appears on your active tasks list. You can simply check it off on your TaskPad 
or task list using the check box in the Complete colunm or you can mark it in 
the Task window. Figure 5-7 shows the Complete column header. 

Figure 5-7: The Complete Column Header 

Note: The Complete column header is only visible when you filter your 
Current View as Simple List. 
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Section 5: Organizing Tasks 

L METHOD —1  
To track a task's status: 

1. Open the task window. 
2. On the Task page, click the Status drop-down list  box, and then 

select a status. 
3. In the % Complete spin box, click a spin arrow or enter a 

percentage. 
4. Select the Details tab. 
S. On the Details page, enter the desired details in the appropriate 

text boxes. 
6. On the toolbar, click the Save and Close button. 

To mark a task completed: 

1. On the TaskPad or on the task list in Simple List view, select 
the Complete check box for the completed task. 
or 

1. In the Task window, on the Task page, click the Status drop-
down list box, and then select Completed. 

2. On the toolbar, click the Save and Close button. 

r--- EXERCISE 

In the following exercise, you will track a task's status and you will mark 
tasks completed. 

1. Open the Calendar folder 

2. On the TaskPad, select the 
buy copy paper Complete 
check box 

3. Open the Tasks folder 

4. Click the Current View drop-
down list arrow, on the 
advanced toolbar and then 
select Simple List 

5. On the task list, select the 
order new tablecloths 
Complete check box 

A check appears in the 
Complete check box and a line 
appears through the subject 

A check appears in the 
Complete check box and a line 
appears through the subject 
and the due date. 
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The task list reappears. 

The text in the % Complete 
text box becomes 100%. 

The Details page appears. 

The task list reappears. A 
check appears in the Complete 
check box and a line appears 
through the subject and the 
due date. 

— END 
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6. From the task list, open the call 
suppliers about discounts for 
bulk orders Task window 

7. On the Task page, click the 
Status drop-down list box, and 
then select In Progress 

8. In the ''/0 Complete spin box, 
type 10% 

9. On the toolbar, click the Save 
and Close button 

10. From the task list, open the get 
info on food festival Task 
window 

11. On the Task page, click the 
Status drop-down list box, and 
then select Completed. 

12. Select the Details tab 

13. In the Total work text box, type 
20 minutes 

14. In the Actual work text box, 
type 20 minutes 

15. In the Mileage text box, type 
none 

16. On the toolbar, click the Save 
and Close button 
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Using Task Timeline View 

Filtering the Current View as Task Timeline, shown in Figure 5-8, shows you 
your task list in timeline format. When you view your tasks with this filter, 
you can visually analyze which tasks you must work on to complete 
everything in a timely fashion. You can open the Task window from this view 
to enter data. 

Fie et ii"iew  o TOOls *Aches F.+•,  
_ 

Go b  Todef fDuw 	ore *- 	ce  

L-ta;e.k sheicàs : 5 

2 Phone CC in Ottawa re VISAs 

Yeelcometo Tasks! 

2 Preparn; Kristerial V`st 

Odle Shcitcuto 

. 611.eins 

• ■■ 

•• 

Fri 8 

J1 Task Timettne 

Wed 6 	Thu 7 Sat 9 Sun 10 

Figure 5-8: The Tasks Folder in Task Timeline View 

L METHOD 

To use Task Timeline view: 

1. On the Advanced toolbar, click the Current View drop-down 
arrow, and then select Task Timeline. 

2. Examine the timelines. 
3. If desired, select a task, and then double-click it. 
4. In the Task window, make desired changes. 
5. On the toolbar, click the Save and Close button. 
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Managing Tasks 

EXERCISE 

In the following exercise, you will use Task Timeline view. 

1. On the advanced toolbar, click 	The drop-down list appears. 
the Current View drop-down 
arrow 

2. Select Task Timeline 	 The task list appears in Task 
Timeline view. 

3. Examine the list 

4. Return the Current View to 
Simple List 
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To create a task: 

Task list method 
1. Click the Click here to add a new 

Task text box. 
2. In the text box, type the subject. 
3. If necessary, click the Due Date 

combo box. 
4. Enter a due date. 

or 
4. Click the Due Date drop-down 

arrow, and then select a date from 
the Date Navigator. 

5. Click anywhere else on the task 
list. 
or 

S. Press ENTER 

New Task window method 
1. On the toolbar, click the New 

Task button. 
or 

1. From the Actions menu, choose 
New Task. 

2. In the Task window, on the Task 
page, in the Subject text box, type 
the subject. 

3. In the Start clate combo box, type 
the start date or click the Start 
date drop-down arrow and choose 
a start date from the Date 
Navigator, then in the Due date 
combo box, type the due date or 
click the Due date drop-down 
arrow and choose a due date from 
the Date Navigator. 

4. If desired, set a reminder. 
5. If desired, in the large text box at 

the bottom of the window, add 
notes. 

6. On the toolbar, click the Save and 
Close button. 

To select a task: 

1. Click the task. 
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To edit a task: 

Task list or TaskPad method 
1. Select the task. 
2. Make the change. 
3. Click anywhere else on the task 

list. 
or 

3. Press ENTER 

Task window method 
1. Double-click the task. 

or 
1. Select the taslc, and then, from the 

File menu, choose Open. 
2. In the Task window, make the 

change. 
3. On the toolbar, click the Save and 

Close button. 

To delete a task: 

1. Select the task. 
2. On the toolbar, click the Delete 

button. 

To restore a deleted task immediately 
after deleting it: 

1. From the Edit menu, choose 
Undo Delete. 
or 

I. On the Advanced toolbar, click 
the Undo Delete button. 

To make a task recurring: 

1. Select a task and open the Task 
window. 
or 

1. Create a task but do not close the 
Task window. 

2. On the toolbar, click the 
Recurrence button. 



Summary 

3. In the Task Recurrence dialog 
box, in the Recurrence pattern 
area, in the left column, select a 
time period option button. 

4. In the Recuzrence pattern area, in 
the right coltunn, select the 
appropriate option button or 
check boxes and, if necessary, fill 
in the required information in the 
appropriate text boxes. 

5. In the Range of recurrence area, 
select the appropriate end date 
option button and fill in the 
required information. 

6. Choose OK. 
7. In the Task window, on the 

toolbar, click the Save and Close 
button. 

To set the priority for a task: 

Task window method 
1. Select a task and open the Task 

window. 
or 

I.  Create a task but do not close the 
Task window. 

2. In the Task window, click the 
Priority drop-down list box, and 
then select a priority. 

3. On the toolbar, click the Save and 
Close button. 

Detailed list method 
1. In any task list view that shows 

the Priority coltunn, click the 
Priority column cell for the task. 

2. From the drop-down list, select a 
priority. 

3. Click anywhere on the task list 
Or 

3. Press ENTER 

To track a task's status: 

1. Open the task window. 
2. On the Task page, click the Status 

drop-down list box, and then 
select a status. 

3. In the % Complete spin box, click 
a spin arrow or enter a 
percentage. 

4. Select the Details tab. 
5. On the Details page, enter the 

desired details in the appropriate 
text boxes. 

6. On the toolbar, click the Save and 
Close button. 

To mark a task completed: 

1. On the TaskPad or on the task list 
in Simple List view, select the 
Complete check box for the 
completed task. 
or 

1. In the Task window, on the Task 
page, click the Status drop-down 
list box, and then select 
Completed. 

2. On the toolbar, click the Save and 
Close button. 

To use Task Timeline Ni ew: 

I. On the Advanced toolbar, click 
the Current View drop-down 
arrow, and then select Task 
Timeline. 

2. Examine the timelines. 
3. If desired, select a taslc, and then 

double-click it. 
4. In the Task window, make 

desired changes. 
5. On the toolbar, click the Save and 

Close button. 
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Self-Check Exercise 

1. Add hire assistant chef to your task list. Set the priority as high. 

2. Add make kitchen clean-up check list to your task list. 

3. Add send out Greater New Orleans Restaurant Association mailing 
to your task list. Set this up as a task that recurs monthly on the fifth of 
each month. Show this as a one-year commitment. 

4. You have an hour appointment to interview Fatty LaMonte tomorrow 
morning for the assistant chef position. Show the Hire assistant chef task 
as in progress and 25 percent complete. 

5. Change the collect recipes for culinary  course task to read get recipes 
from Charlotte for culinary course 

6. Delete the Make signs for Food Festival stand task, and then restore it. 

7. Examine your task list in Task Timeline view. Then, view your task list 
in Next Seven Days view. 
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Keeping a Journal 
and Udlizing Notes 

• Tracking Activities 
• Working with Notes 



Section 6: Keeping a Journal and Utilizing Notes 

Section Skills and Their Importance 
In the following section you will learn to: 

• Track activities 
You can set your Journal to record your activities each time you 
open a document in any of the Microsoft Office 98 suite of 
applications. You can also add to your Journal manually. Then you 
can use different Journal views to analyze how you spend your 
time and to show what documents you worked on and when you 
worked on them. In addition, you can set up the Journal so that you 
can  use a Journal entry as a shortcut to the document shown. 

• Work with notes 
Outlook lets you jot down notes that you can leave on-screen, edit, 
and delete. These notes are of the informal, sticky note type. You 
can color code your notes to help you find those related to one 
subject more easily. You can also change the size of the note icons 
in the information viewer. 
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Tracking Activities 

Tracking Activities 
The Journal is a folder in which you can record the occurrence of certain items 
such as meetings, tasks or E-mail messages. You can set options to record 
items that you send, receive, or create for selected contacts. Figure 6-1 shows 
a sample journal viewed by entry type in month view. The timeline shows 
E-mail messages and when they were opened. 
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Figure 6-1: A Sample Journal Filtered by Entry Type in Afonth View 

You can set up the Journal to record your Outlook activities automatically. 
You can also list your other activities manually, whether you want to record a 
conversation, an appointment, a contact, or anything else of importance. 

You might need to verify when you worked on a document or talked with a 
colleague. In such a case, you can use your Journal to fmd your activity. 
Several filters show timelines that emphasize the date and duration of the 
contact, while the remaining filters document the quantity of activity. You can 
change whether the timeline displays a day, a week, or a month by clicking the 
Day, Week, or Month buttons on the toolbar, as you did in the Calendar 
folder. If you want to open a document that is listed in your Journal, you can 
open it directly fi-om the Journal listing. 
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Section 6: Keeping a Journal and Utilizing Notes 

The Journal Current View drop-down list gives you numerous criteria to use 
to filter the activities. Table 6-1 summarizes the Journal Current View filters. 

Name 	 Function 

By Type 	 Groups activities by application type in 
timeline format. 

By Contact 	 Groups activities by contact in timeline format. 

By Category 	 Groups activities by category in timeline 
format. 

Entry List 	 Lists all activities recorded. Shows the date, 
duration, contact, and category. 

Last Seven Days 	 Shows the entry list for the last seven days. 

Phone Calls 	 Lists phone calls. 

Table 6-1: The Journal Current View Filters 

Table 6-2 summarizes the context-sensitive Journal toolbar buttons. 

	

Button 	Name 	 Function 

	

: 	New Journal 	Opens the New Journal Entry window so you 
can create a new activity. The drop-down 
arrow gives you access to the New windows 
for the other Outlook features. 

By Type 	E 	Current 	Filters your journal items by Type, Contact, 
View 

	

	Last Seven Days, and so forth. The drop- 
down arrow lets you select a filter. 

t G6-t -dest 	Go to Today 	Displays today's date in Day, Week, or Month 
Current View. 

uà 	ay 	Day 	 Displays one day on the timeline. 

IMA 	Week 	Displays one week on the timeline. 

giMnifi i 	Month 	Displays one month on the timeline. 

Table 6-2: The Journal Toolbar Buttons 
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Tracking Activities 

Recording Activities Automatically 

You set up the Journal to record your activities automatically in the Journal 
Options dialog box, shown in Figure 6-2. This dialog box governs 
recording e-mail messages, meetings, tasks assigned to others, activities 
with contacts. You access the Journal Options dialog box from the 
Preferences page of the Options dialog box. 

Figure 6-2: The Journal Page of  the Options Dialog Box 

L METHOD 

To record activities automatically: 

1. From the Tools menu, choose Options. 
2. Select the Preferences tab. 
3. Click on the Journal Options button. 
4. In the Journal Options dialog box, in the Automatically record 

these items: list, select the appropriate check boxes. 
5. In the For these contacts: area, select the appropriate check 

boxes. 
6. Choose OK. 
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Section 6: Keeping a Journal and Utilizing Notes 

Recording Activities Manually 

You use the New Journal Entry window, shown in Figure 6-3, to record 
manually such activities as conversations, timesheet data, and letters and faxes 
sent and received that you cannot record automatically. You access the New 
Journal Entry window by clicking the New Journal button on the Standard 
toolbar. 

Figure 6-3: The New Journal Entry Window 

L METHOD --I 
To record activities manually: 

1. On the Journal toolbar, click the New Journal button. 
or 

1. From the Journal menu, choose New Journal Entry. 
2. In the New Journal Entry window, in the Subject text box, type 

a description. 
3. In the Entry type drop-down list box, select the entry type. 
4. Fill in the remaining text boxes, as appropriate. 
S. On the toolbar, click the Save and Close button. 
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1-EXERCISE 

In the following exercise, you will record activities manually. 

1. On the Journal toolbar, click 
the New Journal button 

The New Journal Entry window 
appears. 

2. In the Subject text box, type 
new assistant chef 

3. Make sure that Phone call is 
selected as the Entry type 

4. In the Contact text box, type 
Felicia Montrachet • Lis rle  drie  drle  

drib  
3,•3  
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5. In the Company text box, type 
Greater New Orleans 
Restaurant Assoc. 

6. In the large text box at the 
bottom of the window, type 
Asked if Felicia has had any 
recent inquiries from chefs. 
She said she'd look in her 
file and call back. 

7. On the toolbar, click the Save 
and Close button 

The Journal reappears 
showing Entry Type: Phone 
Call. 

8. Expand the Entry Type: Phone 
Call 

Your phone call activity 
appears. 

9. Change the Current View to By 
Contact 

Your contact with Felicia 
Montrachet appears. In 
addition, the list includes the 
author of this book as the 
contact for JoumaLdoc. 

r- END 
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Section 6: Keeping a Journal and Utilizing Notes 

Setting Shortcut Opening Options and Using a 
Journal Entry as a Shortcut 

Suppose you are looking for a document you worked on a week ago and you 
can no longer recall its name. You can open items you tracked in your Journal 
to find the document you want. 

The way you set up the Journal page of the Options dialog box determines 
whether you open the document directly or you open the Journal Entry 
window and then the document. By default, double-c licking opens the Journal 
Entry window. 

L METHOD -1  

To set shortcut opening options: 

1. From the Tools menu, choose Options. 
2. On the Preference page of the Options dialog box, click the 

Journal Options button and in the Double-clicking  ajournai 
 entry: area, select an option button. 

3. Choose OK. 

To use a Journal entry as a shortcut: 

1. Double-click the Journal entry. 
2. If necessary, in the Journal Entry window, double-click the 

shortcut in the large text box at the bottom of the window. 

r----- EXERCIS 

In the follovving exercise, you will set shortcut opening options and 
you will use a Journal entry as a shortcut. 

1. Change the view to Last Seven 
Days 

2. If necessary, position the 
double-headed mouse pointer 
over the border that separates 
the Subject and the Start 

 column headers, and then drag 
the border to the right 

The Subject column becomes 
wider, allowing you to see the 
whole drive path. 
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3. In the Subject column, double-
click A:Uournal.doc 

4. In the large text box at the 
bottom of the window, double-
click the Journal.doc shortcut 

5. Close the document and exit 
from Word Perfect 8.0 

6. Close the Journal Entry 
Window 

The JoumaLdoc Journal Entry 
window appears. 

Word Perfect 8.0 loads and the 
document opens. 

The Journal Entry window 
reappears. 

The Journal reappears. 

END 



Section 6: Keeping a Journal and Utilizing Notes 

Working with Notes 
Outlook's Notes folder lets you write casual sticky notes to yourself that you 
can leave on-screen as a reminder. If you have notes related to an 
appointment, a contact, or a task, you should write such notes in the text boxes 
provided in the entry windows. You can write and edit the sticky notes and 
delete them when you no longer need them. 

Table 6-3 describes the fimctions of the Notes toolbar buttons. 

Button 	Name 	 Function 

Standard Toolbar 

New Note 	Opens a New Note so you can create a new 

1 memo. The drop-down arrow gives you 
i:  e 	 access to the New windows for the other C)  

Outlook features. 

Lar2e-Tcres  I 	Large icons 	Shows files and items as large icons. 

— ... 	Small icons 	Shows files and items as small icons. 

List 	 Shows files and items as a list. 

Advanced Toolbar 

 	Current View 	Filters your notes by icons, list, last seven 
days, color, and so forth. The drop-down 
arrow lets you select a filter. 

Table 6-3: The Notes Toolbar Buttons 

You filter the Notes using the Current View drop-down list. Table 6-4 lists the 
built-in filters. 
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Working with Notes 

Name 	 Function 

Icons 	 Displays an icon and the full text of each note. 

Notes List 	 Lists each note and lets you sort by subject, 
date created, and category. 

Last Seven Days 	 Lists the notes created in the last seven days. 

By Category 	 Groups notes by category. 

By Color 	 Groups notes by color. 

Table 6-4: The Notes Current View Filters 

Writing a Note 

You write notes in the Notes folder. When you click the New Note button, 
you see an untitled note that has the current date and time at its bottom. When 
you finish writing a note, as shown in Figure 6-4, you click its Close button to 
store it in the Notes folder. 

Figure 6-4: A Note 

L METHOD 

To write a note: 

11:0; 

1. In the Notes folder, click the New Note button. 
Or 

1. From the Note menu, choose New Note. 
2. On the note, type your text 
3. Click anywhere outside the note to leave the note open. 

or 
3. Click the Close button to close the note. 



EXERCISE 

In the following exercise, you will write notes. 

1. Open the Notes folder 

2. On the toolbar, click the New 
Note button 

3. On the note, type Pick up 
clothes from dry cleaner. 

4. Click outside the note 

5. From the Note menu, choose 
New Note 

6. On the note, type Ask 
Charlotte to attend the 
interview tomorrow. 

7. Click the Close button 

8. On the taskbar, click the dry 
cleaner note 

9. Close the note 

F END 1 

Your notes appear. 

An untitled note appears. 

The note stays open and 
appears in the information 
viewer and on the taskbar. 

An untitled note appears. 

The note is closed and 
appears in the information 
viewer. 

The note becomes active. 

Section 6: Keeping a Journal and Utilizing Notes 
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Working with Notes 

Opening and Editing a Note 

A note must be open to edit it. You use the same editing techniques that you 
use in Word or in your e-mail. 

L METHOD —I 

To open a note: 

1. Double-click the note. 

To edit a note: 

1. If necessary, open the note. 
2. Make the changes. 
3. If desired, close the note. 

E----- EXERCISE 

In the following exercise, you will open and edit a note. 

1. Double-did( the note that 
says, Ask Charlotte to attend 
the interview .  tomorrow. 

The note opens. 

2. Between the word Charlotte 	The word is inserted. 
and the word to type today 

3. Close the note 

F END i 
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Section 6: Keeping a Journal and Utilizing Notes 

Organizing Notes 
Besides sorting and viewing your notes just as you do other Outlook data, you 
can color code your notes and you can change the icon size to read your notes 
better. 

Color Coding a Note 

When you color code your notes by subject, category, project, or other criteria, 
you can quickly identify related notes when you are looking at the notes in 
Icon view. You change the color of a note when the note is open. 

L METHOD --I 
To color code a note: 

1. Open the note. 
2. In the upper-left corner of the note, click the note icon. 
3. From the drop-down menu, choose Color. 
4. From the submenu, choose a color. 
5. If desired, close the note. 

i-----  EXERCISE 

In the following exercise, you will color code a note. 

1. Open the Ask Charlotte today 
to attend the interview 
tomorrow note 

2. In the upper-left corner of the 	A drop-down menu appears. 
note, click the note icon 

3. Choose Color 	 A submenu appears. 

4. Choose Pink 

	

	 The color of the note changes 
to pink. 

5. Close the note 

6. Change the Current View to By The notes are grouped by 
Color 	 color. 
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7. Expand the Pink notes The Ask Charlotte today to 
attend the interview 
tomorrow note appears. 

8. Collapse the notes, and then 
change the Current View back 
to Icons 
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Section 6: Keeping a Journal and Utilizing Notes 

Changing Icon Size 

You can change the size of the note icons just as you change icon size in 
Windows Explorer. Outlook provides three buttons on the standard toolbar 
that detennine icon size and placement—Large Icons, Small Icons, and List-
shown in 
Figure 6-5. 

Large Icons 
button 

r; Large ICons 4  t - â-  Small Icons — 	- 	— 

Small Icons 
button 

List button 

7=1 
List I 

0■0•■■• 
à 

Figure 6-5: The Icon Buttons 

The large icon size is the default size. When you click the Large Icon button, 
the notes are arranged horizontally across the information viewer with the text 
below each icon. When you click the Small Icon button, the icons are arranged 
horizontally with the text to the right of each icon. Clicking the List button 
gives you small icons arranged in a vertical list with the text to the right of 
each icon. 

L METHOD ---1  

To change icon size: 

1. On the standard toolbar, click an Icon button. 
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EXERCISE 

In the following exercise, you will change icon size. 

1. On the toolbar, click the Small 
Icons button 

The icons become small and 
display the text to the right of 
the icons. 

The icons appear in a vertical 
list vvith the text to the right of 
the icons. 

The icons become large and 
display horizontally with the 
text below the icons. 

2. On the toolbar, click the List 
button 

3. On the toolbar, click the Large 
Icons button 

Organizing Notes 

11 
11: 
1 
12' 
; 

I à 
I Li 
r -a ras  
roe  

d rib 
1 -Er 
ra roe  
d roe  
1111:1, 

d 
_GI roe  

g 

g 

END 

179 



Summary 

To record activities automatically: 

1. From the Tools menu, choose 
Options. 

2. Select the Preferences tab. 
3. Click on the Journal Options 

button. 
4. In the Journal Options dialog 

box, in the Automatically 
record these items: list, select 
the appropriate check boxes. 

5. In the For these contacts: area, 
select the appropriate check 
boxes. 

6. Choose OK. 
To record activities manually: 

1. On the Journal toolbar, click the 
New Journal button. 
or 

1. From the Journal menu, choose 
New Journal Entry. 

2. In the New Journal Entry 
window, in the Subject text box, 
type a description. 

3. In the Entry type drop-down list 
box, select the entry type. 

4. Fill in the remaining text boxes, 
as appropriate. 

5. On the toolbar, click the Save and 
Close button. 

To set shortcut opening options: 

1. From the Tools menu, choose 
Options. 

2. On the Journal page of the 
Options dialog box, in the 
Double-clicking  ajournai  entry: 
area, select an option button. 

3. Choose OK.  

To use a Journal entry as a shortcut: 

1. Double-click the Journal entry. 
2. If necessary, in the Journal Entry 

window, double-click the shortcut 
in the large text box at the bottom 
of the window. 

To write a note: 

1. In the Notes folder, click the New 
Note button. 
or 

1. From the Note menu, choose 
New Note. 

2. On the note, type your text. 
3. Click anywhere outside the note 

to leave the note open. 
or 

3. Click the Close button to close 
the note. 

To open a note: 

1. Double-click the note. 

To edit a note: 

1. If necessary, open the note. 
2. Make the changes. 
3. If desired, close the note. 

To color code a note: 

1. Open the note. 
2. In the upper-left corner of the 

note, click the note icon. 
3. From the drop-down menu, 

choose Color. 
4. From the submenu, choose a 

color. 
5. If desired, close the note. 

To change icon size: 

1. On the standard toolbar, click an 
Icon button. 
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Self-Check Exercise 

1. Reset the Journal so that it no longer automatically records your e-mail, 
meeting, and task-related activities. Set double-clicking to open the 
Journal entry. 

2. Add a fax from Felicia Montrachet to your Journal. Felicia sent you 
three assistant chef referrals. 

3. View your Journal by phone calls. Add a call to Felicia Montrachet to 
thank her for the fax. 

4. View your Journal by type. Expand the view to see all your phone calls. 

5. Write a note to invite your sister to visit for Mardi Gras. Change the text 
to include her family. 

6. Make all the personal notes blue and the business notes pink. 

7. Change the Current View to By Color. Expand the Notes list so you can 
see all notes. 

8. Change the Current View to Icons. Change to small icons. 

9. Exit and log off from Outlook. 
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Management Features 

• Using Outlook Today 
• Managing Items 
• Customizing Outlook 
• Organizing Messages 
• Creating Rules 
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Section 7: Using Advanced Management Features 

Section Skills and Their Importance 
In the following section you will leam to: 

• Use Outlook Today 
Outlook Today lets you view your Calendar appointments and 
Tasks for the current date. You may also access your Inbox 
messages and fmd Contacts. 

• Manage items 
As you accumulate Outlook items, you can archive inactive items 
to store them out of your way. When you need an archived item, 
you can import your archived files to use them. Outlook provides 
search tools to help you find items you misplace. When you add 
categories to your items, you can group them and find them faster. 
When you work with long lists, Outlook's grouping feature helps 
you display only the items you want to examine. You can also 
create your own filters to display specific items. 

U Customize Outlook 
You can set your Outlook options to achieve the look you want. 
You can add, move, and delete shortcuts on the Outlook Bar. 

• Organizing messages 
Outlook makes it easy for you to organize your Inbox by using the 
Organi7e page. You can create and move messages to folders and 
color code messages from the Organize pane. 

III Creating Rules 
Rules allow you to specify how you want you incoming mail 
handle,d. You may create simple rules using the Organize pane or 
use the Rules wizard create detailed rules. 
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Using Outlook Today 

Using Outlook Today 

When you click the Outlook Today shortcut on the Outlook Bar, the Outlook 
Today folder opens. By default Outlook Today gives you a comprehensive 
overview of your calendar and tasks for the next five days. It also lets you 
know how many messages are in your Inbox. In addition, Outlook Today lets 
you quickly find a contact. You can customize Outlook Today so that items 
are displayed in the way you prefer. Figure 7-1 shows the Outlook Today 
page. 

ts Permand Folders • Idiom* Dulls& 	 VI. ez.1, 	. 	, 	 .. ifgeteffaellefrellestileffler Z.: ff D 

erv-v 
an: -nit 	11.• 	- sreFeetair 	, 	_•:--;e..7,7_,..tre. '- 	' 	-,. 	-r.— 

-IP.O?Ir"-; 	 • 	.r.w, _..,.. 	 FrklaY.AP/121.19114M , n  — 

	

 

..1 	
..-. ;— 

, s5 —:,..s.,..  e 
...5- 	 , 	 .. •. 

- 

	

... 	 Calendar 	 ..... 	Mail  
• trees 	tvo nevr rresscres Tuesday 

3 MOO SPI - 12:00 PM 	spacers tat 

4:3C PM • S:.M PM 	Buy copy Deer 	 0 Tasks 
, - 

2 
D 	Repiece el sx-es (i)  

• c 	C.a: seekers aecat dscaris for bulk crde-s 

T-1 	Send  sers  re sect moles specegs to al 
`-` 	customers tee left busress ca-es CSPIrni 

2 	a,  •, 	, 	. 	. 	,-.?E•r4..-,, 
. 	 c Kake sees For Food F-esevai *and Clerni 

C 	Coiect nacres For minty co‘rse (4;24.^58) 

-7' 	 C get Ho en food feerva (.4=re) 

	

' a• 	.....e.?71"1. '"‘• 	 2 	 - 	 _ 

	

 	 kc 	,....air...(itt:,..9,) 
 .,.....-..,-- 	--,r7---:-.. 	--------.--r--:»7-4 -: 

Figure 7-1: The Outlook Today Page 
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Section 7: Using Advanced Management Features 

Navigating with Outlook Today 

On the Outlook Today page, when you point to a folder shortcut, a folder 
name, or an individual item, the pointer becomes a hand and, if appropriate, 
the name or item is underlined. Clicking the shortcut or folder name opens the 
folder, just as clicking a shortcut on the Outlook Bar displays the folder. 
Clicking an item opens the item w-indow. 

L METHOD --I 

To open an Outlook folder in Outlook Today 

1. On the Outlook Today page, point to a folder shortcut or a 
folder name 

2. When the pointer becomes a hand or when the folder name 
is underlined, click the shortcut or name. 

To open a calendar item in Outlook Today 

1. On the Outlook Today page, point to the calendar item. 
2. When the pointer becomes a hand and the item is 

underlined., click the item. 

Completing a Task in Outlook Today 

When you are working with tasks in Outlook Today, you can do more than 
just open a task window to examine a task. You can also mark a task 
completed on the Outlook Today page. 

L METHOD --I 

To complete a task in Outlook Today 

1. Click the check box to the left of the task. 
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Navigating with Outlook Today 

Finding a Contact in Outlook Today 

The Find a Contact text box, which appears in the upper right of the Outlook 
Today page, lets you search for a contact. To do so, type the contact's name in 
the text box, and then click the word go that appears to the right of the box. As 
appropriate, Outlook searches your address books and contact records for the 
contact. Depending on the results of the search, Outlook might give you the 
opportunity to select the appropriate contact from a list before displaying the 
contact's information. 

L METHOD -I 
To find a contact in Outlook Today 

1. In the Find a Contact text box, type the contact name. 
2. To the right of the text box, point to the word go. 
3. When the pointer becomes a hand and the word go is 

underlined, click the word. 
4. If necessary, in the Advanced Find window, double-click 

the found contact record. 
or 

4. If necessary, in the Check Names dialog box, select the 
desired contact from the list and then choose Properties. 

5. As desired, close the dialog box(es). 
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Section 7: Using Advanced Management Features 

Setting Outlook Today Options 

You can customize Outlook Today to display from one to seven days in the 
calendar. You can also customize Outlook Today to display a simple task list 
showing all active tasks or only today's tasks. If you prefer, you can set 
Outlook Today to become the Outlook startup page, which means that the 
Outlook Today will appear when you start the program. If you change your 
mind about options you set, you can redefme them at any time. 

L METHOD —J 

To set Outlook Today options 

1. On the Outlook Today page, at the top of the page, point to 
the word Options. 

2. When the pointer becomes a hand and the word Options is 
underlined, click the word. 

3. As appropriate, on the Outlook Today Options page, defme 
the desired options. 

4. At the top of the page, point to the words Back to Outlook 
Today. 

5. When the pointer becomes a hand and the words are 
underlined, click the words. 
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Managing Items 

Managing Items 
When your Outlook items become out of date, you can store them or delete 
them. You can archive them automatically after a specified time interval or 
archive them manually. When you archive your items, you store them in your 
My Documents folder on your hard drive. You can retrieve archived items at 
any time. 

Another way to make item management easier for yourself is to specify 
categories for your items. A category is a keyword or a phrase you add to an 
item to help identify it. Designating categories helps you fmd and group your 
items. In addition, by creating your own filters, you can show and hide items 
according to your own criteria. 

Setting Up AutoArchiving 

In no time, you can collect a tremendous amount of Outlook data, especially 
e-mail messages, that can crowd your folders and make it difficult to find 
wanted items. You can manually transfer individual files to a storage area, but 
it is more efficient to let Outlook archive older data on a regular basis and 
store the data for you in your My Documents folder. 

Setting up AutoArchiving is a two-step process: First you set the intervals 
in the AutoArchive dialog box, shovvn in Figure 7-2. You access the 
AutoArchive dialog box from the Other page of the Tool / Options dialog 
box. Then you set the options in the Properties dialog box for each folder. 
You set the options in each folder's Properties dialog box except for the 
Contacts folder, which cannot be AutoArchived. 

Figure 7-2: The AutoArchive Dialog Box 
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Section 7: Using Advanced Management Features 

The default aging period for Calendar, Tasks, and Journal is six months; for 
Sent Items and Deleted Items, it is two months. By default, Outlook archives 
your data every two weeks. This means that every two weeks Outlook checks 
your data files to see if any are older than their aging period. When Outlook 
finds files that fit this profile, it asks you at start up whether to archive them. 
You can change the aging period for each folder on the AutoArchive page of a 
folder's Properties dialog box. 

If you want to AutoArchive the data in your Inbox and Notes folders, you 
must turn on the AutoArchive feature for these folders yourself.  You turn on 
the AutoArchive feature for these folders using the AutoArchive page of the 
Properties dialog box for the folder you want to archive. Figure 7-3 shows the 
AutoArchive page of the Inbox Properties dialog box. 

After you set up AutoArchiving, the feature automatically activates whenever 
you start Outlook. If the aging period for a folder has expired, Outlook 
displays a message box at startup that asks, Do you want to AutoArchive now? 
You then choose whether to complete the archiving process. If you do not 
choose to archive at the time of the notice, Outlook does not notify you about 
archiving again until the AutoArchive period for the next folder has expired. 
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Managing Items 

Figure 7-3: The AutoArchive Page of the  In box  Properties Dialog Box 

L METHOD —I 
To set up AutoArchiving: 

1. From the Tools menu, choose Options. 
2. In the Options dialog box, select the Other tab. 
3. On the Other page, click the AutoArchive button. 
4. In the AutoArchive every...day(s) at startup spin box, enter the 

number of days. 
5. Choose OK and close the Options dialog box. 
6. On the Outlook Bar, right-click an Outlook shortcut. 
7. In the shortcut menu, choose Properties. 
8. In the Properties dialog box, select the AutoArchive tab. 
9. On the AutoArchive page, if necessary, select the Clean out 

items older than check box. 
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The Options dialog box 
appears. 

The Other page appears. 

The AutoArchive dialog box 
appears 

Section 7: Using Advanced Management Features 

10. In the Clean out items older than spin box, enter the number of 
units, and from the drop-down list, select the calendar period. 

11. If necessary, choose Browse, and in the Find Personal Folders 
dialog box, select the drive and path for the archive file. 

12. Choose OK. 

EXERCISE 

In the following exercise, you will set up AutoArchiving. 

1. Start Outlook and log on 

2. If necessary, dismiss all 
reminders 

3. Open the Tasks folder  

Reminders might appear. 

The task list appears in the 
information viewer. 

4. Make sure the Current View is 
Simple List 

5. Sort the list by Due Date, 
displaying the oldest task first 

6. From the Tools menu, choose 
Options 

7. Select the Other tab 

8. Click the AutoArchive button 

9. Make sure the AutoArchive 
every check box is selected 

10. In the AutoArchive every ... 
day(s) at startup spin box, 
enter 7 

11. Make sure the Default archive 
file: area displays the file path 
D:larchive.pst 

12. Choose OK 

13. On the Outlook Bar, right-click 
the Journal shortcut 

The shortcut menu appears. 
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14. Choose Properties The Journal Properties dialog 
box appears. 

Ii 
[727 15. Select the AutoArchive tab The AutoArchive page 

appears. 

) 
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16. In the Clean out items older 
than spin box, enter 2, and in 
the drop-down list box, make 
sure Months is selected 

11) 17. Choose Browse 
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18. In the Find Personal Folders 
dialog box, select 
D:larchive.pst 

19. Choose OK The data in the Journal older 
than two months is set to be 
archived the next time you 
open Outlook. 

r END 
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Section 7: Using Advanced Management Features 

Archiving Manually 

If you want to archive a folder immediately, you use the Archive dialog box, 
shown in Figure 7-4, which you access from the File menu. If you want to 
archive your Contacts folder, you can only archive it manually. 

Figure 7-4: The Archive Dialog Box 

L METHOD 

To archive manually: 

1. From the File menu, choose Archive. 
2. In the Archive dialog box, select the Archive this folder and all 

subfolders: option button. 
3. In the folder list, select a folder. 
4. From the Archive items older than: drop-down Date Navigator, 

select a date. 
5. Choose OK. 
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EXERCISE 

In the following exercise, you will archive manually. 

1. From the File menu, choose 	The Archive dialog box 
Archive 	 appears. 

2. Make sure the Archive this 
folder and all subfolders: 
option button is selected 

3. In the folder list, make sure the 
Tasks folder is selected 

4. From the Archive items older 
than: drop-down Date 
Navigator, select today's date 
two months ago 

5. In the Archive file text box, 
make sure Inarchive.pst 
appears 
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6. Choose OK 

7. If a message box appears that 
says, AutoArchive is ready to 
archive now. Do you want to 
have old items archived now? 
Choose No 

The items in the Tasks folder 
older than two months are 
archived. 

F END 
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Retrieving Archived Items 

Once the aging period has been reached, Outlook sends you a message at 
startup that asks if you want it to AutoArchive your files. Your Yes response 
activates archiving, and Outlook stores your old files for you. 

The easiest way to retrieve archived items is to open the archive file, 
DAarchive.pst. When  you open d:\archive.pst, Outlook will create a new 
mailbox called Archive Folders, seen in Figure 7-5, which will remain in your 
Folder List until you choose to remove it. Once the Archive Folders is in your 
Folder list you will not have to open dAarchive.pst to retrieve your archived 
items since they will automatically appear in the Archive Folders. 

Aithive Foldefà''" - 	' 
FderLi

- 	, .. 	._ 	: x 
B-terolive Foidere, 

—0 Calendar 
—G Deleted Items 
---fe I nbox 

, —4C3 Joumal 
--je. Notes 
---0 Sent Items 

1 	—. Tasks 
fe-e Outlook Today - [Mailbox - Landry, I- 
É€1--le PubEo Folders 

Figure 7-5: The Archive Folders in the Folder List 

METHOD 

To retrieve archived items: 

1. From the File menu, choose Open, Personal Folders File (.pst). 
2. Select DAarchive.pst. 
3. Choose OK. 
4. The Archive Folders appears with your archived items (folders 

and contents). 
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F--- EXERCISE 

In the following exercise, you will retrieve archived items. 

	

1. From the File menu, choose 	The Open Persona!  Folders 

	

Open, Personal Folders File 	dialog box appears, 
(.pst)... 

3. In the Open Persona/ Folders 
dialog box, select 
earchive.pst 

4. Choose OK 

	

	 The Archive Folders appears 
in the Folder List, 

F END 7 

I 
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Section 7: Using Advanced Management Features 

Creating and Applying Categories 

Assigning a category to each Outlook item helps you sort and fuad your data. 
Outlook supplies a Master Category List that you can use as is, but as your 
data entries become more task specific, you might find it helpful to add your 
own categories to the list. Your category designation can be a keyword or a 
phrase, and you  cari  apply it to related items stored in different folders. For 
example, you can keep track of all messages, tasks, appointments, and 
contacts related to a Mardi Gras celebration by assigning a category named 
Mardi Gras to each of them. You apply categories with the Categories dialog 
box, shown in Figure 7-6, and create categories with the Master Category List 
dialog box, shown in Figure 7-7. 

Figure 7-6: The Categories Dialog Box 
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Figure 7-7: The Master Category List Dialog Box 

L METHOD --I 
To create and apply categories: 

1. Create or open an appointment, task, or contact. 
2. At the bottom of the window, choose Categories. 
3. If necessary, in the Categories dialog box, choose Master 

Category List. 
4. In the Master Category List dialog box, in the New text box, 

type the new category. 
S.  Choose Add. 
6. Repeat steps 4 and 5 as necessary. 
7. Choose OK. 
8. In the Categories dialog box, select a category. 
9. Choose OK.. 

a.% 
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EXERCISE 

In the following exercise, you will create and apply categories. 

1. Open the Contacts folder 

2. Open the Association 
members subfolder 

3. Select the Felicia Montrachet 
address card, and then double-
click it 

4. At the bottom of the window, 
choose Categories 

5. Choose Master Category List 

6. In the New text box, type Food 
Festival 

7. Choose Add 

8. Choose OK 

9. Select Food Festival 

10. Choose OK 

11. Save and Close the address 
card 

12. If the Folder list is displayed, 
close it 

The general contact list 
appears in the information 
viewer. 

The Association members 
contact list appears. 

The Contact window opens. 

The Categories dialog box 
appears. 

The Master Category List 
dialog box appears. 

Food Festival appears in the 
list 

The Categories dialog box 
reappears with Food Festival 
in the Available categories list 

The new category is 
designated. 

Urti-
4 113ria 

3 
•Ird 

.1,cti I 

ç'rei 

--II 
- 

•
s--  

1-min 

r  END 
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Finding Items 

Once you receive and send numerous e-mail messages, list many contacts, and 
post lots of notes, you might fmd it difficult to remember where you stored a 
certain piece of information. For example, you might remember that you 
ordered a new stock pot, but you might forget from which supplier you placed 
your order. You use the Find and the Advanced Find windows, shown in 
Figure 7-8 and Figure 7-10, to locate your items. You can access the Find 
Pane from the Tools menu or Find button of the Standard toolbar, shown in 
Figure 7-9. You can access the Advanced Find window from the Tools menu 
or by right-clicking a folder and choosing Advanced Find from the Shortcut 
menu. The Find Pane allows you to perform From, Subject and text message 
searches while the Advanced Find window allows more search criteria. 

Figure 7-8: The Find Pane 

Figure 7-9: The Find Button 
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Figure 7-10: The Advanced Find window 

L METHOD --I 

To find items: 

1. On the toolbar, click the Find button. 
or 

1. From the Tools menu, choose Find. 
2. In the Find window, from the Look for field, enter a recipient's 

name or a keyword(s). 
3. If necessary, click the Search all text in a message check box. 
4. Click Find Now. 

To find items from the Advanced Find window. 
1. From the Tools menu, choose Advanced Find 

or 
1. Right-click a folder and choose Advanced Find 
2. From the Look for drop-down list, select an item to search. 
3. In the Advanced Find window, in the Search for the word(s) 

combo box, type the word(s) for which you want to search. 
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The Advanced Find window 
appears displaying context-
sensitive information. 

The Find window changes to 
display the Messages 
information. 

The Select Folder(s) dialog 
box appears. 

Sent Items appears in the In 
box. 

Managing Items 

4. If necessary, from the In drop-down list, select the message 
part(s) to search. 

5. If desired, in the From text box, type a name. 
6. If desired, in the Sent To text box, type a name. 
7. If desired, select the More Choices tab. 
8. On the More Choices page, if desired, choose Categories to 

select a category. 
9. Choose Find Now. 
10. If a folder list appears, double-click the desired folder to view 

its contents. 
11. Close the Find window. 
or 
11. Choose New Search, and then repeat steps 2 through 11. 

r— EXERCISE 

In the following exercise, you will find items using the Advanced Find. 

1. From the Tools menu, choose 
Advanced Find. 

2. From the Look for drop-down 
list, select Messages 

3. Choose Browse 

4. Select Sent Items, and then 
choose OK 

5. In the Search for the worri(s) 
combo box, type rice 

6. From the In drop-down list, 
select subject field and 
message body 

7. Choose Find Now 

8. Double-click the message  

One message appears at the 
bottom of the window. 

The message opens. 

9. Close the Message window 



Section 7: Using Advanced Management Features 

10. From the Look for drop-down 
list, select Contacts 

11. Choose OK 

12. Select the More Choices tab 

13. Choose Categories 

14. Select Food Festival, and then 
choose OK 

15. Choose Find Now 

16. Double-click the contact 

17. Close the Contact window 

18. Close the Find window  

A message box that says This 
will clear your current 
search appears. 

The Contacts page appears. 

The More Choices page 
appears. 

The Categories dialog box 
appears. 

The Felicia Montrachet contact 
appears at the bottom of the 
window. 

The Contact window opens. 

r  END 1 
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Managing Items 

Grouping Items 
You can group your messages or other items by any colurnn header when you 
filter your data using a Current View that displays a list. By grouping the 
items, you can view a condensed list that shows each entry only once. For 
example, suppose you regularly send your patrons a brochure advertising the 
month's specials, you send orders to three provisioners, and you drop your 
brother and your sister an occasional note. Your full message list displays the 
name of every patron who receives a brochure, every provisioner from whom 
you placed orders, and your brother and sister. But if you group your list by 
subject, then your condensed List shows only three items: brochure, order, and 
note. If you want to examine all orders, then you expand the order group to 
view every order. 

The easiest way to group your items is by using the Group By Box, which 
appears below the Folder Banner and above the colurrm headers when you 
turn on grouping. Figure 7-11 shows the Group By Box. You display the 
Group By Box by clicking the Group By Box button of the Advanced toolbar, 
shown in Figure 7-12. 

Group By 
Box 

Figure 7-11: The Group By Box Displayed below the Folder Banner 

Figure 7-12: The Group By Box Button of the Advanced toolbar 
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L METHOD --I 
To group items: 

1. On the toolbar, click the Group By Box button. 
2. Drag the desired column header to the box that says Drag a 

column header here to group by that column. 

To turn grouping off: 

1. Drag the Group By column header back to its original location. 
2. On the toolbar, click the Group By Box button. 

EXERCISE 

In the following exercise, you will group items and then turn grouping off. 

1. Open the Sent Items folder 

2. On the Advanced toolbar, 
click the Group By Box 
button 

A box that says Drag a column 
header here to group by that 
column. appears below the Folder 
Banner and above the column 
headers. 

3. Drag the To column header 
to the box 

4. Click the + to the left of 
Crawford, Susan (Sue) 

Red arrows that indicate where 
you should place the column 
header appear. The message list 
is sorted alphabetically by 
recipient, and only the recipients' 
names appear. Each name has a 
+ (plus sign) to its left. 

A list of the messages to Susan 
Crawford appears. 

5. Drag the To column header 
back to its original location 

Red arrows that indicate where 
you should place the column 
header appear. 

6. On the Advanced toolbar, 
click the Group By Box 
button 

The grouping feature is tumed off 
and the message list retums to its 
default format. 

r  END --I 
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Creating and Clearing a Filter 

Each time you use the Current View drop-down list to change your view, you 
are applying a filter to your items. When you view your tasks, for example, 
you can view the simple list that shows every task, the active tasks list that 
shows only tasks for which you are still responsible, or the completed tasks 
list. 

Suppose you want to view all tasks that are related to your activities for the 
Greater New Orleans Restaurant Association. You can create a filter of your 
own to show only those tasks that have the text Association or Assoc. in the 
subject field or the message body. 

You show or hide items using the Filter dialog box, shown in Figure 7-13. 
Each Outlook folder has a context-sensitive page in the Filter dialog box, so 
that each filter's suggested search fields are relevant to the folder in which you 
set up the filter. If you specify multiple search criteria fields, only the items 
that meet all criteria appear. If you specify multiple search criteria in only one 
field, then items that meet any of the criteria within that field appear. 

When you want to restore the Current View, you clear the filter. 

:...effletedeetre. 6 	Jligndlffl1 El 

CX 	1 	Cance- 	1 	I 	Clear- 	I 

Fdter 

Figure7-13: The Filter Dialog Box Displaying the 
Context-Sensitive Messages Page 
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L METHOD 

To create a filter: 

I. Select any folder. 
2. From the View menu, choose Current View. 
3. From the Current View submenu choose Customize Current 

View. 
4. In the View Summary dialog box, click on the Filter button. 
5. In the Search for the word(s): combo box, enter the search 

criteria. 
6. Choose OK. 

To clear a filter: 
1. From the View menu, choose Cun-ent View. 
2. From the Current View submenu choose Customize Current 

View. 
3. In the View Summary dialog box, click on the Filter button. 
4. In the Filter dialog box, click on the Clear all button. 
5. Click on OK. 

EXERCISE 

In the following exercise, you will create and clear a filter. 

1. Make sure the Sent Items 
folder is open 

2. Right-click the mouse in the 
Information Viewer and choose 
Filter 

3. On the Messages page, in the 
Search for the word(s): combo 
box, type booth 

4. From the In: drop-down list, 
select subject field and 
message body 

5. Choose OK  

The Filter dialog box appears. 

The message list displays the 
only sent item that contains the 
specified word. 
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6. Open, read, and close the 
message 

The word booth is in the body 
of the message. 

7. Right-click the mouse in the 
Information Viewer and choose 
Filter 

The Filter dialog box appears. 

8. Choose Clear All The Search for the word(s): 
combo box becomes blank. 
The In: list box displays 
subject field only 

9. Choose OK 	 All sent items appear in the 
message list. 
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Section 7: Using Advanced Management Features 

Customizing Outlook 
Outlook's default settings might not suit your needs. You can reset certain 
general options as well as options specific to each folder. You can add 
shortcuts to the Outlook Bar and move them to a convenient location. And 
you can also change your password to keep up with your security needs. 

Setting Options 

The Options dialog box has seven pages on which you can set options the way 
you want them. The Other page, shown in Figure 7-14, lets you make changes 
that apply throughout Outlook. The remaining pages let you set options for 
specific Outlook features. 

Figure 7-14: The Other Page of  the Options Dialog Box 
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L METHOD —I 
To set options: 

1. From the Tools menu, choose Options. 
2. In the Options dialog box, select a tab. 
3. On the selected page, select the desired check boxes and option 

buttons. 
4. Select the desired items from the lists. 
5. As desired, select additional tabs and repeat steps 3 and 4. 
6. Choose OK. 

1--- EXERCISE 

In the following exercise, you will set options. 

1. From the Tools menu, choose 
Options 

2. Select the Other tab 

3. In the General settings area, 
select the Empty the Deleted 
Items folder upon exiting check 
box 

4. Select the Preference tab and 
click the Calendar Options 
button. 

5. In the Calendar working hours 
area, from the Start time drop-
down list, select 9:00 AM, and 
from the End time drop-down 
list, select 5:00 PM 

6. Choose OK 

7. Select the Preference tab and 
in the Calendar area, set the 
default reminder time to 10 
minutes 

8. From the Preference page, 
click the Journal Options 
button 

The Options dialog box 
appears. 

The Other page appears. 

The Calendar Options dialog 
box appears. 

The Journal page appears. 
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9. In the For these contacts area, 
select Charles Simon and Clio 
Hebert 

10. Choose OK 	 The new options are set 

A message box that asks, Are 
you sure you want to 
permanently delete all the 
items and subfolders in the 
"Deleted Items" folder? 
appears. 

12. Choose Yes 

11. Exit from Outlook 

13. Open Outlook Outlook opens in the Calendar 
folder. The workday starts at 
9:00 A.M. and ends at 5:00 P.M. 

[ END 1 

212 



The shortcut menu appears. 

The Add to Outlook Bar dialog 
box appears. 

The  shortcut to the Association 
members contact list appears 
at the bottom of the Outlook 
Bar. 

The shortcut menu appears. 

The Add to Outlook Bar dialog 
box appears. 

Customizing Outlook 

Adding Shortcuts to the Outlook Bar 

Once you create new subfolders, you can display shortcuts to them on the 
Outlook Bar. Adding shortcuts gives you easy access to your new folders. 

L METHOD --1  

To add shortcuts to the Outlook Bar: 

1. Right-click the Outlook Bar. 
2. From the shortcut menu, choose Outlook Bar Shorcut. 
3. In the Add to Outlook Bar dialog box, in the Folder list, select 

the desired folder. 
4. Choose OK. 

r-- EXERCISE 

In the following exercise, you will add shortcuts to the Outlook Bar. 

Right-click the Outlook Bar 

2. Choose Outlook Bar Shortcut 

3. In the OUTLOOK EXERCISES 
mailbox, expand the Contacts 
folder, and then select 
Association members 

4. Choose OK 

5. Scroll to the end of the Outlook 
Bar 

6. Right-click the Outlook Bar 

7. Choose Outlook Bar Shortcut 

8. In the Contacts folder list, 
select Friends and Family 

1. 
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9. Choose OK 

10. Click the Association members 
shortcut 

11. Click the Friends and Family 
shortcut 

The shortcut to the Friends 
and Family contact list appears 
below the Association 
members shortcut on the 
Outlook Bar. 

The Association members 
contact list appears. 

The Friends and Family 
contact list appears. 

END 
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Customizing Outlook 

Moving a Shortcut on the Outlook Bar 

You can rearrange the shortcuts so that the ones you use most frequently are at 
the top of the shortcut list and appear when you open Outlook or you click one 
of the group buttons on the Outlook Bar. 

L METHOD —i 
To move a shortcut on the Outlook Bar: 

1. Drag the shortcut to the desired position between other shortcuts 
(or between the top or the bottom edge of the Outlook Bar and 
the end shortcut). 

i----- EXERCISE 

In the following exercise, you will move a shortcut on the Outlook Bar. 

A black horizontal line with 
arrowheads at its ends 
appears at each spot where 
you can position the shortcut. 

1. Drag the Association members 
shortcut to the bottom of the 
Outlook Bar 

2. Drag the Association members 
shortcut to the position below 
the Contacts shortcut 

3. Drag the Friends and Family 
shortcut to the position below 
the Association members 
shortcut 

F END  7 
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The Friends and Family 
shortcut is removed from the 
Outlook Bar. 

3. Choose Yes 

Section 7: Using Advanced Management Features 

Removing a Shortcut from the Outlook Bar 

When you no longer need a shortcut you added to the Outlook Bar, you can 
easily remove it. 

L METHOD —I 

To remove a shortcut from the Outlook Bar: 

1. Right-click the shortcut you want to remove. 
2. From the shortcut menu, choose Remove from Outlook Bar. 
3. In the Are you sure you want to remove this folder shortcut? 

message box, choose Yes. 

EXERCISE 

In the following exercise, you will remove a shortcut from the 
Outlook Bar. 

1. Right-click the Friends and 	The shortcut menu appears. 
Family shortcut 

2. Choose Remove from Outlook The message box that asks 
Bar 	 Are you sure you want to 

remove this folder shortcut? 
Appears. 

r  END 1 
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Organizing Messages 

Organizing Messages 

When your messages arrive, Outlook stores them in the Inbox. As messages 
accumulate, your Inbox can become a confusing jumble. You can manage your 
messages by storing them in folders you create and by defining rules and 
color-coding for specific types of messages. If you don't need a message once 
you read it, you can delete it, which saves space on your hard drive and 
removes clutter from your Inbox. 

Displaying and Hiding the Organize Pane 

On the Standard toolbar, clicking the Organize button splits the information 
viewer so that the Ways to Organin Inbox pane, or Organize pane, appears in 
the top pane and the message list moves to the bottom pane. You can use the 
Organize pane, shown in Figure 7-15, to create a folder, to move a message, to 
defme a rule, and to color-code messages. The Organize button is a toggle 
switch. You click it to open the Organi.ze pane and click the button again to 
close the pane. You can also use the menus and toolbar buttons for most 
organizing functions. 

Figure 7-15: The Organize pane in the Information Viewer 
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L METHOD --I 

To display or hide the Organize pane 

1. In any folder, on the Standard toolbar, click the Organize button. 

To create a folder using the Organize pane 

1. In any mail folder, display the Organize pane. 
2. hi the Organi7e pane, choose New Folder. 
3. In the Create New Folder dialog box, in the Naine  text box, 

type the name for the new folder. 
4. Choose OK. 
5. If a message box asking if you want to add the shortcut to 

your Outlook Bar appears, choose Yes or choose No. 

To move a message to a folder using the Organize pane 

1. In any mail folder, from the message list, select the message 
to move. 

2. Display the Organize pane. 
3. In the Organize pane, if necessary, in the Move message 

selected below bulleted item, from the drop-down list, select 
a folder. 

4. If necessary, in the Select Folder dialog box, select a folder 
and then choose OK. 

5. Choose Move. 
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Color-Coding Messages 

You can have Outlook color-code messages you receive from or send to a 
specific correspondent so that you can immediately identify messages that meet 
your criteria. For example, you might color-code all messages from a supplier 
blue and all messages to a client red. Color-coding affects the relevant 
messages in the folder in which you are working when you create the rule and 
all relevant messages that are subsequently moved into or received in that 
folder, if you want to color-code messages in other folders, you must define the 
color-coding in each folder. If you change your mind about a color you are 
using after you set up color-coding, you can color-code the relevant messages 
again so that they appear in another color or in black. You color-code messages 
in the Organize pane on the Using Colors page, shown in Figure 7-16. 

Figure 7-16: The Using Colors Page of the Organize pane 

L METHOD 

To color-code messages 

1. In any mail folder, from the message list, select a message to 
or from someone whose messages you want to color-code. 

2. Display the Organize pane. 
3. In the Organize pane, click the underlined text Using Colors. 
4. If necessary, in the Color messages bulleted item, from the 

first drop-down list, select an option. 
5. If necessary, in the text box, select the name or type the 

appropriate user name. 
6. If necessary, from the second drop-down list, select a color. 
7. Choose Apply Color. 
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Section 7: Using Advanced Management Features 

Using a Rule 

Rules let you manage incoming and outgoing messages by allow-ing you to 
define actions that apply to certain messages. You use the Organi7e pane to 
create a simple rule and the Rules wizard to create a detailed rule to 
automatically move, delete, forward, or flag specific types of messages. For 
example, you might create a rule to notify you whenever messages from 
your advertising manager arrive in your Inbox. If you decide you no longer 
want a rule once you create it, you can delete it. Figure 7-17 shows the 
initial Rules Wizard dialog box. 

Figure 7-17: The Rules Wizard Dialog Box with One Rule 
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Creating rules 

L METHOD —I 
To create a simple rule 

1. In any mail folder, from the message list, select a message 
to or from someone for whose messages the rule will apply. 

2. Display the Organi7e pane. 
3. If necessary, in the Organize pane, in the Create a rule to 

move new messages bulleted item, from the drop-down list, 
select an option. 

4. If necessary, in the text box, select the name and then type 
the user name. 

5. If necessary, from the into drop-down list, select a folder. 
6. Choose Create. 

To create a detailed rule 

1. In any mail folder, fi-om the Tools menu, choose Rules 
Wizard. 
or 

1. In any mail folder, display the Organize pane, and then, in 
the Organize pane, choose Rules Wizard. 

2. In the Rules Wizard dialog box, choose New. 
3. On the Rules Wizard page, from the Which type of rule do 

you want to create list, select a type. 
4. Choose Next. 
5. If necessary, in the next Rules Wizard page, in the Which 

condition(s) do you want to check list, deselect and/or 
select appropriate check box(es). 

6. If necessary, in the Rule description text box, click an 
underlined value to replace it with your limiter. 

7. If a dialog box appears, provide the requested information, 
and then choose OK. 

8. Choose Next. 
9. If necessary, on the next Rules Wizard page, in the What do 

you want to do with the message list, deselect and/or select 
the appropriate check box(es). 

10. If necessary, in the Rule description text box, click an 
underlined value to replace it with your limiter. 

11. If a dialog box appears, provide the requested information, 
and then choose OK. 

12. Choose Next. 
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13. As necessary, on the next Rules Wizard page, in the Add 
any exceptions (if necessary) area, deselect and/or select 
appropriate check box(es). 

14. Choose Next. 
15. On the next Rules Wizard page, in the Please spece a 

name for this rule text box, type a name. 
16. If desirecl, select or deselect the Turn on this rule check 

box. 
17. Choose Finish. 
18. In the Rules Wizard dialog box, to create another rule, 

choose New, and then repeat steps 3 through 17. 
or 

18. In the Rules Wizard dialog box, choose OK. 

To delete a rule 

1. If necessary, in any mail folder, from the Tools menu, 
choose Rules Wizard. 
or 

1. In any mail folder, display the Organize pane, and then, in 
the Organize pane, choose Rules Wizard. 

2. In the Rules Wizard dialog box, in the rules list, select a 
rule. 

3. Choose Delete. 
4. In the message box, choose Yes. 
5. In the Rules Wizard dialog box, choose OK. 
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Summary 

r7.7 

To open an Outlook folder in Outlook 
Today: 

1. On the Outlook Today page, point 
to a folder shortcut or a folder 
name. 

2. When the pointer becomes a hand 
and, if appropriate, the folder 
name is underlined, click the 
shortcut or name. 

To open a calendar item in Outlook 
Today: 

1. On the Outlook Today page, point 
to the calendar item. 

2. When the pointer becomes a hand 
and the item is underlined, click 
the item. 

To complete a task in Outlook Today: 

1. Click the check box to the left of 
the task. 

To ftnd a contact in Outlook Today: 

1. In the Find a Contact text box, 
type the contact name. 

2. To the right of the text box, point 
to the word go. 

3. When the pointer becomes a hand 
and the word go is underlined, 
click the word. 

4. If necessary, in the Advanced 
Find window, double-click the 
found contact record. 
or 

4. If necessary, in the Check Names 
dialog box, select the desired 
contact from the list and then 
choose Properties. 

5. As desired, close the dialog 
box(es). 

To set Outlook Today options: 

1. On the Outlook Today page, at 
the top of the page, point to the 
word Options. 

2. When the pointer becomes a hand 
and the word Options is 
underlined, click the word. 

3. As appropriate, on the Outlook 
Today Options page, clef= the 
desired options. 

4. At the top of the page, point to 
the words Back to Outlook Today. 

5. When the pointer becomes a hand 
and the words are underlined, 
click the words. 

To set up AutoArchiving: 

1. From the Tools menu, choose 
Options. 

2. In the Options dialog box, select 
the Other tab. 

3. On the Other page, click the 
AutoArchive button. 

4. In the AutoArchive every...day(s) 
at startup spin box, enter the 
number of days. 

5. Choose OK and close the Options 
dialog box. 

6. On the Outlook Bar, right-click 
an Outlook shortcut 

7. In the shortcut menu, choose 
Properties. 

8. In the Properties dialog box, 
select the AutoArchive tab. 

9. On the AutoArchive page, if 
necessary, select the Clean out 
items older than check box. 

10.In the Clean out items older than 
spin box, enter the number of 
units, and from the drop-down 
list, select the calendar period. 

cam 
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11 .If  necessary, choose Browse, and 
in the Find Personal Folders 
dialog box, select the drive and 
path for the archive file. 

12.Choose OK. 

To archive manually: 

1. From the File menu, choose 
Archive. 

2. In the Archive dialog box, select 
the Archive this folder and all 
subfolders: option button. 

3. In the folder list, select a folder. 
4. From the Archive items older 

than: drop-down Date Navigator, 
select a date. 

5. Choose OK. 

To retrieve archived items: 

1. From the File menu, choose 
Open, Personal Folders File 
(.pst). 

2. Select DAarchive.pst. 
3. Choose OK. 
4. The Archive Folders appears with 

your archived items (folders and 
contents). 

To create and apply categories: 

1. Create or open an appointment, 
task, or contact. 

2. At the bottom of the window, 
choose Categories. 

3. If necessary, in the Categories 
dialog box, choose Master 
Category List. 

4. In the Master Category List 
dialog box, in the New text box, 
type the new category. 

S.  Choose Add. 
6. Repeat steps 4 and 5 as 

necessary. 
7. Choose OK. 
8. In the Categories dialog box, 

select a category. 
9. Choose OK.  

To find items: 

1. On the toolbar, click the Find 
button. 
Or 

1. From the Tools menu, choose 
Find. 

2. In the Find window, from the 
Look for field, enter a recipient's 
naine or a keyword(s). 

3. If necessary, click the Search all 
text in a message check box. 

4. Click Find Now. 

To use the Advanced Find. 
1. From the Tools menu, choose 

Advanced Find 
or 
1. Right-click a folder and choose 

Advanced Find 
2. From the Look for drop-down 

list, select an item to search. 
3. In the Advanced ced Find window, 

in the Search for the word(s) 
combo box, type the word(s) for 
which you want to search. 

4. If necessary, from the In drop-
down list, select the message 
part(s) to search. 

5. If desired, in the From text box, 
type a name. 

6. If desired, in the Sent To text 
box, type a name. 

7. If desired, select the More 
Choices tab. 

8. On the More Choices page, if 
desired, choose Categories to 
select a category. 

9. Choose Find Now. 
10. If a folder list appears, double-

click the desired folder to view 
its contents. 

11. Close the Find window. 
or 
11. Choose New Search, and then 

repeat steps 2 through 11. 
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Summary 

To group items: 

1. On the toolbar, click the Group 
By Box button. 

2. Drag the desired column header 
to the box that says Drag a 
column header here to group by 
that column. 

To add shortcuts to the Outlook Bar: 

0E1=11 

1. Right-click the Outlook Bar. 
2. From the shortcut menu, choose 

Outlook Bar Shorcut 
3. In the Add to Outlook Bar dialog 

box, in the Folder list, select the 
desired folder. 

4. Choose OK. 

To move a shortcut on the Outlook 
Bar: 

Là1=1111 

To turn grouping off: 

1. Drag the Group By column 
header back to its original 
location. 

2. On the toolbar, click the Group 
By Box button. 

To create a Mter: 

1. Drag the shortcut to the desired 
position between other shortcuts 
(or between the top or the bottom 
edge of the Outlook Bar and the 
end shortcut). 

1. Select any folder. 
2. Right click the mouse in the 

Information Viewer. 
3. Select Filter. 
4. In the Search for the word(s): 

combo box, enter the search 
criteria. 

5. Choose OK. 

To remove a shortcut from the 
Outlook Bar: 

To clear a filter: 

1. Right-click the shortcut you want 
to remove. 

2. From the shortcut menu, choose 
Remove from Outlook Bar. 

3. In the Are you sure you want to 
remove this folder shortcut? 
message box, choose Yes. 

1. Right-click the Information 
Viewer. 

2. Select Filter. 
3. In the Filter dialog box, choose 

Clear all. 

To create a folder using the Organize 
pane: 

1. In any mail folder, display the 
Organize pane. 

2. In the Organize pane, choose 
New Folder. 

3. In the Create New Folder dialog 
box, in the Name text box, type 
the name for the new subfolder. 

4. Choose OK. 
5. If a message box aslcing if you 

want to add the shortcut to your 
Outlook Bar appears, choose Yes 
or choose No. 

To set options: 

1. From the Tools menu, choose 
Options. 

2. In the Options dialog box, select 
a tab. 

3. On the selected page, select the 
desired check boxes and option 
buttons. 

4. Select the desired items from 
lists. 

5. As desired, select additional tabs 
and repeat steps 2 through 4. 

6. Choose OK. 
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To move a message to a folder using 
the Organize pane: 

1. In any mail folder, from the 
message list, select the message 
to move. 

2. Display the Organize pane. 
3. In the Organize pane, if 

necessary, in the Move message 
selected below bulleted item, 
from the drop-down list, select a 
folder. 

4. If necessary, in the Select Folder 
dialog box, select a folder and 
then choose OK. 

5. Choose Move. 

EOM 

3. If necessary, in the Organize 
pane, in the Create a rule to 
move new messages bulleted 
item, from the drop-down list, 
select an option. 

4. If necessary, in the text box, 
select the name and then type 
the user name. 

5. If necessary, from the into 
drop-down list, select a folder. 

6. Choose Create. 

To create a detailed rule: 
map 
cm' 
ors 

To color-code messages: 

1. In any mail folder, from the 
message list, select a message 
to or from someone whose 
messages you want to color-
code. 

2. Display the Organize pane. 
3. In the Organize pane, click the 

underlined text Using Colors. 
4. If necessary, in the Color 

messages bulleted item, from 
the first drop-down list, select 
an option. 

5. If necessary, in the text box, 
select the name and then type 
the appropriate user name 

6. If necessary, from the second 
drop-down list, select a color. 

7. Choose Apply Color. 

FiESM 

felaiEn 

To create a simple rule: 

1. In any mail folder, from the 
message list, select a message 
to or from someone for whose 
messages the rule will apply. 

2. Display the Organize pane. 

1. In any mail folder, from the 
Tools menu, choose Rules 
Wizard. 
or 

1. In any mail folder, display the 
Organize pane, and then, in the 
Organize pane, choose Rules 
Wizard. 

2. In the Rules Wizard dialog 
box, choose New. 

3. On the Rules Wizard page, 
fi-om the Which type of rule do 
you want to create list, select a 
type. 

4. Choose Next. 
5. If necessary, in the next Rules 

Wizard page, in the Which 
condition (s) do you want to 
check list, deselect and/or 
select appropriate check 
box(es). 

6. If necessary, in the Rule 
description text box, click an 
underlined value to replace it 
with your limiter. 

7. If necessary, in the [limiter] 
dialog box, provide the 
requested information, and 
then choose OK. 

8. Choose Next. 



To delete a rule: 

1. If necessary, in any mail folder, 
from the Tools menu, choose 
Rules Wizard. 

or 
1. In any mail folder, display the 

Organize pane, and then, in the 
Organize pane, choose Rules 
Wizard. 

2. In the Rules Wizard dialog 
box, in the rules list, select a 
rule. 

3. Choose Delete. 
4. In the message box, choose 

Yes. 
5. In the Rules Wizard dialog 

box, choose OK. 

Summary 

9. If necessary, on the next 
Rules Wizard page, in the 
What do you want to do with 
the message list, deselect 
and/or select the appropriate 
check box(es). 

10.If necessary, in the Rule 
description text box, click an 
underlined value to replace it 
with your limiter. 

11 .If  necessary, in the [limiter] 
dialog box, provide the 
requested information, and 
then choose OK. 

12.Choose Next. 
13.As necessary, on the next 

Rules Wizard page, in the 
Add any exceptions (if 
necessary) area, deselect 
and/or select appropriate 
check box(es). 

14. Choose Next. 
15. On the next Rules Wizard 

page, in the Please specifi,  a 
name for this rule text box, 
type a name. 

16.If desired, select or deselect 
the Turn on this rule check 
box. 

17. Choose Finish. 
18. In the Rules Wizard dialog 

box, to create another rule, 
choose New, and then repeat 
steps 3 through 17. 
or 

18. In the Rules Wizard dialog 
box, choose OK. 
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Self-Check Exercise 

1. Set Outlook to AutoArchive every 14 days. Set the Journal aging period 
to six months. Archive all items in your Calendar that are more than one 
month old. Then retrieve your archived items. 

2. Create a category called Wholesalers and apply it to the contact Jeff 
Thompson. 

3. Find, open, read, and then close the sent Invoice message and the sent 
message that mentions Mardi Gras. 

4. Group your tasks by due date. Display all tasks with no due date. Then 
ungroup your tasks 

5. Create a filter to view only those tasks that have Food Festival in the 
subject or notes fields. Then clear the filter. 

6. Reset your options so that Outlook no longer empties the Deleted Items 
folder upon exiting. Set Outlook to start up in the Inbox. Set the 
Calendar to show your work day starting at 8:30 AM and ending at 
5:30 PM. Set the Appointment Reminder default to 15 minutes. 

7. On the Outlook Bar, create a new shortcut to your Inbox Business folder 
and move the shortcut to just below the Inbox shortmit. 

8. Delete the Association members shortcut and the Business shortcut from 
the Outlook Bar. 

9. Exit Outlook. 
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Optimizing Mail Functions 

• Using Address Books 
• Worlcing with Personal 

Distribution Lists 
• Using Message Features 



Section 8: Optimizing Mail Functions 

Each name in bold in an address book indicates a group address, a unique 
name that references a group of Outlook users. When you address mail to a 
group, each individual in the group receives the message. If group narnes 
appear in the Postoffice Address List, these names have been created by your 
system administrator. You can use the group addresses, but you cannot change 
who is in the group. 

Several buttons in the Select Names dialog box help you use your address 
books more effectively. Table 8-1 describes these buttons. 

WEI= 

111MMII: 
Button 	 Function 

New 	Click to enter a new name and address for a recipient. You 
can also add the names you create to your Personal Address 
Book. 

Properties 	Select a name in the left or the right pane, and then click this 
button to display information about that recipient. 

Find 	Click to search one or more address books for names. 

Send Options 	Specify options for sending a message to the selected name. 
The options vary based on the selected address book. 

Table 8-1: Buttons in the Select Names Dialog Box 



Using Address Books 

Adding a Name to Your Personal Address Book 
If you frequently send e-mail to the same people, you can add them to your 
Personal Address Book. You can easily add names and their associated 
addresses from other address books, or you can add a name and address for 
someone to whom you regularly send e-mail on the Internet. If you want to 
add more information about people to whom you send e-mail frequently, you 
might prefer to list them in your contact list, but if you only want to keep track 
of a name and address, it is simpler to list them in your Personal Address 
Book. 

Inez 
You add names to your Personal Address Book with the Select Names dialog 
box. You can also add the names without opening a new message by using the 
Address Book window, shown in Figure 8-2. You open this window by 
clicking the Address Book button on the Standard toolbar. 
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Figure 8-2: The Address Book TVindow 

The Address Book window toolbar buttons, described in Table 8-2, let you 
perform your address book management tasks quickly and easily. 
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Button 	Name 	 Function 

New Entry 	Displays the New Entry dialog box for entering 
new user names. 

IV 	Find Items 	Displays the Find dialog box, which helps you 
locate names. 

ei l 	Properties 	Displays the Properties dialog box, which gives 
you information about the user address and lets 
you add information about the user. 

I 	x I 	Delete 	Deletes the selected user name from your 
Personal Address Book. 

Add to 	Adds the selected user name to your Personal 
Personal 	Address Book. 
Address Book 

— 	New Message 	Opens a new message window. 

11 -91 	Help 	 Accesses help on Outlook functions, menu 
commands, dialog boxes, and parts of the 
window. 	 . 

Table 8-2: Address Book Window Toolbar Buttons 

When adding a new name to your Personal Address Book, use the New Entry 
dialog box, shown in Figure 8-3, to select the type of entry, such  as  Microsoft 
Mail Address or Internet Address. 

Hew Entry 

Select the entry type: 

R4 scrosott  Mail 	  
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Other Address 
Personal  Dion Ut  
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Figure 8-3: The New Entry Dialog Box 
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Using Address Books 

L METHOD 1  

To add a name to your Personal Address Book: 

Inbox method 

1. On the Standard toolbar, click the Address Book button. 
2. If necessary, in the Address Book window, from the Show 

Names from the: drop-down list, select the address book from 
which you want to add a name. 

3. From the address list, select the name(s) you want to add to 
your Personal Address Book. 

4. On the Address Book window toolbar, click the Add to Personal 
Address Book button. 

5. Close the Address Book window. 

New message method 

1. On the New message toolbar, click the Address Book button. 
2. If necessary, in the Select Names dialog box, from the Show 

Names from the: drop-down list, select the address book from 
which you want to add a name. 

3. From the address list, select the name(s) you want to add to 
your Personal Address Book. 

4. Choose Properties. 
5. In the Properties dialog box, choose Personal Address Book. 
6. Choose OK. 
7. Close the Address Book window. 

r-- EXERCISE 	  

In the following exercise, you will add names from another address book 
to your Personal Address Book. 

1. On the Standard toolbar, click 	The Address Book window 
the Address Book button 	appears. 

2. Select an address book from 
the Show Names from the: 
drop-down list 

3. From the address list, select 
your partner's name 
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4. On the Address Book window 
toolbar, click the Add to 
Personal Address Book button 

The name is added to your 
Personal Address Book. 

5. Press and hold CTRL, select all 
remaining students, and then 
release CTRL 

6. On the address Book window 
toolbar, click the Add to 
Personal Address Book button 

The names are added to your 
Persona!  Address Book 

sew 

riff" 

Ere 



ilein" 1 Phone Nurrben Norez: SMTP Gererai 

D.izrie name 	I 
E-mai addre.x 	1 

r, Alyeris send to tlis rectient  n Microt.oft Exchange rich text format 

Send Options._ 

_ memo El  

I OK 

Using Address Books 

Creating an Alias in Your Personal Address Book 

When you want to add a name and its associated address to your Personal 
Address Book and that name and address are not listed in any of your 
postoffice address lists or in your contact list, you create an alias to represent 
that name and address. Choose a name that you can remember easily that is 
nonetheless distinctive from the other names in your address books. When you 
click the New Entry button on the Address Book window toolbar, the New 
Entry dialog box appears and lets you choose the entry type: Microsoft Mail 
Address, Internet Address, or X400 Address. You enter the alias in a New 
Address Properties dialog box, such as the one shown in Figure 8-4 for an 
Internet address. 

Figure 8-4: The New Internet Address Properties Dialog Box 

L METHOD —I 
To create an alias in your Personal Address Book: 

1. On the Standard toolbar, click the Address Book button. 
2. On the Address Book window toolbar, click the New Entry 

button. 
3. In the New Entry dialog box, select the entry type. 
4. Choose OK. 
5. On the STMP-General page of the New Address Properties 

dialog box, in the Display Name text box, type the name you 
want to use to represent this address. 
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EXERCISE 	  

In the following exercise, you will create an alias in your Personal Address 
Book. 

1. Make sure the Address Book 
window is still open 

The New Address Properties 
dialog box is closed and the 
new name is added to your 
Personal Address Book. 

The names you just selected 
appear in the name list 

111:11eall 
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6. In the E-Mail Address text box, type the e-mail address. 
7. Choose OK. 

Note: In network setups, you can only add addresses to your 
Personal Address Book. The system administrator adds names to 
the other address books. 

2. On the Address Book window 
toolbar, click the New Entry appears. 
button 

3. Select Internet Address 

The New Entry dialog box 

4. Choose OK 

5. On the SMTP-General page of 
the New Internet Address 
Properties dialog box, type a 
name in the Display Name field 

6. Type the Internet e-mail 
address in the E-Mail Address 
field 

7. Choose OK 

8. From the Show Names from 
the: drop-down list, select 
Personal Address Book 

9. Close the Address Book 
window 

The New Address Properties 
dialog box for the entry 
appears. 

[-END]  
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Using Address Books 

Selecting a Default Address Book 

You might be a member of a large network that has many smaller networks, 
each of which has its own address book. You can select the default address 
book to display by using the Addressing page of the Services dialog box, 
shown in Figure 8-5. In addition, if you find that you primarily send messages 
to people listed in a certain address book, you can change the order in which 
Outlook searches the address books for addresses so that Outlook checks your 
most used address book first. 

Figure 8-5: The Addressing Page of the Services Dialog Box 

L METHOD 

To select a default address book: 

1. From the Tools menu, choose Services. 
2. In the Services dialog box, select the Addressing tab. 
3. On the Addressing page, from the Show this address list  first:  

drop-down list, select the desired address book. 
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4. If desired, from the When sending mail, check names using 
these address lists in the following order: list, select an address 
book, and then choose the up or the down arrow to change the 
priority order. 

5. Choose OK. 
6. Exit from and restart Outlook. 

r- --  EXERCISE 

In the following exercise, you will select your Personal Address Book as 
your default address book. 

1. From the Tools menu, choose 
Services 

2. Select the Addressing tab 

3. From the Show this address list 
first: drop-down list, select 
Personal Address Book 

4. Choose OK 

5. Exit from and restart Outlook 

6. On the Standard toolbar, click 
the Address Book button 

The Services dialog box 
appears. 

The Addressing page of the 
Services dialog box appears. 

Your default address book is 
selected. 

Your Personal Address Book 
is now the default address 
book. 

The Address Book window 
appears.  The  Show Names 
from the: drop-down list 
displays  Persona!  Address 
Book. 

E  END 1 



Working with Personal Distribution Lists 

Working with Personal Distribution Lists 
In addition to the group addresses created by your postoffice administrator, 
you can create your own personal distribution lists. For example, if you often 
send messages to members of a project team or committee, you might want to 
create a group to save you time and trouble. Once you've created a personal 
distribution list, you  can  use it just as you use any other name to address a 
message. It is easy to add and delete members. 

Creating a Personal Distribution List 
It= You create a new personal distribution list similarly to creating and adding 

names to a Personal Address Book. The New Entry dialog box gives you 
access to the New Personal Distribution List Properties dialog box, shown in 
Figure 8-6. From here, you add members to your list. Cel 
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Figure 8-6: The New Personal Distribution List Properties Dialog Box 
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L METHOD --I 
To create a personal distribution list: 

1. On the Standard toolbar, click the Address Book button. 
2. On the Address Book window toolbar, click the New Entry 

button. 
3. In the New Entry dialog box, from the Select entry type list, 

select Personal Distribution List, and then choose OK. 
4. In the New Personal Distribution List Properties dialog box, in 

the Naine  text box, type a name for your personal distribution 
list. 

5. Choose Add/Remove Members. 
6. Select the names. 
7. Choose Members. 
8. Choose OK. 
9. In the New Personal Distribution List Properties dialog box, 

choose OK. 
10. Close the Address Book window. 

EXERCISE 

In the following exercise, you will create a personal distribution list. 

1. Make sure the Address Book 
window is open 

2. On the Address Book window 	The New Entry dialog box 
toolbar, click the New Entry 	appears. 
button. 

3. From the Select the ently type: The New Personal Distribution 
list, select Personal 	 List Properties dialog box 
Distribution List, and then 	appears. 
choose OK 

4. In the Name te)d box, type 
Classmates 

5. Choose Add/Remove 
Members 

The Edit Members of 
Classmates dialog box 
appears. 
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Working with Personal Distribution Lists 

6. Press and hold CTRL, select 
your mail partner and three 
other classmates, and then 
release CTRL 

The members are selected. 

7. Choose Members The names appear in the 
personal distribution list pane. 

8. Choose OK The names are added to the 
pane in the New Personal 
Distribution List Properties 
dialog box. 

9. Choose OK Your personal distribution list 
name appears in your 
Personal Address Book name 
list in bold. 



Section 8: Optimizing Mail Functions 

Editing a Personal Distribution List 

You might want to add members to a personal distribution list, or you might 
need to remove existing members. To edit your lists, open the List Properties 
dialog box. 

L METHOD —I 

To add personal distribution list members: 

1. On the Standard toolbar, click the Address Book button. 
2. If necessary, in the Address Book window, from the Show 

Names fi-om the: drop-down list, select Personal Address Book. 
3. In the address list, double-click the name of the personal 

distribution list to which you want to add members. 
4. In the List Properties dialog box, choose Add/Remove 

Members. 
5. In the Edit Members dialog box, select the name(s) you want to 

add to the group. 
6. Choose Members. 
7. Choose OK. 
8. In the List Properties dialog box, choose OK. 

To remove personal distribution list members: 

1. On the Standard toolbar, click the Address Book button. 
2. If necessary, in the Address Book window, from the Show 

Names fi-om the: drop-down list, select Personal Address Book. 
3. In the address list, double-click the name of the personal 

distribution list from which you want to remove members. 
4. In the List Properties dialog box, choose Add/Remove 

Members. 
5. In the Edit Members dialog box, select the name(s) you want to 

remove from the group. 
6. Press DELETE 

7. Choose OK. 
8. In the List Properties dialog box, choose OK. 
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Working with Personal Distribution Lists 

EMERCISE 

In the following exercise, you will edit a personal distribution list. 

1. Make sure the Address Book 
window is open 

2. In the Select Names from the 
drop-down list, make sure 
Personal Address Book is 
displayed 

3. Double-click the personal 
distribution list name 
Classmates 

4. Choose Add/Remove 
Members 

5. In the address list, select 
another student's name 

The Classmates Properties 
dialog box appears. 

The Edit Members of 
Classmates dialog box 
appears. 

6. Choose Members 	 The student's name is added 
to the group. 

7. In the personal distribution list, 
select any name 

8. Press DELETE 	 The name is removed. 

9. Choose OK 	 The changes are accepted. 

10. Choose OK 	 The Classmates Properties 
dialog box is closed. 

r  END 
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Deleting a Personal Distribution List 
You should keep your Personal Address Book a manageable size so that you can 
easily fmd entries. When you complete a project, for example, you no longer 
need a personal distribution list for that project, so you should delete the list. 

L METHOD --I 
To delete a personal  distribution list: 

1. On the Standard toolbar, click the Address Book button. 
2. From the Show Names in the: drop-down list, select Personal 

Address Book. 
3. In your Personal Address Book, select the personal distribution 

list you want to delete. 
4. Press DELETE 
5. In the message box that asks, Are you sure that you want to 

permanently remove the selected user(s) from this Address 
Book? choose Yes. 

r--- EXERCISE 

In the following exercise, you will delete a personal distribution list. 

1. Make sure the Address Book 
window is open 

2. In the Select Names from the: 
drop-down list, make sure 
Personal Address Book is 
displayed 

3. Select the personal distribution 
list name Classmates 

4. Press DELETE 

5. Choose Yes 

6. Close the Address Book 
window 

The Classmates Properties 
dialog box appears. 

A message box that asks Are 
you sure that you want to 
permanently remove the 
selected user(s) from this 
Address Book? Appears. 

The personal distribution list is 
deleted. 

[-END  i 
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Using Message Features 

Using Message Features 
Outlook includes numerous message features that make your e-mail 

without sending it so that you  cari work on it later. Outlook provides spelling 
operations simple. For example, Outlook lets you save and close a message 

options that speed up your text entry and automatically make corrections. If 
you are asking message recipients for their opinions, Outlook lets you include 
voting buttons in your message that indicate acceptance or rejection and 
automatically return the responses to you. Outlook also lets you set such 
message options as importance and return receipt, and lets you attach files to 
your messages. Should you realize that you inadvertently sent a message to 
the wrong recipient, Outlook lets you recall your message if the recipient 
hasn't opened it. If you receive a message for which you must take follow-up 
action, Outlook provides a means to flag the message for later attention. 

Saving and Closing a Message without Sending It 

If you need to end your work session but have not completed a message or do 
not wish to send it yet, you can save the message without sending it. If you try 
to close an unsent message, a message box wams you to save your work 
before closing. The unsent message then appears in the message list in your 
Draft folder. You can open the saved message and resume work on it or send 
it at any time. 

L METHOD ---I 
To save and close a message without sending it: 

1. In the New Message window, on the toolbar, click the Save 
button. 

2. Close the window. 

To send a saved message: 

1. Open the Drafts folder. 
2. Open the saved message. 
3. Complete and send the message. 

) 

) 

) 

) 

) 

) 

9 
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EXERCISE 

In the following exercise, you will save and close a message without 
sending it. 

1. Create a new message 

2. Address the message to your 
e-mail partner 

3. In the Subject text box, type 
Mardi Gras Plans 

4. In the New Message window 
message area, type The 
attached file lists our 
restaurant's plans for Mardi 
Gras. 

5. On the toolbar, click the Save 
button 

6. Close the New Message 
window 

7. Open the Drafts folder 

8. Open the Mardi Gras Plans 
message 

9. Complete and send the 
message 

The message subject appears 
in the message list 

The saved message appears 
in the message list 

The message is now stored in 
the Sent Items folder 

r  END 
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Using Message Features 

Setting Spelling Options 

You should write your messages as carefully as you write other documents. 
Careless spelling and grammar errors reflect poorly on you. You set spelling 
options in the Spelling Tab of the Options dialog box, shown in Figure 8-7. 

Figure 8-7: The Spelling Page of the Options Dialog Box 
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L METHOD —I 
To set spelling options: 

1. From the Tools menu, choose Options. 
2. In the Options dialog box, select the Spelling tab. 
3. On the Spelling tab, select the check boxes for the desired 

feature. 
4. Choose OK. 

1--- EXERCISE 

In the following exercise, you will set spelling options. 

1. From the Tools menu, choose 	The Options dialog box 
Options 	 appears. 

2. Select the Spelling tab 	 The Spelling page appears. 

3. If necessary, select the 
following check boxes: 

Always suggest replacements 
for misspelled words 

Always check spelling before 
sending 

Ignore words in UPPERCASE 

Ignore words with numbers 

Ignore original message text in 
reply or forward 

4. Choose OK The Options dialog box closes. 

r  END —1 
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Using Message Features 

Setting and Using Message Options 

When you Imow the message you are sending is especially important (or, 
likewise, unimportant) you can mark it to show the recipient its urgency. If 
you set the importance of a message to high, the recipient sees a red 
exclamation point in the message list. If you set the importance to low, the 
recipient sees a blue down arrow. If the importance is normal, the recipient 
sees no icon beside the message in the message list. 

When you request a delivery receipt or a read receipt, Outlook automatically 
sends you a receipt that tells you when your message was delivered or was 
read. 

You use the Message Options dialog box shown in Figure 8-8, to set options 
for the current message only. You must click the Options button on the 
Untitled Message window's toolbar to display it. Table 8-3 summarizes the 
options. 

Message Options illEtiE=21 •-reeemfflgufflums 

Figure 8-8: The Message Options Dialog Box 
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Option 	Name 	 Function 
type 

Message 	Importance 	Sets the message importance to high or 
settings 	 low. 

Message 	Sensitivity 	Sets the message sensitivity to personal, 
settings 	 private, or confidential. 

Voting and 	Use voting 	Adds labeled buttons to your message so 
Tracking 	buttons 	 recipients can respond to a proposal with a 
Options 	 click of the button. 

Voting and 	Tell me when this 	Requests a receipt when the message has 
Tracking 	message has 	been delivered. 
Options 	been delivered 

Voting and 	Tell me when this 	Requests a receipt when the recipient 
Tracking 	message has 	opens the message. 
Options 	been read 

Delivery 	Have replies sent 	Assigns someone else to receive the replies 
Options 	to 	 to a message. 

Delivery 	Save sent 	Saves a copy of the sent message in the 
Options 	message to 	specified folder. 

Delivery 	Do not deliver 	Sets the earliest possible delivery date. 
Options 	before 

Delivery 	Expires after 	Deletes a message if it is not delivered by 
Options 	 the specified date. 

Table 8-3: Message Options 

L METHOD 

To set the importance for a message: 

1. On the New Message window toolbar, click the Importance: 
High button or the Importance Low button. 
or 

1. In the Options dialog box, in the Message settings area, from 
the Importance drop-down list, select Low, Normal, or High. 

To set General, Delivery, and Tracking options for a message: 

1. In the Options dialog box, in the Delivery options area, select 
the desired options check boxes. 

2. Where necessary, select details from the drop-down list. 
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EJCERC1SE 

10. When you receive the Sub for 
me? message, check its 
importance 

A red exclamation point 
appears in the Priority column. 

11. Open and read the message 

12. VVhen you receive the Read 
Report message indicating 
receipt of your message, open 
it, read it, and then close it e...., ) , , ,1) 

telf,)), 

r  END ---i 
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Using Message Features 

In the following exercise, you will set and use message options. 

1. Create a new message and 
address it to your partner 

2. On the toolbar, click the 
Importance: High button 

3. In the Subject field, type Sub 
for me? 

4. In the message area, type I'd 
like to go away this 
weekend. Can you sub for 
me? and then press ENTER 
twice 

5. Type your initials, using 	Your name appears. 
lowercase letters, and then 
press SPACEBAR 

6. Click the Options button 	The Options dialog box 
appears. 

7. In the Message settings area, 
make sure the Importance 
drop-down list box displays 
High 

8. In the Voting and Tracking 
options area, select the Tell 
me when this message has 
been read check box and 
choose Close 

9. Send the message 



Section 8: Optimizing Mail Functions 

Using Voting Buttons 

An additional Voting and Tracking option available in a new message is using 
voting buttons. When you use voting buttons, you make it easy for the 
recipient to respond to a question. The recipient sees the buttons in the new 
message above the tabs. When the recipient chooses a button, Outlook 
displays a message box like those shown in Figure 8-9 that asks the recipient 
to confirm the response. The recipient can select the Edit the response before 
sending option button to include a message with the vote. Once the recipient 
chooses OK, Outlook automatically sends a message to the sender that shows 
the recipient's response. 

Micros:at Out1oo1.1 Idicrosoft Outlook .' 

You have chosen io repcnd R eject 

e 'Send the response nov4 

fdt the response bef or.  e serdng 

Figure 8-9: Voting Message Boxes 

L METHOD —I 

To attach voting buttons to a message: 

1. In the Options dialog box, select the Use voting buttons check 
box. 

2. From the Use voting buttons drop-down list, select 
Approve;Reject, Yes;No, or Yes;No;Maybe. 

To respond to a voting message: 

1. In the voting message, choose a response button. 
2. In the message box, select an option button. 
3. Choose OK. 
4. If editing the message, in the text box, type your message, and 

then send it. 



The Options page appears. 

Approve;Reject appears in the 
drop-down list box. 

The Approve and Reject voting 
buttons appear above the tabs. 

A message box appears. 

Outlook automatically sends 
your vote to the sender and 
closes the message. 

Using Message Features 

1--- EICERCISE 

In the following exercise, you will use voting buttons. 

1. Create a new message and 
address it to your partner 

2. In the Subject field, type Band 

3. In the message area, type I 
think Elena should hire a 
band. What's your opinion? 

4. Click the Options button 

5. Select the Use voting buttons 
check box 

6. Click the Use voting buttons 
drop-down arrow to see the 
other button options, select 
Approve;Reject and choose 
Close. 

7. Send the message 

8. If necessary, check for new 
mail 

9. Open and read the Band 
message from your partner 

10. Choose a voting button 

11. Choose OK 

12. When you receive the 
message indicating your 
partner's vote, open it, read it, 
and then close it 

r  END --1 
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Section 8: Optimizing Mail Functions 

Flagging a Message 

When you send a message, you can flag it for follow-up, for the recipient's 
information, for forwarding, for a call, or for other actions. You can also flag 
messages you receive. You use the Flag for Follow-up dialog box, shown in 
Figure 8-10, to attach the flag. You can even indicate the date by which you or 
the recipient should act. 

flan  itlt FOMOUIP Up 

Figure 8-10: The Flag for Follow-Up Dialog Box 

The message list displays a flag on the message line to indicate that a message 
is flagged. When you open the message, you see an information area below 
the tabs that displays the flagged message, as shown in the sample message in 
Figure 8-11. 

Figure 8-11: A Sample Flagged Message Showing the Information Area 
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Using Message Features 

L METHOD 

To flag a message: 

1. On the Message window toolbar, click the Message Flag button. 
2. In the Flag Message dialog box, click the Flag drop-down list 

arrow, and then select the flag. 
3. In the By combo box, enter the due date. 
4. Choose OK. 

r---- EXERCISE 

In the following exercise, you will flag messages. 

1. Open the Sent Items folder 

2. Open the Mardi Gras 
message 

3. On the Message toolbar, click 	The Flag Message dialog box 
the Message Flag button 	appears. 

4. Click the Flag drop-down list 
arrow to see other flag options, 
and then accept Follow up 

5. In the Reminder combo box, 
type tomorrow 

6. Choose OK The information area below the 
tabs displays tomorrow's date 
in the flagged message. 

7. Close the message 	 The tlag appears beside the 
subject in the message list 

r  END 
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Section 8: Optimizing Mail Functions 

Recalling a Message 

You might send an e-mail message and then decide you want it back. You can 
recall a message any time before the recipient opens it, even if it has been 
delivered. There is, however, a time lag between when you recall a message 
and when it is successfully recalled. You recall a message using the Recall 
This Message dialog box, shown in Figure 8-12. You access this dialog box 
from the message's Actions menu. 

Figure 8-12: The Recall This Message Dialog Box 

When you choose the Delete unread copies of this message option button, the 
message stays in your Sent Items folder but contains an information area that 
says, You attempted to recall this message on [date and time of attempt J. 
When you choose the Delete unread copies and replace with a new message 
option button, the message contains an information area that says, This 
message has not been sent. Once the recall is successful, you receive a 
message in your Inbox that informs you that your message was recalled. 

When you recall a message that has been de livered, the recipient might see the 
original message in his or her Inbox and a second message that says the sender 
attempted to recall the message. If the recipient cooperates and does not open 
the message, both messages disappear from the Inbox shortly thereafter. 
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5. Make sure the Te// me if recall 
succeeds or fails for each 
recipient check box is selected 

6. Choose OK The message is recalled and is 
open. An information area that 
says This message has not 
been sent appears below the 
tabs. 

7. Close the message 

F END 
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Using Message Features 

L METHOD —I 

To recall a message: 

1. From the Sent Items folder message list, open the message. 
2. From the Actions menu, choose Recall This Message. 
3. In the Recall This Message dialog box, select an option button. 
4. Choose OK. 

EXERCISE 

In the following exercise, you will send and then recall a message. 

1. Prepare and send a message 
to your e-mail partner with the 
subject Mardi Gras Plans 

2. From your Sent Items folder 
message list, open the Mardi 
Gras Plans  message 

The Recall This Message 
dialog box appears. 

3. From the Actions menu, 
choose Recall This Message. 

4. Select the Delete unread 
copies and replace with a new 
message option button 
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Attaching a File 

Outlook is an excellent tool for sending simple text messages. It is also great 
for sending complex information or different types of files that you include as 
attachments. 

You use the Insert File button in the New Message window to attach a file to a 
message. An attachment is most frequently a data file created by a Windows 
application. For example, you might want to create a map providing directions 
to a meeting location in a graphics application and attach the file to a meeting 
invitation message. You use the Insert File dialog box, shown in Figure 8-13, 
to select and attach files to a message. 

Figure 8-13: The Insert File Dialog Box 

You can frequently identify the type of file attached to a message by 
examining the attachment icon in the message. For example, Figure 8-14 
shows a message containing a text attaclunent and a graphic attachment. You 
might also want to include information in the message text about the kind of 
file the attaclunent is, in case the recipient does not have access to the 
application needed to open and use the attachment. 

Although you can attach any type and number of files to a message, not all 
e-mail services can deliver messages with large attachments or with multiple 
attachments, so you might want to send only one large attachment per 
message. 
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Using Message Features 

Figure 8-14: A Sample Message with Attachments 

L METHOD --I 

To attach a file: 

1. In a new message, position the insertion point in the message 
area where you want to attach the file. 

2. On the toolbar, click the Insert File button. 
or 

2. From the Insert menu, choose File. 
3. In the Insert File dialog box, select the desired drive, folder, and 

file. 
4. Choose OK. 
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Section 8: Optimizing Mail Functions 

[--- EXERCISE 	  

In the following exercise, you will insert a file in a message and send the 
message. 

1. Prepare a new message 
addressed to your e-mail 
address, type Mardi Gras 
Plans for the subject and place 
the insertion point in the 
message text field 

2. On the toolbar, click the Insert 
File button 

The Insert File dialog box 
appears. 

3. Select the A:1 drive The files in the folder are 
listed. 

4. In the File Name list, select 
Elena's Mardi Gras 
Plans.doc 

5. Choose OK The file is attached to the 
message. 

6. Send the message A second copy of the 
message appears. The 
information area shows that 
you attempted to recall this 
message. 

7. Close the message 



Using Message Features 

Opening, Closing, and Saving an Attached File 

You need to view and open attachments in the messages you receive. To open 
an attachment, you must have the program that created the attached data file 
loaded on your computer (or have a special viewer utility). When you open an 
attachment, the program in which the attachment is embedded is automatically 
started. After you look at the attachment, you might want to save it. 

L METHOD ----1  

To open an attached Windows data file: 

1. In the message, double-click the attachment icon. 

To save an attachment: 

Save Attachment dialog box method 
1. In the message window, from the File menu, choose Save 

Attachments. 
2. In the Save All Attaclunents dialog box, select the attaclunent(s) 

you want to save, choose OK, and then, in the next Save All 
Attachments dialog box, select the drive and folder where you 
want to save the attachment. 

3. If desired, in the File name text box, type a new name for the 
attachment. 

4. Choose Save. 

Mouse method 
1. In the Other Shortcuts group, open My Computer. 
2. Select the folder where you want to save the attachment. 
3. Drag the attachment icon from the message to the folder. 
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The Opening Mail Attachment 
Dialog Box appears 

The attachment appears 

gm 
-1.2...0 
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EXERCISE 

In the following exercise, you will open, close, and save an attachment. 

1. Open the Mardi Gras Plans 
message in your lnbox 

2. In the message body, double-
click the attachment icon 

3. Click Open it and choose OK 

3. Examine the document, and 
then close it 

4. In the message window, from 
the File menu, choose Save 
Attachments 

5. Make sure the H:ldoc folder is 
selected 

6. Type Mardi Gras for the 
filename 

7. Choose Save 

8. Close the message 

The Save Attachment dialog 
. box appears. 

The attachment is saved. 

[-END ]  
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To add a name to your Personal 
Address Book: 

4. Choose OK. 
5. On the STMP-General page of 

the New Address Properties 
dialog box, in the Display Name 
text box, type the naine  you want 
to use to represent this address. 

6. In the E-Mail address text box, 
type the e-mail address. 

7. Choose OK. 

Inbox method 
1. On the Standard toolbar, click the 

Address Book button. 
2. If necessary, in the Address Book 

window, from the Show Names 
from the: drop-down list, select 
the address book from which you 
want to add a name. 

3. From the address list, select the 
name(s) you want to add to your 
Personal Address Book. 

4. On the Address Book window 
toolbar, click the Add to Personal 
Address Book button. 

5. Close the Address Book window. 

To select a default address book: 

New message method 
1. On the New message toolbar, 

click the Address Book button. 
2. If necessary, in the Select Names 

dialog box, from the Show Names 
from  the: drop-down list, select 
the address book from which you 
want to add a name. 

3. From the address list, select the 
name(s) you want to add to your 
Personal Address Book. 

4. Choose Properties. 
5. In the Properties dialog box, 

choose Personal Address Book. 
6. Choose OK. 
7. Close the Address Book window. 

1. From the Tools menu, choose 
Services. 

2. In the Services dialog box, select 
the Addressing tab. 

3. On the Addressing page, from the 
Show this  address list first:  drop-
down list, select the desired 
address book. 

4. If desired, fi-om the iVhen sending 
mail, check names using these 
address lists in the following 
order: list, select an address 
book, and then choose the up or 
the down arrow to change the 
priority order. 

5. Choose OK. 
6. Exit from and restart Outlook. 

To create an alias in your Personal 
Address Book: 

To create a personal distribution list: 

1. On the Standard toolbar, click the 
Address Book button. 

2. On the Address Book window 
toolbar, click the New Entry 
button. 

3. In the New Entry dialog box, 
from the Select entry type list, 
select Personal Distribution List, 
and then choose OK. 

4. In the New Personal Distribution 
List Properties dialog box, in the 
Name text box, type a name for 
your personal distribution list 

5. Choose Add/Remove Members. 

1. On the Standard toolbar, click the 
Address Book button. 

2. On the Address Book window 
toolbar, click the New Entry 
button. 

3. In the New Entry dialog box, 
select the entry type. 
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6. Select the names. 
7. Choose Members. 
8. Choose OK. 
9. In the New Personal Distribution 

List Properties dialog box, choose 
OK. 

10. Close the Address Book window. 

To add personal distribution list 
members: 

1. On the Standard toolbar, click the 
Address Book button. 

2. If necessary, in the Address Book 
window, from the Show Names 
fi-om the: drop-down list, select 
Personal Address Book 

3. In the address list, double-click 
the name of the personal 
distribution list to which you 
vvant to add members. 

4. In the List Properties dialog box, 
choose Add/Remove Members. 

S. In the Edit Members dialog box, 
select the name(s) you want to 
add to the group. 

6. Choose Members. 
7. Choose OK. 
8. In the List Properties dialog box, 

choose OK. 

To remove personal distribution list 
members: 

1. On the Standard toolbar, click the 
Address Book button. 

2. If necessary, in the Address Book 
window, from the Show Names 
from the: drop-down list, select 
Personal Address Book. 

3. In the address list, double-click 
the name of the personal 
distribution list from which you 
want to remove members. 

4. In the List Properties dialog box, 
choose AdcVRemove Members. 

5. In the Edit Members dialog box, 
select the name(s) you want to 
remove from the group. 

6. Press DELETE  

7. Choose OK. 
8. In the List Properties dialog box, 

choose OK. 

To delete a personal distribution list: 

1. On the Standard toolbar, click the 
Address Book button. 

2. From the Show Names in the: 
drop-down list, select Personal 
Address Book 

3. In your Personal Address Book, 
select the personal distribution 
list you want to delete. 

4. Press DELETE 
5. In the message box that asks, Are 

you sure that you want to 
permanently remove the selected 
user(s) from this Address Book? 
choose Yes. 

To save and close a message without 
sending it: 

1. In the New Message window, on 
the toolbar, click the Save button. 

2. Close the window. 

To send a saved message: 

1. Open the Drafts folder. 
2. Open the saved message. 
3. Complete and send the message. 

To set spelling options: 

1. From the Tools menu, choose 
Options. 

2. In the Options dialog box, select 
the Spelling tab. 

3. On the Spelling page, select the 
check boxes for the desired 
feature. 

4. Choose OK. 

266 



Summary 

To set the importance for a message: 

1. On the New Message window 
toolbar, click the Importance: 
High button or the Importance 
Low button. 
or 

1. In the Options dialog box 
Message settings area, from the 
Importance drop-down list, select 
Low, Normal, or High. 

To recall a message: 

1. From the Sent Items folder 
message list, open the message. 

2. From the Actions menu, choose 
Recall This Message. 

3. In the Recall This Message dialog 
box, select an option button. 

4. Choose OK. 

To attach a file: 

To set General, Delivery and 
Tracking options for a message: 

1. In the Options dialog box, in the 
Delivery options area, select the 
desired options check boxes. 

2. Where necessary, select details 
from the drop-down list 

1. In a new message, position the 
insertion point in the message 
area where you want to attach the 
file. 

2. On the toolbar, click the Insert 
File button. 
or 

2. From the Insert menu, choose 
File. 

3. In the Insert File dialog box, 
select the desired drive, folder, 
and file. 

4. Choose OK. 

To attach voting buttons to a 
message: 

1. In the Options dialog box, select 
the Use voting buttons check box. 

2. From the Use voting buttons 
drop-down list, select 
Approve;Reject, Yes;No, or 
Yes;No;Maybe. 

To open an attached Windows data 
Me: 

1. In the message, double-click the 
attaclunent icon. 

To respond to a voting message: 

1. In the voting message, choose a 
response button. 

2. In the message box, select an 
option button. 

3. Choose OK. 
4. If editing the message, in the text 

box, type your message, and then 
send it. 

To save an attachment: 

To flag a message: 

1. On the Message window toolbar, 
click the Message Flag button. 

2. In the Flag Message dialog box, 
click the Flag drop-down list 
arrow, and then select the flag. 

3. In the By combo box, enter the 
due date. 

4. Choose OK. 

Save Attachments dialog box 
method 

1. In the message window, from the 
File menu, choose Save 
Attachments. 

2. In the Save All Attachments 
dialog box, select the 
attachment(s) you want to save, 
choose OK, and then, in the next 
Save All Attachments dialog box, 
select the drive and folder where 
you want to save the attachment 

3. If desired, in the File name text 
box, type a new name for the 
attachment 

4. Choose Save. 
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Câ 

Mouse method 
1. In the Other Shortcuts group 

folder, open My Computer. 
2. Select the folder where you want 

to save the attachment. 
3. Drag the attachment icon from 

the message to the folder. 
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Self-Check Exercise 

1. Add your instructor to your Personal Address Book. 

2. Select the Global Address List as the default address book. 

3. Exit from Outlook and restart it. 

4. Create a personal distribution list called Everyone that includes your 
instructor and all the members of your class except for yourself. 

5. Use your Personal Address Book to address a message to Everyone. In 
the Subject text box, type Dinner. In the message area, type Let's meet 
at Elena's  alter class. Can you make it? Save and close the message. 

6. Reopen the Dinner message. Tum off the spelling options that suggest 
corrections and capitnlize the first letter of a sentence. 

7. In the Dinner message, from the A:1 drive, attach the file 
Directions.bmp. 

. In the Dinner message, set the message importance level as high. Add 
voting buttons that say Yes and No. Have replies sent to your instructor. 
Request a receipt when the message has been read. Then send the 
message. 

9. Open the message fi-om your partner. (Ignore all the other messages.) 
Open the attachment. Save the attachment in the H:\doc  folder as 
To Elena's.bmp. Close the attachment. Choose a response button and 
send your reply. 

10. When you receive a Read Report message indicating receipt of your 
message, open it, read it, and then close it. Ignore all other Read Report 
messages. 

11. Address a new message to your partner. In the Subject text box, type My 
Favorite Places. Flag the message: For Your Information. In the 
message area, type Here they are: and then press SPACEBAR. Type the 
following places: Accra, Athens, Buenos Aires 

12. Send the message and immediately recall it. Send the message again. 
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13. Remove your instructor from the Everyone personal distribution list. 
Then add yourself to the list. 

14. Delete the Everyone personal distribution list. 
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Section 9: Working with Contacts 

Section Skills and Their Importance 
In the following section you will learn  to: 

• Refine your contact list 
When  you have several contacts from one company, you can copy 
the information you have ah-eady entered about the company and 
use it with each new contact. To make locating contacts easier, you 
can use Outlook's File As feature. 

• Access contacts directly 
You can access a contact's web page directly from the Contact 
window, just as you can address an e-mail message to a contact. In 
addition, you can manage your favorite web pages while working 
in Outlook. 

272 



Refining Your Contact List 

Refining  Your  Contact List 
As you add more and more contacts, you might fmd that several address cards 
have similar information. You can easily add new contacts fiom the same 
company or orgarizRtion by retrieving the information you have previously 
entered. You might also find that, as your contact list grows, you remember a 
contact's first name or niclmame or other piece of information but not the last 
name. Using Outlook's File as feature, you can designate under what name to 
file the address card. 

Adding a Contact from the Same Company 

Sometimes you might want to add multiple contacts who work for the same 
company to your contact list. Outlook lets you reproduce company 
information on a new address card to which you then add the individual 
information. This procedure is faster than creating a new address card from 
scratch, since the company name and address and sometimes even the 
business phone number are the same. 

L METHOD —I 

To add a contact from the same company: 

1. Select an address card from the company. 
2. From the Actions menu, choose New Contact from Same 

Company. 
3. In the New Contact window, enter the appropriate information. 
4. On the toolbar, click the Save and Close button. 

EXERCISE 

In the following exercise, you will add a contact from the same company. 

1. Open the Contacts folder 

2. Select the Clio Hebert address 
card 
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3. From the Actions menu, 
choose New Contact from 
Same Company 

The New Contact window 
appears displaying Company, 
Address, and Phone data 

4. In the Full Name text box, type 
Marietta LaPierre 

5. In the Job title text box, type 
Chef 

6. On the toolbar, click the Save 
and Close button 

The address card for Marietta 
LaPierre appears in the 
contact list 
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Refining Your Contact List 

Using the File as Feature 

You might find it helpful to file your contacts by information other than their 
last names. For example, you mig,ht want to file your dentist as Dentist instead 
of as Dr. Jones. The File as feature lets you designate how to show your 
contacts on the address cards. You can also file your contacts by company 
name or by a combination of their  naine and their company name. If you 
prefer to list them by nickname or position, you can type that information into 
the File as combo box as well. Figure 9-1 shows a Contact window with the 
default File as drop-down list giving you five built-in File as selections. 

Figure 9-1: The Contact Window Showing the File as Drop-Down List 
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L METHOD --I 
To use the File as feature: 

1. Double-click the address card. 
2. In the Contact window, from the File as drop-down list, select a 

listing. 
or 

2. In the Contact window, in the File as combo box, type the 
listing. 

3. On the toolbar, click the Save and Close button. 

[---- EXERCISE 	  

In the following exercise, you will use the File as feature. 

1. Double-click the Marietta 	The Marietta LaPierre - 
LaPierre address card 	Contact window opens. 

2. In the contact window, from 
the File as drop-down list, 
select Gumbo Gulch 

3. On the toolbar, click the Save 
and Close button 

The address card appears in 
the contact list as Gumbo 
Gulch, not as LaPierre, 
Marietta. 
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Accessing Contacts Directly 
Outlook helps you keep in touch with your contacts by providing automatic 
features that let you send an e-mail message to a contact using the address on 
the address card, connect you to a contact's web page, or dial a contact from 
your computer. To use the AutoDial feature that dials your contact, you must 
have a modem. 

Sending a Message to a Contact 

It's useful to fill out as much information on an address card as possible. 
When you fill in an e-mail address on a contact's address card, you can then 
send a message directly to the contact from the address card. Every time you 
add an e-mail address to an address card, you add an address to the e-mail 
Contacts address book. When you click the New Message to Contact toolbar 
button, shown in Figure 9-2, a New Message window opens with the message 
addressed to the contact. In order to see your Contacts folder in the Address 
Book, you must fust add it to the Outlook Address Book. 

Figure 9-2: The New Message to Contact Button 

L METHOD —I 

To add your Contacts to the Address Book: 

1. Right mouse click the Contacts folder 
2. Select Properties. 
3. Select the Outlook Address Book tab. 
4. Select "Show this folder as an e-mail Address Book"and click 

OK. 

To send a message to a contact: 

Contact folder method 
1. Double-click an address card. 
2. In the Contact window, on the toolbar, click the New Message 

to Contact button. 
3. In the New Message window, compose and send the message. 



Inbox method 
1. On the Inbox toolbar, click the Address Book button. 
2. In the Address Book window, from the Show Names from the: 

drop-dovvn list, select Outlook Address Book Contacts. 
3. Select the contact. 
4. On the toolbar, click the New Message button. 
5. In the New Message window, compose and send the message. 
6. Close the Address Book window. 

EXERCISE 	  

In the following exercise, you will send a message to a contact. 

1. Create an address card for 
your e-mail partner, including 
your partner's name and e-mail 
address 

2. On the toolbar, click the New 
Message to Contact button 

The New Message window 
appears already addressed to 
your partner. 

3. In the Subject text box, type 
Message to Contact 

4. In the message area, type a 
brief message 

5. Send the message 
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Accessing a Contact's Web Page 

To connect to a web page, you must have a web browser such Netscape 
Navigator installed. When you fill in the web page address text box on a 
contact's address card, you can then access the contact's web page directly 
from the selected address card. When you click the Explore Web Page button 
on the Advanced toolbar, shown in Figure 9-3, Outlook automatically opens 
your Internet browser and displays the contact's web page directly. 

Figure 9-3: The Explore TVeb Page Button 

1--- METHOD --I 

To access a contact's web page: 

1. Select an address card. 
2. On the Advanced toolbar, click the Explore Web Page button. 

1--- EJCERCISE 	  

In the following exercise, you will access a contact's web page. 

1. Make sure your partner's 
Contact window is open 

2. In the Web page text box, type 
http://www.msnbc.com  and 
click Save and Close. 

3. On the Advanced toolbar, click the Internet browser displays 
the Explore Web Page button 	your partner's web page. 
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To add a contact from the same 
company: 

1. Select an address card from the 
company. 

2. From the Actions menu, choose 
New Contact from Same 
Company. 

3. In the New Contact window, 
enter the appropriate information. 

4. On the toolbar, click the Save and 
Close button. 

To use the File as feature: 

1. Double-click the address card. 
2. In the Contact window, from the 

File as drop-down list, select a 
listing. 
or 

2. In the Contact window, in the 
File as combo box, type the 
listing. 

3. On the toolbar, click the Save and 
Close button. 

To add the Contact folder to the 
Outlook address book 

1. Right mouse click the Contact's 
folder. 

2. Select Properties. 
3. Select the Outlook Address Book 

tab. 
4. Select Show this folder as an 

e-mail Address Book and click 
OK. 

To send a message to a contact: 

Contact folder method 
1. Double-click an address card. 
2. In the Contact window, on the 

toolbar, click the New Message to 
Contact button. 

3. In the New Message window, 
compose and send the message. 

Inbox method 
1. On the Inbox toolbar, click the 

Address Book button. 
2. In the Address Book window, 

from the Show Names from  the: 
drop-dovvn list, select Outlook 
Address Book and then Contacts. 

'3. Select the desired contact. 
4. On the toolbar, click the New 

Message button. 
5. In the New Message window, 

compose and send the message. 
6. Close the Address Book window. 

To access a contact's web page: 

1. Select an address card. 
2. On the Advanced toolbar, click 

the Explore Web Page button. 
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Self:Check Exercise 

1. Add a new contact from Nature's Best Bets to your contact li st. The 
contact, Andra Gautier, is a sales associate. Use the File as feature to file 
Andra under her company name. 

Hint: Find other contacts who work for the same company. 

2. Send a new message to your partner, addressing the message by using 
your partner's address card. For the Subject, type Self-Check and, in the 
message area, type This is a test. 

3. Open your partmer's web page by using your partner's address card. 
Then use the browser's Address box to go to the MCI Internet Resources 
web page (http://www.mci.com/resources).  

4. Close the browser and all open Contact windows. 
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Section 10: Working with Other Users 

Section Skills and Their Importance 
In the following section you will learn to: 

III Schedule meetings 

Using Outlook's scheduling features, you view your colleagues' 
Calendars to choose a meeting time and plan a meeting. You can 
even plan a recurring meeting or schedule an event. 

Outlook lets you send meeting invitations, to which you can attach 
notes and documents. When you receive an invitation, you respond 
to it. When someone agrees to attend a meeting, Outlook 
automatically puts the meeting on the recipient's and on the 
sender's Calendars. 

You also review meeting information through your Calendar. You 
can find out who plans to attend, and you can resche,dule or cancel 
a meeting when necessary. If you change a meeting time or date, 
Outlook notifies all the other attendees. 

•  Manage tasks 

You schedule your tasks or delegate tasks to colleagues and 
contacts and track their progress. If a colleague assigns a task to 
you, you respond to your colleague and, if necessary, place the task 
on your Calendar. If someone declines your task request, you can 
reclaim ownership of it. 

Some tasks you must repeat after a certain time period rather than 
at recurring intervals; you regenerate such tasks. When you receive 
a message that is not specifically a task request, perhaps from 
someone who does not use Outlook, you can create a task from the 
message by creating a new item from an existing one. You can also 
use this process to put a meeting on your Calendar. 
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Scheduling Meetings 
A meeting is a scheduled activity that involves other people and can also 
involve resources, which include equipment, locations, and other people. You 
eliminate phone tag and coordination problems when you and your colleagues 
arrange meetings and assess work load and task status for a project by 
examining one another's Outlook folders from your own computers. 

One of Outlook's greatest strengths is its capacity to let you work with others. 
For example, you could use Outlook to manage the steps involved in 
evaluating employee performance, as shown in Table 10-1. 

Step 	 Purpose 

Task 	 Evaluate employee performance. 

Appointment 	Write appraisals. 

Meeting 	 Session with employees in conference room to explain 
purpose of appraisals. Need computer with projection 
capability to run a slide show that gives overview of 
evaluation process. 

Meetings 	 Sessions with individual employees. 

Task 	 Track status and mark completed. 

Table 10-1: Steps Needed to Evaluate Employee  Performance 

 Colleagues and Setting a Meeting Time 

When you want to schedule a meeting, you click the Plan a Meeting toolbar 
button, shown in Figure 10-1. This button accesses the Plan a Meeting dialog 
box, shown in Figure 10-2, which lets you invite colleagues and set a meeting 
time. 

Figure 10-1: The Plan a Meeting Button 

In the Plan a Meeting dialog box, Outlook lets you see your schedule and the 
schedule of everyone else on your network whom you invite to the meeting. 
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Appointments shown as busy appear in blue, as tentative appear in light blue, 
and as out of the office appear as purple. 

Tue.- 	March  25, 19Ç -7  
3 00 	5 00 	9:00 	11:03 	1 00  

All Attendee -3 

Ei llilill, 	I. 	II, _ - 	I 
CP mitiFORD Susan (Sue) 

er g•vèn w,L0e-CN K 

1 	' 	- - 	e narre, . 

_ 

HI- 	 If  

• DIV tatfe Z Busy 	Out of Offre 

Meeting sUrt tirne: Penn 3/24/97 	12:00 PM 

Meeting end 	IMon 3/24/97 	-•1 13:C0 PM 

Figure 10-2: The Plan a Meeting Dialog Box 

When you select a time for the meeting and choose Make Meeting, a Meeting 
Message window appears addressed to the invitees and shows the meeting 
time, as shown in Figure 10-3. You complete the meeting details in the 
Meeting Message window. If the meeting is a recurring meeting, you use the 
Recurrence button to access the Appointment Recurrence dialog box to set the 
frequency of the meetings. After you enter all meeting details, you send the 
message to the addressees. 
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Figure 10-3: The Meeting Message Window 

L METHOD --I 
To invite colleagues and set a meeting time: 

1. On the Calendar Advanced toolbar, click the Plan a Meeting 
button. 

2. In the Type attendee name here text box, type the names of the 
invitees. 
or 

2. Choose Invite Others, and in the Select Attendees and 
Resources dialog box, from the Name list, select the names of 
the invitees. 

3. Choose Required, Optional, or Resources, and then choose OK. 
4. On the planner, examine all attendees and resources schedules. 
5. In the Meeting start time and Meeting end time combo boxes, 

select dates and times for the meeting. 
or 

5. Choose AutoPick. 
6. Choose Make Meeting. 
7. In the Meeting Message window, complete the information, and 

then send the message. 



Your appointment for tomorrow 
appears. 

The Plan a Meeting dialog box 
appears, displaying your user 
name and your schedule for 
tomorrow. 

Your partner's schedule 
appears in the planner. 

The Select Attendees and 
Resources dialog box appears 
showing the user name of the 
partner whom you have 
selected. 

All your partners' user names 
appear in the Required list 

Section 10: Working with Other Users 

I 	EXERCISE 

In the following exercise, you will invite colleagues and set a meeting 
time. 

1. Open the Calendar folder 

2. Schedule appointments 
according to Table 10-2 

3. On your Calendar, display 
tomorrow's date 

4. On the toolbar, click the Plan a 
Meeting button 

5. In the Type attendee name 
here text box, type the user 
name of one of your workgroup 
partners, and then press 
ENTER 

6. Choose Invite Others 

7. From the Name list, select your 
other partner(s)'s user 
name(s), and then choose 
Required 

8. Choose OK 

9. Examine everyone's schedule 

10. In the first Meeting sta rt  time 
combo box, select the date 
indicated in Table 10-3, and in 
the second combo box, select 
the first available time 

Your partners' schedules 
appear in the planner. 
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11. In the first Meeting end combo 
box, select the same date, and 
in the second combo box, 
select a time one hour after the 
start time 

12. Choose Make Meeting A Meeting message window 
appears addressed to your 
partners and showing the 
meeting time. 

13. In the Subject area, type Food 
Festival 

14. In the Location area, type 
Elena's 

15. In the message area, type 
Let's discuss plans for next 
year's festival. 

16. Send the message 

17. Examine your Calendar for 
tomorrow, the day after 
tomorrow, and the day one 
week from today 

Your Calendar displays the 
meeting you originated as well 
as the meetings your 
workgroup partners created. 
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Student 	Subject 	Date 	 lime 	Show time as 

	

Student1 	A 	tomorrow 	9:00-10:00 	Out of Office 

	

B 	day after 	2:30-4:00 	Busy 
tomorrow 

	

C 	one week from 	1:00-2:00 	Tentative 
today 

	

Student2 	D 	tomorrow 	11:00-12:00 	Tentative 

	

E 	day after 	9:00-10:00 	Out of Office 
tomorrow 

	

F 	one week from 	4:00-5:30 	Busy 
today 

	

Student3 	G 	tomorrow 	2:00-3:00 	Busy 

	

H 	day after 	8:30-10:00 	Tentative 
tomorrow 

	

I 	one week from 	11:00-12:30 	Out of Office 
today 

Table 10-2: The Workgroup Appointment Schedule 

Student 	 Date 

Student1 	tomorrow 

Student2 	day after tomorrow 

Student3 	week from today 

Table 10-3: The Workgroup Meeting Schedule 
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Inviting a Contact to a Meeting 

Usually, your meetings are not limited to only those colleagues who are in 
your e-mail postoffice. You might also meet with a contact for whom you 
have an address card in your contact list. 

To automate inviting a contact to a meeting, you must fill in the contact's 
e-mail address on the contact's address card. You can then drag the address 
card onto the Calendar shortcut on the Outlook Bar to begin the invitation 
process. 

L METHOD 

To invite a contact to a meeting: 

1. Drag the contact's address card onto the Calendar shortcut on 
the Outlook Bar. 

2. In the Meeting Message w -indow, complete the information and 
then send the message. 

Note: If your Outlook Address Book appears in your address book 
list, you can also address meeting invitations directly to your 
contacts using the address book. 

EXERCISE 	  

In the following exercise, you will invite a contact to a meeting. 

1. If necessary, create an 
address card including an 
e-mail address and close the 
Contact window 

2. Drag the contact card onto the A Meeting Message window 
Calendar shortcut on the 	appears addressed to your 
Outlook Bar 	 partner and showing the 

meeting time. 

3. In the Subject text box, type 
Advertising Campaign 

4. In the Location text box, type 
Elena's office 
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5. In the message area, type 
Let's critique the brochure. 

6. Send the message 



— 1=1 ni Staff meeting - Meeting 

x. 4. - 

Please attend cur staff meeting. Bring your notes. 

Scheduling Meetings 

Responding to a Meeting Request 

When you schedule a meeting and send the invitation message, the meeting 
automatically appears on your Calendar. Invited colleagues receive your 
message and decide whether to attend, just as you decide whether to attend a 
meeting or an event to which you are invited. 

The received message, such as the invitation shown in Figure 10-4, includes 
response buttons (similar to voting buttons) on the toolbar that you use to 
respond to the meeting organizer to indicate whether you accept the invitation, 
you tentatively accept, or you decline. You can check your Calendar to make 
sure you have enough time before and after the meeting to meet your other 
commitments. 

The meeting appears on your Calendar as a tentative meeting until you accept 
the invitation, at which time it appears as confirmed on your Calendar. If you 
decline the invitation, the meeting disappears from your Calendar. Before you 
respond, you can add a note to your reply. When you respond, Outlook 
automatically sends your response to the meeting organizer. 

Fde edit %reed  Insert F2;rnali ïoci; Àctic;ms_ ttb 

1 AeePt ? Tenteve X &dine 	Ca4enda- ..- 1 

Boucher, feccheine from: 

Required: 1:anclry, Helene -SXR; Galipeau, anstne -DR 
Opbon 

Subiect: 	e.aff meeting 

Sent: Thu 07/31/99 3:23 PM 

, 
Location: 	Conference rocrn 

leelen: 	January 8, 1999 BM At1-8M  M.  

Figure 10-4: An Invitation to a Meeting 
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L METHOD 

To respond to a meeting request: 

1. In the invitation message, on the toolbar, click the Calendar 
button. 

2. Examine and then close your Calendar. 
3. Choose Accept, Tentative, or Decline. 
4. In the message box that asks, Do you want to include comments 

with your response? select an option button, and then choose 
OK. 

5. If necessary, in the Accepted Meeting Response message 
window, type a response and/or attach a file. 

6. Send the message. 

r--EJCERCISE 

In the following exercise, you will respond to meeting requests. 

1. If necessary, check for new 
mail 

2. Open the Inbox 

3. Open the first Food Festival 
message from one of your 
workgroup partners 

4. On the toolbar, click the 
Calendar button 

5. Examine and then close your 
Calendar 

6. Choose Accept  

The invitation appears with 
response buttons on the 
toolbar. 

The meeting appears as a 
tentative meeting on your 
Calendar and displays a light 
blue move handle. 

The invitation reappears. 

A message box that says This 
meeting has been accepted 
and will be moved to your 
Calendar and that asks, Do 
you want to include 
comments with your 
response? appears. 
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The invitation appears with 
response buttons on the 
toolbar. 

The meeting appears as a 
tentative meeting on your 
Calendar and displays a light 
blue move handle. 

The move handle on this 
meeting time slot is now blue 

The invitation reappears. 

A message box that asks, Do 
you want to include 
comments with your 
response? appears. 

The Declined: Meeting 
Response message window 
appears. 

The tentative meeting has 
disappeared. 

The meeting is scheduled on 
your Calendar. 

r  END 

Scheduling Meetings 

7. Select the Don't send a 
response option button, and 
then choose OK 

8. Open the second Food 
Festival message 

9. On the toolbar, click the 
Calendar button 

10. Examine the time slot for your 
previously scheduled meeting 

11. Close your Calendar 

12. Choose Decline 

13. Select the Edit the response 
before sending option button, 
and then choose OK 

14. In the message window, type 
Sorry, but I don't intend to 
be on the committee. 

15. Send the message 

16. Examine the time slot on your 
Calendar for the meeting you 
just declined 

17. Open the Advertising 
Campaign message and 
accept the meeting invitation 
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Section 10: Working with Other Users 

Reviewing Meeting Information 

When attendees accept your invitation, the meeting also appears on their 
Calendars. When you open the first response, you see whether that invitee 
plans to attend. When you open the second and later responses, you see a 
running tabulation of responses. 

When you open the Meeting window, the Appointment page shows you the 
tabulated responses, the meeting time and location, and the text of the 
message you sent to all attendees. The Attendee Availability page, shown in 
Figure 10-5, shows you the status of each attendee and lets you invite more 
attendees. 

In Staff ideetig - 	 - 

Fde Ed;t. vew L-cert Format  look  Actions 

5ave ard CoseH25er Update
; rAtl .1t-  Recurrence... 

, AppOIntrnre 	A 

5,10vo attendee a 

Snow attendee statiLs , 	_ 

Attendance Response 

None endtv tiealene -5XR Meeting Onenizer 
Required Attendee Accepted ;CP./Dui-hey, Mrichetre -CF9D 

4- 	 
; 

Livte Otf-ters„. 

Figure 10-5: The Attendee Availability Page of the Meeting Window 
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Scheduling Meetings 

L METHOD —I 
To review meeting information: 

1. On your Calendar, double-click the meeting. 
2. In the Meeting window, on the Appointment page, examine the 

tabulated responses, the meeting time and location, and the text 
of the message sent to all attendees. 

3. Select the Attendee Availability tab. 
4. On the Attendee Availability page, examine the status of each 

attendee. 

[--- EXERCISE 	  

In the following exercise, you will review meeting information. 

1. On your Calendar, double-click 
the Food Festival meeting you 
organized 

The Meeting window appears 
showing the Appointment 
page. An information line tells 
you that one person accepted 
your invitation and one 
declined. 

2. Select the Attendee Availability 
tab 

The Meeting Planner page 
appears. 

3. Examine the status of each 
attendee 

You can ruad which partner 
accepted the invitation and 
which declined. 

4. Close the Meeting window 

5. In the lnbox, open and read 
the message from the 
workgroup partner who 
declined to attend your 
meeting, and then close the 
message 
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Rescheduling and Canceling a Meeting 

As the meeting organi7er you can reschedule or cancel a meeting. Outlook 
reminds you to notify the attendees of the changes you make with the update 
and cancellation message boxes. Figure 10-6 shows an update message box. 

Figure 10-6: An Update Message Box 

As an attendee, you can change your mind about attending a meeting you 
accepted or tentatively accepted by opening the Meeting window and selecting 
a new response button. Outlook sends your change to the meeting organizer. 

L METHOD --I 

To reschedule a meeting: 

1. On your Calendar, move the meeting to a new time slot. 
2. In the message box that asks, Would you like to send an 

update...? choose Yes. 
3. Review the Meeting message and, if necessary, make changes. 
4. On the toolbar, click the Send Update button. 

To cancel a meeting: 

1. On your Calendar, select the meeting. 
2. On the toolbar, click the Delete button. 
3. In the message box that says, The attendees have not been 

notzfied..., select an option button, and then choose OK. 

To cancel your attendance at a meeting: 

1. On your Calendar, double-click the meeting. 
2. In the Meeting window, select the Decline voting button. 
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Scheduling Meetings 

r— EXERCISE 	  

In the following exercise, you will reschedule a meeting and cancel a 
meeting. 

1. On your Calendar, move the 
Food Festival meeting you 
scheduled to the time slot one 
hour later 

A message box that asks, 
Would you like to send an 
update...? appears. 

2. Choose Yes The Meeting message window 
with the details about the 
meeting you are moving 
appears. 

3. In the message area, below 
the current text, type I was 
stuck in traffic and need 
more time. 

4. On the toolbar, click the Send 
Update button 

5. On your Calendar, select the 
Advertising Campaign meeting 

6. On the toolbar, click the Delete 
button 

A message box that says, The 
attendees have not been 
notified.... appears. 

7. Select the Send cancellation 
and delete meeting option 
button 

8. Choose OK The meeting is cancelled and 
all attendees are notified. 

9. Check for new mail and then 
open the messages 

The meetings are rescheduled 
and then cancelled. 

10. On the Calendar, double-click 
a meeting scheduled by one of 
your workgroup partners 

11. In the Meeting window, select 
the Decline voting button 

The meeting is removed from 
your Calendar, and a message 
that says you declined the 
meeting invitation goes to the 
meeting originator. 
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Scheduling an Event 

You can also add events to your colleagues' Calendars using the Plan a 
Meeting dialog box. You schedule an event as you would schedule a meeting, 
but in the Meeting message window, you select the All day event check box. 
When you select this check box, the time combo boxes disappear and the 
Meeting message window becomes an Invited Event message window, as 
shown in Figure 10-7. 

112 Mani Gras in August - !need Event 

ne 	:'ei  Insert  Firnat "rwis kct 

"Z. 	ReIrrence— qc Croce' irretattotti.. 

,1,-.Peiremerk 

Chr..e,ne. -.5YR 

Start tme: 	IThu 2/11(99 	 dav evert — 

End trne. 	I Thu 2/11/99 

III wear costume 

Figure 10-7: The Invited Event Message Window 

Since an event lasts a whole day or longer and doesn't require an appointment, 
you can schedule events regardless of your colleagues' schedules. Suppose, 
for example, that your company wants to schedule a blood drive and arranges 
for a blood mobile to be available for two days. You can place the event on 
your colleagues' Calendars and then let your colleagues individually schedule 
their appointments with the blood mobile staff. 



Scheduling Meetings 

L METHOD --I 
To schedule an event: 

I. Invite colleagues and set a meeting time for the desired date(s). 
2. In the Meeting message window, select the All day event check 

box. 
3. In the Invited Event message window, complete the information 

and send the message. 

r-- EXERCISE 	  

In the following exercise, you will schedule an event. 

1. Invite your workgroup partners 
and set a meeting time 
according to the schedule in 
Table 10-4 

2. In the Meeting message 
window, select the AH  day 
event check box 

The meeting times disappear. 
The title bar now shows the 
message window as Invited 
Event 

3. From the End time drop-down 
Date Navigator, select the last 
day of the month 

4. In the Subject text box, type 
Mardi Gras in [your month, 
as designated in Table 10-4] 

5. In the Location text box, type 
Elena's 

6. In the message area, type All 
servers will wear costumes. 

7. Send the message 

8. Open the Mardi Gras in [a 
summer month] messages and 
then examine your Calendar 
for June, July, and August 

The event is listed every day 
for each of the months. No 
meetings or appointments are 
sCheduled in connection with 
these events. 



Section 10: Working with Other Users 

Student 	 Date 

Student1 	 next June 1 

Student2 	 next July 1 

Student3 	 next August 1 

Table 10-4: The Workgroup Event Schedule 



Completing Tasks 

Completing Tasks 
When you have tasks on your task list, you should schedule time to complete 
them. If you are working with colleagues on a project, Outlook lets you 
coordinate tasks with others in your network group. You can even assign tasks 
to others, as they can assign tasks to you. 

Scheduling a Task 

Moving tasks from your task list to your Calendar is easy. If you are working 
in your Tasks folder, you simply drag a task from your task list onto the 
Calendar shortcut on the Outlook Bar. If you are working in the Calendar 
folder, you select a time slot and then drag a task from the TaskPad directly 
onto the Calendar. Outlook opens an Appointment window that displays your 
task as the subject of the appointment. You then add details to the 
Appointment window to schedule work on the task. Figure 10-8 shows a task 
in an appointment window. 

m ptmarin  win:mow me 4fflellue 

Subject 	Preparing Ntinicerial Visit 
Due Date: 	January E. 1999 

Slat= 	Not Started 
Percent Complete:0% 

Total Wort 
Actual Work 

0 hours 
0 hours 

Owner: 	Landry. Helene: SXR 

Categones». I 	 1>trate r, . 	, 	 - 	, . 

Figure 10-8: A Task in an Appointment Window 
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L METHOD --I 

To schedule a task: 

I. In the Tasks folder, drag a task onto the Calendar shortcut on 
the Outlook Bar. 
or 

1. In the Calendar folder, select a time slot,  and  then drag a task 
onto the Calendar. 

2. If necessary, in the Appointment window, in the Start time area, 
from the drop-down Date Navigator, select a date, and from the 
time drop-down list, select a time. 

3. If necessary, in the End time area, from the drop-down Date 
Navigator, select a date, and from the time drop-down list, 
select a time. 

4. On the toolbar, click the Save and Close button. 

EXERCISE 	  

In the following exercise, you will schedule a task. 

Open the Tasks folder 

2. Drag the Make kitchen clean-
up check list task onto the 
Calendar shortcut on the 
Outlook Bar 

An Appointment window 
showing the task in the Subject 
text box and the details in its 
message area appears. 

3. In the Start  time area, from the 
drop-down Date Navigator, 
select a week from tomorrow, 
and from the time drop-down 
list, select 4:30 PM 

4. In the End time area, make 
sure the date is a week from 
tomorrow, and from the time 
drop-down list, select 5:00 PM 

5. On the toolbar, click the Save 	The task is scheduled on your 
and Close button Calendar. 
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6. Open the Calendar folder and 
examine the 4:30-5:00 time 
slot for one week from 
tomorrow 

The Make kitchen clean-up 
checklist task is scheduled. 

7. Select the 10:00-noon time slot 
on the same date as the Make 
kitchen clean-up checklist task 

8. From the TaskPad, drag the 
Change artwork on restaurant 
walls task onto the Calendar. 

When you start to drag the 
task, the blue coloring that 
indicates the selected time slot 
disappears. An Appointment 
window showing the task in the 
Subject text box and the 
details in its message area 
appears. 

9. On the toolbar, click the Save 
and Close button 

The task is scheduled on your 
Calendar. 

10. Examine the 10:00-noon time 
slot 

The Change artwork on 
restaurant walls task is 
scheduled. 
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Regenerating a Task 

Sometimes you need to start a task all over again some time  alter  you have 
completed it. For example, you might want to clean off your desk monthly but 
you find you occasionally do it sooner. In such a case, you use the Task 
Recurrence dialog box, shown in Figure 10-9, to regenerate the task so that 
you remind yourself to clean off your desk one month  alter  you last did it. 
Instead of designating that the task recur daily, weekly, monthly, or yearly on 
a certain day of that time period, you select the Regenerate new task option 
button and set up the task for regeneration after one month. 

r Range of nicurence 

rzri 1/77.—C/s97 

Figure 10-9: The Task Recurrence Dialog Box Set to Regenerate a New Task 

L METHOD 

To regenerate a task: 

1. Select a task and open the Task window. 
or 

1. Create a task but do not close the Task window. 
2. On the toolbar, click the Recurrence button. 
3. In the Task Recurrence dialog box, in the Recurrence pattern 

area, select a time period option button, and then select the 
Regenerate new task  option  button and the numeral in the time 
period text box and enter the appropriate figure. 

4. Choose OK. 
5. In the Task window, on the toolbar, click the Save and Close 

button. 
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r------ EXERCISE 

In the following exercise, you will regenerate a task. 

1. Open the Tasks folder 

2. Click the New Task button 
appears. 

3. In the Subject text box, type 
Replace all spices 

The New Task window 

4. On the toolbar, click the 
Recurrence button 

The Task Recurrence dialog 
box appears. 

5. In the Recurrence pattern 
area, in the left column, select 
the Monthly option button 

6. In the Recurrence pattern 
area, in the right column, 
select the Regenerate new 
task option button, select the 
text in the time period text box, 
and then type 6 

7. Choose OK 

8. In the Due combo box, select 
the text, and then type Next 
Friday and then click the 
Subject text box 

9. On the toolbar, click the Save 
and Close button 

10. Mark the Replace all spices 
task completed 

The Replace all spices Task 
window reappears. The 
information area says Due 
today. Due 6 months after 
this task is completed 
effective Etoday's date]. 

The information area specifies 
in how many days the task is 
due. 

The task appears in the task 
list 

A check appears in the 
Complete check box and a line 
appears through the subject 
and the due date. A new 
Replace all spices task 
appears with the due date six 
months from today. 

FEND 
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Assigning a Task to Someone Else 

Just as you and your colleagues  cari  see one another's Calendars to plan 
meetings, you can also see one another's task lists. You can assign a task to a 
colleague or to a contact and track that person's progress completing the task. 
If your contacts are not part of your network group, then you can send them 
the request, but you cannot track the progress automatically. 

Once you assign a task to someone else, you cannot change the information in 
the task window. Outlook keeps track of who owns the task and notifies you 
whenever the new owner updates the status of the task. You use the Task 
message window, shown in Figure 10-10, to assign tasks. 

Figure 10-10:  The  Task Message Window 

L METHOD 

To assign a new task to someone else: 

1. From the Actions menu, choose Assign Task . 
2. In the Task message window, address the request, enter a 

subject, and fill in appropriate information. 
3. Make sure the Keep an updated copy of this Task on my Task 

List check box is selected. 
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4. Make sure the Send me a status report when this Task is 
complete check box is selected. 

5. Send the message. 

To assign a previously created task to someone else: 

1. Double-click the task. 
2. In the Task window, on the toolbar, click the Assign Task 

button. 
3. In the Task message window, address the request, enter a 

subject, and fill in appropriate information. 
4. Make sure the Keep an updated copy of this Task on my Task 

List check box is selected. 
5. Make sure the Send me a status report when this Task is 

complete check box is selected. 
6. Send the message. 

EXERCISE 	  

In the following exercise, you will assign a new task and a previously 
created task to someone else. 

1. From the Actions menu, 
choose New Task Request 

The Task message window 
showing the task in the Subject 
text box appears. 

2. Address the request to your 
mail partner 

3. In the Subject text box, type 
Dessert Bake Off 

4. In the Due combo box, type 
six months from today 

5. In the Start combo box, type 
today 

The text in the Due combo box 
becomes the date six months 
from today. 

6. In the message area, type Will 
you organize and run the 
contest? 

The text in the Start combo 
box becomes today's date. 
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7. Make sure the Keep an 
updated copy of this Task on 
my Task List check box and 
the Send me a status report 
when this Task is complete 
check box are selected 

8. Send the message 	 The task list reappears. 

9. Double-click the send fliers  te: 	The Task window appears. 
next month's specials... task 

10. On the toolbar, click the Assign The Task message window 
Task button 	 showing the task in the Subject 

text box appears. 

11. Address the request to your 
mail partner 

12. In the Due combo box, type 
25th of month 

13. In the message area, type Can The text in the Due combo box 
you do this? 	 becomes the actual date. 

14. Make sure the Keep an 
updated copy of this Task on 
my Task  List  check box and 
the Send me a status report 
when this Task is complete 
check box are selected 

15. Send the message 

16. As necessary, choose Yes and 
OK 

Message boxes might appear 
that wam you that the due date 
for this task has passed and 
that you have changed a start 
date on a recuning task. 

r  END 
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?lease translate the following text. 

Use Tasks to organise your business and personal to-do lists in one easy-to-manage place. 
Ouickly sort and prioritise tasks, set reminders for when tasks are due, and assign tasks to 
others. 

To create a task, point to New on the File menu, and then click Task. Type a task name in the 
Subject box, and then select the options you want. 

— 
For more information about working with tasks in Outlook, press the F1 key, type your question . _ 	. 
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Completing Tasks 

Responding to a Task Request 

When you receive a task request, response buttons appear on the message 
toolbar that let you accept or decline the request. When you select a button, 
Chitlook sends your response to the original owner of the task. If you accept 
the task, you become its new owner, and Outlook adds it to your task list. 
When you mark the task complete, Outlook automatically notifies the original 
task owner that you have completed the task. Figure 10-11 shows a received 
task request with response buttons on the toolbar. 

Figure 10-11: A Received Task Request with Response Buttons 

The message toolbar also contain% an Assign Task button, shown in 
Figure 10-12, that you can use if you do not want to perform the task yourself 
but want to reassign the task to a third person. You assign the task as if you 
were the original owner. 

Figure 10-12: The Assign Task Button 
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If you decline a task assignment, Outlook returns your response to the original 
owner of the task and places your copy of the task in your deleted items 
folder. 

L METHOD --I 
To accept or decline a task request: 

1. In the task request message, on the toolbar, click the Accept or 
the Decline button. 

2. In the message box, select the Send the response now option 
button, and then choose OK. 
or 

2. In the message box, select the Edit the response before sending 
option button, and then choose OK. 

3. If necessary, in the message window message area, type your 
response, and then send the message. 

To reassign a task request: 

1. In the task request message, on the toolbar, click the Assign 
Task button. 

2. In the Task message window, address the task to the assignee. 
3. In the message area, type a message. 
4. If desired, select the Keep an updated copy of this task on my 

task list check box. 
5. If desired, select the Send me a status report when this task is 

complete check box. 
6. Send the message. 
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I-- EXERCISE 

In the following exercise, you will decline a task request and reassign a 
task request 

1. If necessary, check for new 
messages 

2. In the Inbox, open the Dessert 
Bake Off message 

i 

3. On the toolbar, click the 
Decline button 

A message box that asks Do 
you want to edit the 
response before sending it? 
appears. 

4. Select the Send the response 
now option button, and then 
choose OK 

5. If necessary, open the send 
fliers  te:  monthly specials... 
message 

6. On the toolbar, click the Assign 
Task button 

7. Address the task to one of 
your workgroup partners 

8. In the message area, type I 
don't have the time. Can you 
do this? 

9. Send the message 

10. Choose Yes 

The Task message window 
showing the task and the 
message appears. 

A message box that warns, 
The due date for this Task 
has passed, appears. 

ri  
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Reclaiming Ownership of a Declined Task 

If your colleague dec lines a task, you can reclaim ownership of it by retuming 
the task to your task list. 

L METHOD ----I 

To reclaim ownership of a dec lined task: 

1. In the message that contnins the declined task request, from the 
Actions menu, choose Return to Task List. 

2. In the Task window, on the toolbar, click the Save and Close 
button. 

EXERCISE 

In the following exercise, you will reclaim ownership of a declined task. 

1. If necessary, check for new 
messages 

2. Open the Task Declined: 
Dessert Bake Off message 

3. From the Actions menu, 
choose Return to Task List 

4. On the toolbar, click the Save 
and Close button 

The Task window appears. 

The message disappears from 
the message list 

5. Examine your task list 	 The task is returned to your 
task list. 

r  END 
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Creating a New Item from an Existing One 

When you drag an item from a list in one folder onto the shortcut for another 
folder, Outlook's  Auto  Create feature automatically creates a new item from 
the item you dragged. For example, if you drag a contact from the contact list 
onto the Inbox shortcut, AutoCreate addresses a new message to the contact. If 
you drag a note onto the Tasks folder shortcut, AutoCreate creates a new task 
from the note. 

Suppose you receive a message that requests that you perform a task, but the 
message was not sent as a task request. When that happens, you use 
AutoCreate to create a new task from the message. When you drag the 
message from the Inbox onto the Task folder shortcut on the Outlook Bar, 
Outlook automatically converts the message to a task and copies the entire 
message to the large text box at the bottom of a New Task window. It also 
copies key data from the existing item to relevant fields in the new item. 
Figure 10-13 shows a new task that was created from a message. 

11 Message to creents . 	 MS El 
Ede 	 t: To* AcOons 14"et< 

St date: Noni—e- 

r Reminder:  frr 

2atus: Not 5rnerted 

Prionte Forma-77:: 

From: 	 Galipeau, Christine -CFSP 
Sent 	 January 4. 1999 621 PM 
To: 	 Landry. Helene -SXR 
Subject 	Message to clients 

Hélène 

Figure 10-13: A New Task Created from a Message 
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L METHOD --i 
To create a new item from an existing one: 

1. From an item list, drag an item onto the shortcut on the Outlook 
Bar. 

2. In the folder window, if necessary, add more details. 
3. On the toolbar, click the Save and Close button. 

EXERCISE 

In the following exercise, you will create new items from edsting ones. 

1. Open the Contacts folder 

i 

5. 

6. 

7. 

2. From your contact list, drag 
your mail partner's address 
card onto the lnbox shortcut on 
the Outlook Bar 

3. In the Subject text box, type 
Recipe Request 

4. In the message area, type 
Please give me your recipe 
for Baklava. 

Send the message 

Check for new mail 

From the lnbox, drag the 
recipe request onto the Tasks 
shortcut on the Outlook Bar 

8. On the toolbar, click the Save 
and Close button 

9. Open the Tasks folder and 
examine the task list 

The New Message window 
appears addressed to your 
partner. 

The Task window showing the 
message subject as the Task 
subject and the message 
details in the large text box 
appears. 

The new task appears in the 
list 

r  END --I 
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C/D 

To invite colleagues and set a meeting 
time: 

4. In the message box that asks, Do 
you want to include comments 
with your response? select an 
option button, and then choose 
OK. 

5. If necessary, in the Accepted 
Meeting Response message 
window, type a response and/or 
attach a file. 

6. Send the message. 

To review meeting information: 

1. On your Calendar, double-click 
the meeting. 

2. In the Meeting window, on the 
Appointment page, examine the 
tabulated responses, the meeting 
time and location, and the text of 
the message sent to all attendees. 

3. Select the Attendee Availability 
tab. 

4. On the Attendee Availability 
page, examine the status of each 
attendee. 

E.7 

1. On the Calendar Advanced 
toolbar, click the Plan a Meeting 
button. 

2. In the Type attendee name here 
text box, type the names of the 
invitees. 
or 

2. Choose Invite Others, and in the 
Select Attendees and Resources 
dialog box, from the Name list, 
select the names of the invitees. 

3. Choose Required, Optional, or 
Resources, and then choose OK. 

4. On the planner, examine all 
attendees and resources 
schedules. 

5. In the Meeting start time and 
Meeting end time combo boxes, 
select dates and times for the 
meeting. 
or 

5. Choose AutoPick. 
6. Choose Make Meeting. 
7. In the Meeting Message window, 

complete the information, and 
then send the message. 

To reschedule a meeting: 

1. On your Calendar, move the 
meeting to a new time slot 

2. In the message box that asks, 
Would you like to send an 
update...? choose Yes. 

3. Review the Meeting message 
and, if necessary, make changes. 

4. On the toolbar, click the Send 
Update button. 

To invite a contact to a meeting: 

1. Drag the contact's address card 
onto the Calendar shortcut on the 
Outlook Bar. 

2. In the Meeting Message window, 
complete the information and 
then send the message. 

To respond to a meeting request: 

1. In the invitation message, on the 
toolbar, click the Calendar button. 

2. Examine and then close your 
Calendar. 

3. Choose Accept, Tentative, or 
Decline. 

To cancel a meeting: 

1. On your Calendar, select the 
meeting. 

2. On the toolbar, click the Delete 
button. 

3. In the message box that says, The 
attendees have not been 
notified..., select an option 
button, and then choose OK. 
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To cancel your attendance at a 
meeting: 

1. On your Calendar, double-click 
the meeting. 

2. In the Meeting window, select the 
Decline voting button. 

To schedule an event: 

1. Invite colleagues and set a 
meeting time for the desired 
date(s). 

2. In the Meeting message window, 
select the All day event check 
box. 

3. In the Invited Event message 
window, complete the 
information and send the 
message. 

To schedule a task: 

1. In the Tasks folder, drag a task 
onto the Calendar shortcut on the 
Outlook Bar. 
or 

1. In the Calendar folder, select a 
time slot, and then drag a task 
onto the Calendar. 

2. If necessary, in the Appointment 
window, in the Start time area, 
from the drop-down Date 
Navigator, select a date, and from 
the time drop-down list, select a 
time. 

3. If necessary, in the End time area, 
from the drop-clown Date 
Navigator, select a date, and from 
the time drop-down list, select a 
time. 

4. On the toolbar, click the Save and 
Close button. 

To regenerate a task: 

1. Select a task and open the Task 
window. 
or 

1. Create a task but do not close the 
Task window. 

2. On the toolbar, click the 
Recurrence button. 

3. In the Task Recurrence dialog 
box, in the Recurrence pattern 
area, select a time period option 
button, and then select the 
Regenerate new task option 
button and the numeral in the 
tùne period text box and enter the 
appropriate figure. 

4. Choose OK. 
5. In the Task window, on the 

toolbar, click the Save and Close 
button. 

To assign a new task to someone else: 

1. From the Actions menu, choose 
New Task Request. 

2. In the Task message window, 
address the request, enter a 
subject, and fill in appropriate 
information. 

3. Make sure the Keep an updated 
copy of this Task on my Task List 
check box is selected. 

4. Make sure the Send me a status 
report when this Task is complete 
check box is selected. 

5. Send the message. 

To assign a previously created task to 
someone else: 

1. Double-click the task. 
2. In the Task window, on the 

toolbar, click the Assign Task 
button. 

3. In the Task message window, 
address the request, enter a 
subject, and fill in appropriate 
information. 

4. Make sure the Keep an updated 
copy of this Task on my Task List 
check box is selected. 

5. Make sure the Send me a status 
report when this Task is complete 
check box is selected. 

6. Send the message. 
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To accept or decline a task request: 

1. In the task request message, on 
the toolbar, click the Accept or 
the Decline button. 

2. In the message box, select the 
Send the response now option 
button, and then choose OK. 
Or 

2. In the message box, select the 
Edit the response before sending 
option button, and then choose 
OK. 

3. If necessary, in the message 
window message area, type your 
response, and then send the 
message. 

2. In the folder window, if 
necessary, add more details. 

3. On the toolbar, click the Save and 
Close button. 

To reassign a task request: 

1. In the task request message, on 
the toolbar, click the Assign Task 
button. 

2. In the Task message window, 
address the task to the assignee. 

3. In the message area, type a 
message. 

4. If desired, select the Keep an 
updated copy of  this  task on my 
task list check box. 

5. If desired, select the Send me a 
status report when this task is 
complete check box. 

6. Send the message. 

To reclaim ownership of a declined 
task: 

1. In the message that cont2ins the 
declined task request, from the 
Actions menu, choose Return to 
Task List. 

2. In the Task window, on the 
toolbar, click the Save and Close 
button. 

To create a new item from an existing 
one: 

1. From an item list, drag an item 
onto the shortcut on the Outlook 
Bar. 
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c/D 

1. Schedule the Dessert Bake Off as a three-day event beginning six 
months from today. 

2. Invite your workgroup partners to a four-hour meeting to judge the 
Dessert Bake Off entries at 10:00 A.M., according to the schedule in 
Table 10-5. 

Student 	 Date 

Studentl 	first day of contest 

Student2 	second day of contest 

Student3 	last day of contest 

Table 10-5: The Workgroup Judging Schedule 

3. From the Contacts folder, invite your mail partner to judge the contest, 
too. 

4. Accept the invitations you re,ceive from your workgroup partners and 
decline the invitation from your mail partner. 

5. Review the meeting information you have received concerning the 
meeting you originated. 

6. Reschedule the meeting for one hour later, and notify everyone of the 
change. Then cancel the meeting, again notifying everyone. 

7. Add these tasks to your task list: 

• Design a display ad for Elena to place in the Sunday issue of the 
Times-Picayune. 

• Have breakfast at Brennan's. 

• Write a mini review as Elena's listing for the New Orleans edition of 
the Gregarious Gourmet. 

8. Schedule designing the display ad for your first free time tomorrow. 

9. Mark the breakfast at Brennan's task complete and regenerate it for four 
months after completion. 
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10. Assign writing the mini review to your mail partner. Tell your partner to 
complete the task within one week_ Also assign your partner to locate 
additional places where Elena can advertise nationally. 

11. Accept your partner's assignment to write the mini review but reassign 
the assignment to locate advertisers to one of your workgroup members. 

12. Reclaim ownership of the task to write the mini review. 

13. Change your notes into tasks. 

14. Schedule at any available times the tasks you just created from your 
notes. 

15. Create a new message from a contact card and then close the message 
window without sending or saving the message. 
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Section 11: Working with Templates and Forms 

Section Skills and Their Importance 
In the following section you will learn to: 

• Work with templates 
Outlook provides several message templates you can use again and 
again. You simply retrieve the template and add current 
information. Outlook provides built-in templates and lets you 
create more on your own. 

• Utilize forms 
The Outlook dialog boxes and windows with which you have been 
worlcing are standard Outlook forms. These forms, as well as any 
you download from the Web can be edited. You can then open and 
use these forms. 
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Working with Templates 
Many messages you send have the same format and style time after time. For 
example, you might use e-mail to send out memos. Instead of creating the 
message from scratch each time you need to send a new one, you can create a 
message with a standard style and format once and save it as a template. 

A template is a reusable document that defmes the structure and layout of the 
specific type of message. It should include common elements that appear 
within the message in specific locations or at repeated intervals. Such 
elements might include a company logo, repeating titles and text, and text 
styles, to name a few. 

You can modify a message based on a template exactly the same way that you 
would modify a message you create from scratch. You change the message 
resulting from the template and not the template itself. Changes you make in 
this message do not affect future messages you create with the template. Only 
changes you make to the template itself appear in future publications. 

Outlook comes with built-in templates you can use to give your messages 
flair. You can modify these templates or design your own. Outlook templates 
have the .oft extension. 

Using a Template 

Most built-in Outlook templates simulate decorative stationery. The While 
you wereput template simulates the popular pink memo you see in many 
offices. You can use these templates for your informal correspondence and to 
get ideas to produce your own custom-designed templates. Once you create a 
template of your own, you can use it in exactly the saine  way as using a built-
in template. You select templates in the Choose Form dialog box, shown in 
Figure 11-1. 
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_ Look Ire 10e.00k 	
_ 

. 	 . 

I C: \Program Fles \Microsoft Office T ernplates Olook\>.cift . 	 . 
Appointrnent 
CONTACT 
MAIL 
POST 
TASK 
While YOU Were Out 

Browse... 

Dizplay name: 

Lletalz >> I 

Figure 11-1: The Choose Form Dialog Box 

L METHOD 

To use a template: 

1. From the File menu, choose New. 
2. From the submenu, choose Choose Form. 
3. In the Choose Form dialog box, click on the down arrow on the 

Look in drop-down box and choose Templates in File System. 
4. If a message appears stating Directory change failed. 

Defaulting to previous directory, click on OK. 
S.  If the active folder is not CAProgram Files\Microsoft 

Office\Templates\Outlook then use the Browse button to point 
to point to this folder. 

6. Choose a template and click on the Open button. 
7. Compose and send the message. 
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r-- EXERCISE 	  

In the following exercise, you will use a template. 

1. Open the Inbox 

2. From the File menu, choose 
New 

The New submenu appears. 

3. Click Choose Form The Choose Form dialog box 
appears. 

4. In the Choose Form dialog 
box, click on the down arrow 
on the Look in drop-down box 
and choose Templates in File 
System. 

The Templates in File System 
page appears. 

5. If a message appears stating 
Directory change failed. 
Defaulting to previous 
directory, click on OK. 

6. If the active folder is not 
CAProgram Files\Microsoft 
Office1TemplateslOutlook then 
use the Browse button to point 
to point to this folder. 

7. Select While You Were 
Outoft 

8. Choose Open The template appears with a 
design in the left margin. 

9. Close the template without 
sending a message 

10. From the File menu, choose 
New 

The New submenu appears. 

11. Choose Choose Form The Choose Forrn dialog box 
appears. 

12. In the Choose Form dialog 
box, click on the down arrow 
on the Look in drop-down box 
and choose Templates in File 
System. 

The Templates in File System 
page appears. 
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13. If a message appears stating 
Directory change failed. 
Defaulting to previous 
directory, click on OK. 

14. If the active folder is not 
CAProgram FilesWicrosoft 
OfficeTemplates\Outlook then 
use the Browse button to point 
to point to this folder. 

15. Select Mail.oft 

16. Choose Open 	 The template appears with a 
design in the left margin. 

17. Address the template to your 
partner, add a friendly 
message, and then send the 
message 
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Creating a Template 

To create a template, you must first define the layout and the repeating 
elements. When you save this message as a template, Outlook automatically 
saves it in the Template directory. All message templates you create appear in 
the Choose Form dialog box under Templates in File System in the Look in 
drop-down list box. 

L METHOD 

To create a template: 

1. Compose the message you want to use as a template. 
2. From the File menu, choose Save As. 
3. In the File name text box, type a name for the template. 
4. In the Save as type drop-down list box, select Outlook template 

(*.oft). 
5. Make sure the Save list displays the drive and path containing 

the Outlook templates. 
6. Choose Save. 

1- EXERCISE 	  

In the following exercise, you will create a template and then use it. 

1. Open a new message 

2. In the message area, type 
Memo and then press ENTER 
twice 

3. Format the word Memo in 
Aria!, 16 points, bold and italic, 
and center the text 

4. From the He menu, choose 	The Save As dialog box 
Save As 	 appears. 

5. In the File name text box, type 
Memo 

6. From the Save as type drop-
down list, select Outlook 
Template (*.oft) 
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7. Make sure the Save list 
displays the drive and path 
containing the Outlook 
templates 

8. Choose Save 

9. Close the template 

The template is saved. 

10. From the File menu, choose 
New / Choose Form 

11. In the Choose Form dialog 
box, click on the down arrow 
on the Look in drop-down box 
and choose Templates in File 
System. 

12. If a message appears stating 
Directory change failed. 
Defaulting to previous 
directory, click on OK. 

13. If the active folder is not 
Cerogram Files\Microsoft 
Office\Templates\Outlook then 
use the Browse button to point 
to point to this folder. 

14. Select Memo.oft The template opens. Only the 
word Memo appears. You can 
reuse the template to send 
another message. 

15. Address the message to your 
partner and in the message 
area, below the word Memo, 
type All servers should try 
on costumes by Monday and 
send the message 
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Utilizing Forms 
Aform is a fill-in-the-blank item that helps you enter and view information in 
an orderly way. You are already familiar with Outlook forms because you 
have used Message windows, Contact windows, Task windows, Appointment 
windows, Outlook templates, dialog boxes, and so forth. 

Outlook has two types of forms. The first is a message form, such as the 
Vacation Request or the While You Were Out form, that you use to send 
information to others. The second is a post form, such as the Classified Ad, 
that you display in a public folder on the network. Post forms are similar to 
message forms in that they provide an area in which the viewer can respond to 
the originator. 

Installing Sample Forms 

From time to time, Microsoft provides more forms on its Free Stuff page on 
the World Wide Web. You can access this page directly from the Help menu, 
Microsoft on the Web, Microsoft Office Home Page. 
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Using a Form 

Once you have installed the free Microsoft forms on your workstation, you 
can open them. To use company forms from your network, the network 
administrator must make them available. Such forms as the Vacation Request 
form and the While You Were Out form, shown in Figure 11-2, are ready to 
use as is; but other fonns, such as the Classified Ads form, just let you see 
how you can use a form. You cannot send them to your network workgroup 
unless you have administrator privileges to put them into the Organization 
Forms Library. This library is where your network administrator makes forms 
available for network-wide use. 

When you receive a form, you see it as a form only if you have the same form 
loaded in your Outlook folder. Otherwise, the form arrives as an ordinary 
message. 

0 

 

Figure 11-2: The While You Were Out Form 
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L METHOD —I 
To use a form: 

1. From the File menu, choose New. 
2. From the New submenu, choose Choose Form. 
3. In the New Form dialog box, fi-om the drop-down list box, make 

sure Personal Forms Library is selected. 
4. From the list box, select the form, and then choose OK. 
5. In the New [Sample Form] window, enter the information. 
6. If necessary, on the toolbar, click the Send button. 
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Creating a Form 
Alter  you work extensively with forms, you might want to restructure or 
enhance an existing form or create a new form from scratch to meet your 
office needs. You can modify an existing form and save it as a file. 

Modifying an Existing Form 

The simplest way to create your own form is to modify an existing form. You 
can add custom pages, choosing the fields you want on each page. Outlook's 
AutoLayout feature automatically sizes each field. You add controls to the 
page using the Toolbox, shown in Figure 11-3, vvhich you access by clicking 
the Control Toolbox button on the Form toolbar, shovvn in Figure 11-4. A 
control is a graphical object within a form that lets you enter or view data or 
accomplish a task, such as rtuming a macro. Outlook uses controls as the basis 
for building forms. 

Controls 

k A ab! 	E9 

Figure 11-3:  The  Toolbox 

Figure 11-4: The Control Toolbox Button 
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Table 11 - 1 describes the f-unctions of the controls. 

Tool button 	Tool name 	 Function 

Select Objects 	Selects, sizes, moves, and edits controls. 

Label 	 Creates an unattached text label 

‘.  

abl 	
TextBox 	Creates a text box control. 

ComboBox 	Creates a combo box control in which 
you can select from a list of values or 
enter a value. 

F 	
ListBox 	 Creates a list box control in which you 

can select from a list of values. 
_ 	 CheckBox 	Creates a check box control. 

• 	OptionButton 	Creates an option button control. 

ToggleButton 

	

	Creates a toggle button control by which 
a yes/no value can be selected. 

ei 	Frame 	 Creates a functional and visual control 
group. 

M 	
CommandButton Creates a command button that you can 

use to activate a macro or module. 

elJ 	
TabStrip 	Groups related controls. 

el MultiPage 	Presents multiple pages as a single set. 

ScrollBar 	Sets the value of another control based 
on the position of the scroll box. 

a 	SpinButton 	Creates a command button that lets you 
increase or decrease a number. 

PA 	
Image 	 Creates a frame in which you can display 

an unchanging image. 

Table 11 -1: Toolbox Tool Functions 
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Figure 11-5 shows the Contact (Design) window, which is the Contact 
vvindow with five customiz.able additional pages. Page 2 of this form appears 
with modifications. Parentheses around page names on the tabs indicate that 
those pages are hidden. 

Figure 11 -5: The Contact (Design) TVindow 

L -METHOD ---I 
To add pages to an existing fonn: 

1. Open the form you want to modify. 
2. From the Tools menu, choose Forms, choose Design This 

Form. 
3. Select a page tab. 
4. From the Form menu, choose Rename Page. 
5. In the Rename Page dialog box, in the Page name text box, type 

a page name, and then choose OK. 
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To add fields to a new page: 

1. From the Field Chooser dialog box, drag a field onto the new 
page. 
or 

1. In the Field Chooser dialog box, choose New, and in the New 
Field dialog box, fill in the text boxes and then choose OK. 

To add controls to a new page: 

1. On the toolbar, click the Control Toolbox button, and then, from 
the Toolbox, drag a control and its label area to the page. 

2. Click a label area and then click it again; then type the label into 
the label area. 

To hide a page: 

1. Select the page tab, and then, from the Form menu, choose 
Display This Page to deselect the check 

To set properties for the form:- 

1. Select the (Properties) tab, and on the Properties page, in the 
Form Caption text box, type a name for the form; to be able to 
send a copy of the form in e-rmil, select the Send form 
definition with item check box; and then select the other options 
you want. 

To publish a form: 

1. From the Tools menu, choose Forms / Publish this form. 
2. In the Look In field, choose Personal Forms Library. 
3. Enter a Display Name. 
4. Choose Publish. 

To open a new form: 

1. From the File menu, choose New / Choose Form 
2. From the Look In field, choose Personal Forms Library. 
3. Select the form to open. 
4. Choose Open. 
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r--- EXERCISE 	  

In the following exercise, you will modify an edsting form. 

1. 

2. 

3. 

4. 

The Contact (Design) window 
appears. 

(P.2), including the Field 
Chooser dialog box, appears. 

The label and a text box are 
placed on the page. The 
parentheses disappear from 
the page name, and the page 
becomes a visible part of the 
form. 

The label and a text box are 
placed on the page. 

REM 

The Rename Page dialog box 
appears. 

The page name appears on 
the tab. 

Open the Contacts folder 

Open a New Contact window 

From the Tools menu, choose 
Forms, Design This Form 

Select the (P.2) tab 

5. From the Field Chooser dialog 
box, drag Assistant's Phone 
onto the upper left part of the 
page 

6. From the Field Chooser dialog 
box, drag Pager to a position 
just below Assistant's Phone 

7. From the Form menu, choose 
Rename Page 

8. In the Page text box, type 
Additional Info and then 
choose OK 

9. Click the Control Toolbox 
button 

10. Drag the Toolbox to the lower 
left corner of the screen 

11. Drag the option button onto the 
grid twice 

12. Drag the option buttons and 
their label areas to the left to 
align them with the other items 
on the page 

The Toolbox appears. 

Two option buttons with label 
areas appear. 

13. Click the first option button 
label area, and then click it 
again 

An area in which you can type 
a label appears. 
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14. Type Always call assistant 
before using pager number 

Part of your typing is hidden 
because it is too long for the 
label area. 

15. Position the mouse pointer 
over the center right selection 
handle, and, when the pointer 
becomes a double-headed 
arrow, drag the label area to 
the right about halfway across 
the page 

Your typing fits into the label 
area. 

16. From the Tools menu, choose 
Forms / Publish this form 

17. From the Look In field, choose 
Personal Forms Library 

18. Enter New Contact in the 
Display Name field 

19. Click Publish 

20. Close the form without saving 
changes 

21. From the File menu, choose 
New / Choose Form 

22. Choose Personal Forms 
Library 

23. Select New Contact and 
choose Open 

24. Enter a name for the new 
contact, a job title and a 
company name 

25. Click the Additional Info page 

26. Enter the Assistant's phone 
number, a Pager number and 
click the Always call assistant 
before using pager number 
option 

27. Save and close the contact 
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Summary 

To use a template: 

1. From the File menu, choose New. 
2. From the submenu, choose 

Choose Form. 
3. In the Choose Form dialog box, 

click on the down arrow on the 
Look in drop-down box and 
choose Templates in File System. 

4. If a message appears stating 
Directory change failed. 
Defaulting to previous directory, 
click on OK. 

5. If the active folder is not 
CAProgram Files\Microsoft 
Office\Templates\Outlook then 
use the Browse button to point to 
point to this folder. 

6. Choose a template and click on 
the Open button. 

7. Compose and send the message. 

To create a template: 

1. Compose the message you want 
to use as a template. 

2. From the File menu, choose Save 
As. 

3. In the File name text box, type a 
name for the template. 

4. In the Save as type drop-down 
list box, select Outlook template 
(*.oft). 

5. Make sure the Save list displays 
the drive and path containing the 
Outlook templates. 

6. Choose Save. 

To use a form: 

L From the File menu, choose New. 
2. From the New submenu, choose 

Choose Form. 
3. In the New Form dialog box, 

from the drop-down list box, 
make sure Personal Fonns is 
selected. 

4. From the list box, select the form, 
and then choose OK. 

5. In the New [Sample Form] 
window, enter the information. 

6. If necessary, on the toolbar, click 
the Send button. 

To add pages to an existing form: 

1. Open the form you want to 
modify. 

2. On the Tools menu, choose 
Design Outlook Form. 

3. Select a page tab. 
4. From the Form menu, choose 

Rename Page. 
5. In the Rename Page dialog box, 

in the Page  name text box, type a 
page name, and then choose OK. 

To add fields to a new page: 

1. From the Field Chooser dialog 
box, drag a field onto the new 
page. 
or 

1. In the Field Chooser dialog box, 
choose New, and in the New 
Field dialog box, fill in the text 
boxes and then choose OK. 

To add controls to a new page: 

1. On the toolbar, click the Control 
Toolbox button, and then, from 
the Toolbox, drag a control and 
its label area to the page. 

2. Click a label area and then click it 
again; then type the label into the 
label area. 

To hide a page: 

1. Select the page tab, and then, 
from the Form menu, choose 
Display This Page to deselect the 
check. 
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To set properties for the form: 

1. Select the (Properties) tab, and on 
the Properties page, in the Form 
Caption text box, type a name for 
the form; to be able to send a 
copy of the form in e-mail, select 
the Save fonn definition with item 
check box; and then select the 
other options you want. 

To save a form in the open file folder: 

1. From the File menu, choose Save. 

To save a form as a file or as a 
template: 

1. From the File menu, choose Save 
As. 

2. In the Save As dialog box, in the 
Save in box, select the folder. 

3. In the File naine combo box, 
enter a name. 

4. From the Save as type drop-down 
list, select a file type. 

5. Choose Save. 

To publish a form: 

1. From the Tools menu, choose 
Forms / Publish this form. 

2. In the Look In field, choose 
Personal Forms Library. 

3. Enter a Display Name. 
4. Choose Publish. 

To open a new form: 

1. From the File menu, choose New 
/ Choose Form 

2. From the Look In field, choose 
Personal Forms Library. 

3. Select the form to open. 
4. Choose Open. 



Self-Check Exercise 

1. Send your e-mail partner a message using the While you Were Out 
template. Choose a Fax under the You Received heading and type the 
message I have the fax you were expecting, please see me in the 
Details window. 

2. Create a new message template. First, create a new message, in the 
subject text box type Staff Schedule, Week of. In the message area, 
create a table using the Tab key with the headings shown in Table 11-2. 
Save the template as Staff Schedule. 

Employee 	Mon Tue 	Wed Thur Fri 	Sat 	Sun 

Baptiste 
Claire 
Valerie 
Charlotte 

Table 11-2: Staff  Schedule  Template Data 

3. Use the Staff Schedule template to send your e-mail partner the schedule 
for next week, using the data shown in Table 11-3. 

Employee 	Mon Tue 	Wed Thur Fri 	Sat 	Sun 

Baptiste 	2-8 	2-8 	 2-10 	4-12 	4-12 	2-8 
Claire 	 5-10 	5-10 	5-8 	5-10 	3-10 
Valerie 	 10-6 	10-6 
Charlotte 	4-8 	4-8 	4-8 	 2-10 	2-10 

Table 11 -3: Staff  Schedule  for Next Week 
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address books Address lists your 
network administrator sets up that 
include the names and corresponding e-
mail addresses of everyone on your 
network. See Personal Address Book. 

Glossary 
AutoText A Microsoft feature that lets 
you add words to you AutoComplete tip 
database. 

category A keyword or phrase that 
helps you sort and find data. 

r:71 

address card All information stored 
about a contact. Similar to a business 
card in a rotary file. 

aging period The time interval from 
when data is first entered in an Outlook 
folder until it is automatically stored in 
an archive. 

contact list Your personal address 
book, including names, addresses, phone 
numbers, notes, and other information. 

control A graphical object within a 
form that lets you enter or view data or 
accomplish a task. 

appointment An activity scheduled on 
your Calendar that does not involve 
anyone else. 

Date Navigator Displays the calendar 
and enables you to go to desired dates. 

edit Insert, delete, and replace text. 
appointment handle The blue borders 
at the top and the bottom of a selected 
appointment that allow you to changethe 
appointment beginning and ending 
times. 

event A day on which you observe or 
celebrate something, such as a birthday 
or an anniversary, while conducting 
business as usual. 

efil] 
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archive To store out-of-date Outlook 
items away from the main Outlook data 
folder. 

ASCII The American Standard Code 
for Information Interchange. 

AutoComplete A Microsoft feature that 
displays the word you are probably 
tping. If the word displayed is correct, 
press Enter to complete the typing. 

AutoCorrect A Microsoft feature that 
automatically places phone calls from 
your computer. 

AutoDate A Microsoft feature that lets 
you enter a time or a date as a word or 
phrase that Outlook then translates into a 
date. For example, if you type 
Halloween, Outlook changes the word to 
10/31/yyyy, where yyyy is the year in 
which Halloween next occurs. 

filter Display a specified subset of 
messages, appointments, contacts, tasks, 
notes,or journal entries. 

Folder Banner The title bar at the top 
of the information viewer. 

folder list The folder tree in which you 
create new Outlook folders, move data 
from folder to folder, archive clata,delete 
and recover data, sort data, and find data. 

form A fill-in -the-blank item that helps 
you enter and view information in an 
orderly way. 

group address A unique naine  that 
references a group of Outlook users. 

hyperlink When clicked, jumps from a 
web page address in a message to the 
web page on the Internet. 



Training Guide Microsoft Outlook 98 

information viewer The pane that 
displays the active Outlook folder. 

meeting An activity scheduled on your 
Calendar that involves other people and 
can also involve resources. 

message list All messges in a Mail 
subfolder. 

move handle The vertical colored line 
to the left of an appointment that lets you 
move the appointment 

network A group of two or more 
computers which are physically 
connected. The network allows you to 
send information to other computers and 
receive information from other 
computers. 

Office Assistant This on-screen helper 
can provide tips and help you search for 
answers. 

Organization Forms Library Where 
your network administrator makes forms 
available for network-wide use. 

Outlook Bar The Window element that 
contains shortcuts to Outlook's features 
and folders. 

Personal Address Book An address list 
you set up that includes the names or 
aliases and corresponding e-mail 
addresses of people with whom you 
correspond frequently. See address 
books. 

Personal Forms Library Where you 
store forms you are not sharing. 

recurring appointment An 
appointment that occurs regularly, such 
as a biweekly day off in a flex work 
schedule. 

recurring task A task that occurs 
regularly, such as picking up your 
paycheck every other Friday. 

resource A person, location, or piece of 
equipment. 

ScreenTip Context-sensitive help. 

shortcut Icons on the Outlook Bar that 
store the folder location and provide 
access to Outlook folders. 

synchronize To update network folders 
with changes you have made offline and 
to update offline folders with changes 
you have made online so that the folders 
are identical. 

task A specific duty that you must 
perform and usually complete within a 
specific time frame. 

TaskPad The area on the Calendar that 
displays your tasks. 

template A reusable message with a 
defined structure and layout. 

tentative appointment An appointment 
that reserves a time slot in your Calendar 
but might not take place. 

user name The e-mail identification 
name assigned to each user on a network 
and used to address a message. Can be a 
full e-mail address or an alias that 
substitutes for the full address. 
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Index 

accessing 
contacts' web pages, 

279 
activities 

finding, 165 
listing, 165 
recording, 167, 168, 

180 
adding 

contacts from the 
same company, 273 

names to your 
Personal Address 
Book, 233, 235 

shortcuts, 213 
adding contacts 

manually, 81 
via e-mail, 87 

address books 
selecting a default, 

239,240 
using, 231 

address cards, 81 
changing the Current 

View, 92, 93 
selecting, 85 

addressing messages, 
43,231 

aging period, 190 
appointment handles, 

116, 121 
appointments, 99 

changing the time, 
121 

creating,  112,113 
deleting, 132, 133 
making, 111 
moving, 111, 116, 

117, 119 
on holidays, 113 
recurring, 123 
restoring, 133 
saving, 111 
selecting,  116,117 
tentative, 123, 128 
viewing, 103, 104, 

106 
archiving 

aging period, 190 

automatically, 189 
items, 189 
manually, 194 
setting up 

AutoArchiving, 
189 

ASCII, 49 
assigning tasks to 

someone else, 308, 
309 

attaching files to 
messages, 260,261 

attachments to 
messages 
opening, closing, and 

saving, 263 
AutoArchiving 

setting up, 189, 192, 
224 

AutoDate, 113 

Calendar, 7, 99 
Current View filters, 

100 
toolbar buttons, 100 

canceled appointments 
deleting, 123 

canceling Meetings, 298 
categories, 189 

applying, 198, 199, 
224 

creating, 198, 199, 
224 

changing 
icon size, 178 
views, 100 

choosing 
Office Assistant, 13 

closing attachments to 
messages, 263 

closing messages, 37 
color coding 

notes, 176 
column headers,  33,38 
completed tasks, 155, 

156 
completing 

a task in Outlook 
Today, 186 

composing messages, 
41 

contact list, 79 
adding contacts from 

the same company, 
273 

adding contacts 
manually, 81 

adding contacts via e-
mail, 87 

creating, 79 
editing, 85 
File as feature, 275 
transmitting contacts 

via e-mail, 87 
contacts, 7 

adding via e-mail, 87 
managing, 89 
transmitting via e- 

mail, 87 
Contacts 

Current View filters, 
92 

toolbar buttons, 79 
context-sensitive help, 

15 
controls on forms, 334 
creating 

aliases, 237 
appointments, 111, 

112, 113 
folders, 64, 65 
forms, 334 
new items fi-om 

existing items, 315, 
316 

personal distribution 
lists,  241,242 

recurring 
appointments, 124 

recurring tasks, 149 
tasks, 142, 143, 144 
templates, 329 
tentative 

appointments, 128 - 
Current View filters 

Calendar, 100 
Contacts, 92 
Inbox, 39 
Journal, 166 
Mail, 39 



hiding fields, 89,90 

Training Guide Microsoft Outlook 98 

Notes, 172 
taslcs, 152 

customizing a page, 17 
customizing settings, 

210 

D 

Date Navigator, 99, 
103, 104 

Day view, 100 
Deleted Items, 7 
deleting 

appointments, 132, 
133 

canceled 
appointments, 123 

messages, 68 
messages 

pernaanently, 68 
personal distribution 

lists, 246 
tasks, 151 
text, 46 

Design window, 336 
discontiguous days 

viewing, 106 

E 	11 
editing 

address cards, 85 
contact list, 85 
notes, 175 
recurring 

appointments, 126 
tasks, 146 
text, 46 

editing personal 
distribution lists, 244 

ending sessions, 22 
events, 123 

inserting, 129, 130 
scheduling, 300, 301 
viewing, 129 

exiting,  22,24 
exploring, 4 

Favorites, 8 
fields 

showing and hiding, 
89, 90 

File as feature,  275,276 
filtering 

address cards, 92, 93 
Calendar, 100 
contacts, 92, 93 
Journal, 166 
messages, 39 
Notes, 172 
taslcs, 152 

filtering items, 207, 208 
fmding 

a contact in Outlook 
Today, 187 

activities, 165 
finding items, 201, 203, 

224 
flagging messages, 256, 

257 
Folder Barmer, 4, 5, 6, 8 
folder list, 63 
folder tree, 63 
folders 

creating,  64,65 
managing, 63 

font, 49 
font size, 49 
formatting text, 49,50 
formatting toolbar, 49 
forms 

creating, 334 
creating from another 

form, 334 
modifying, 334 
using, 331, 333, 340 

forms library, 332 
forwarding messages, 

59, 60 

group buttons, 4,8 
group folders, 6 
grouping items, 205, 

206 

help, 10 
context-sensitive, 15 
Office Assistant, 10 

icon size 
changing, 178 

Inbox, 7, 31, 217 
Current View filters, 

39 
toolbar buttons, 31 

information viewer,  4,5 
inserting 

events, 130 
text, 46 

items 
archiving, 189 
creating new items 

from existing 
items, 315, 316 

filtering, 207, 208 
finding, 201, 203, 224 
grouping,  205,206 
managing, 189 

Journal, 7 
Current View filters, 

166 
entries as shortcuts, 

170 
toolbar buttons, 166 
tracking activities, 

165 

layout, 16 
listing 

activities, 165 
logging off,  22,24 

Mail 
Current View filters, 

39 
toolbar buttons, 31 

Mail group folder, 6 
malcing 

appointments, 111 
managing 

G 

H 

346 

.t 



sending, 57, 58 
setting and using 

options, 251, 252 
signatures, 51 
sorting, 38 
to contacts, 277 
typing,  43,44 
using folders, 63 

minimizing,  22,23 
modifying forms, 334 
Month view, 100 
move hanclle, 116, 121 
moving 

appointments, 111, 
116, 117, 119 

messages to folders, 
66, 67 

moving shortcuts, 215 
My Computer, 7 
My Documents, 8 

contacts, 89 
items, 189 
messages, 63 

meetings 
inviting colleagues 

and setting a time, 
286,287 

rescheduling and 
canceling, 298 

responding to 
requests,  293,294 

reviewing 
information, 296, 
297 

scheduling, 285 
message features, 247 
message list, 33 
message options 

setting and using, 
251,252 

messages 
addressing, 43, 44, 

231 
attaching files, 260, 

261 
checicing spelling, 57 
closing, 37 
color-coding, 219 
composing, 41 
deleting, 68 
deleting permanently, 

68 
filtering, 39 
flagging,  256,257 
forwarding,  59,60 
managing, 63 
moving to folders, 63, 

66, 67 
notification, 31 
opening,  33,34 
opening, closing, and 

saving attachments, 
263 

previewing, 33, 34 
printing, 36 
reading, 33, 34 
recalling,  258,259 
replying to, 59, 61, 62 
restoring, 68 
saving tmsent 

messages, 247 
selecting, 36 

notes, 175 
opening attachments to 

messages, 263 
options 

printing, 19 
setting, 210, 211, 225 

Organize pane, 217 
color-coding 

messages, 219 
displaying, 217 
hiding, 217 
managing messages, 

217 
organizing 

notes, 176 
Other group folder, 6 
Outbox, 7 
Outlook Bar, 5, 6, 8 
Outlook group folder, 6 
Outlook Today 

completing a task in, 
186 

finding a contact in, 
187 

navigating with, 186 
setting options, 188 
Using Outlook 

Today, 185 
working on the 

Outlook Today 
page, 185 

Outlook window 
elements, 4 

overview, 3 

navigating, 6, 8 
in Calendar, 99 

new items 
creating from existing 

items, 315, 316 
New Message window, 

41 
notes, 7 

color coding, 176 
editing, 175 
opening, 175 
organizing, 176 
sorting, 176 
viewing, 176 
writing, 172, 173 

Notes 
Current View filters, 

172 
icons, 178 
toolbar buttons, 172 

page 
customizing, 17 
setting up, 17 

pane size 
adjusting, 103, 104 

Personal Address Book, 
231,234 
adding names, 233, 

235, 238 
creating aliases, 237, 

238 
personal distribution 

lists 
creating,  241,242 
deleting, 246 

obinining context- 
sensitive help, 15 

Office Assistant, 10, 11 
choosing, 13 
using, 11 

opening 



Training Guide Microsoft Outlook 98 

editing, 244 
previewing, 20 
printing, 16, 19, 20 

messages, 36 
printing options, 19 
prioritizing tasks, 153 

range of days 
viewùig, 106 

reading messages, 33 
recalling messages, 258, 

259 
reclaiming taslcs, 314 
recording 

activities, 167, 168, 
180 

recurring appointments, 
123 
creating, 123, 124 
editing, 126 

recurring tasks, 148 
creating, 149 

regenerating tasks, 306 
removing shortcuts, 216 
replacing 

text, 47 
replying to messages, 

59, 61, 62 
rescheduling meetings, 

298 
responding 

to meeting requests, 
293,294 

to task requests, 311, 
313 

restoring 
appointments, 133 
messages, 68 
tasks, 151 

reviewing meeting 
information, 296, 297 

Rules 
using, 220 

Rules wizard, 220 

saving 
appointments,  111  

attaclunents to 
messages, 263 

data, 22 
unsent messages, 247 

scheduling 
events, 300, 301 
meetings, 285 
taslcs, 303, 304 

screen elements, 4 
ScreenTip, 15 
selecting 

address cards, 85 
appointments, 116, 

117 
messages, 36 
printing options, 19 
tasks, 146 

sending 
messages, 58 

Sent Items, 7 
setting 

message options, 251, 
252 

options, 210, 211, 
225 

spelling options, 249, 
250 

setting Outlook Today 
options, 188 

setting up a page, 17 
shortcuts, 4, 5, 6, 8 

adding, 213 
Journal entries as, 

170 
moving, 215 
removing, 216 

showing fields, 89, 90 
signatures 

creating, 51 
deleting, 53 

sorting 
messages, 38 
notes, 176 

spelling options 
setting,  249,250 

starting, 3 
status 

of tasks, 155, 156 
tracicing, 155 

-Imumummulell  
Task Timeline view, 

158 
taskbar, 23 
TaskPad, 99, 141 
tasks, 7, 99, 141 

assigning to someone 
else, 308, 309 

completed, 155, 156 
creating, 142, 143, 

144 
deleting, 151 
editing, 146 
filtering, 152 
managing, 152 
prioritizing, 153 
reclaiming, 314 
recurring, 148 
regenerating, 306 
responding to 

requests,  311,313 
restoring, 151 
scheduling,  303,304 
selecting, 146 
Task Timeline view, 

158 
toolbar buttons, 142 
tracking status, 155, 

156 
Taslcs 

Current View filters, 
152 

templates 
creating, 329 
defining and using, 

325 
tentative appointments, 

123, 128 
text 

deleting, 46 
editing, 46 
formatting, 49, 50 
inserting, 46 
replacing, 47 

time zones, 99 
changing, 109 
viewing, 108, 109 

timeline 
Journal, 165 

timeline format, 158 
toolbar 
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viewing 
appointments, 103, 

104, 106 
discontiguous days, 

106 
notes, 176 
range of days, 106 
time zones, 108, 109 

views 
changing, 100 
Day, Week, and 

Month, 100 
Task Timeline, 158 

voting buttons 
using, 254 

Journal, 166 
toolbar buttons 

Calendar, 100 
Contacts, 79 
folder management, 

63 
formatting, 49 
Journal, 166 
Mail, 31 
New Message 

window, 41 
Notes, 172 
Task, 142 

toolbars 
New Message 

window, 41 
ToolTips, 10 
tracking activities, 165 
transmitting contacts 

via e-mail, 87 
typing messages, 43 web pages 

accessing contacts', 
279 

Week view, 100 
writing 

messages, 41 
notes, 172, 173 

unsent messages 
saving, 247 

user names, 43 
using 

address books, 231 
folders, 63 
forms, 331, 333, 340 
message options, 251, 

252 
Office Assistant, 11 
voting buttons, 254 
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